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Brève	description
Swift	Publisher	est	une	application	de	mise	en	page	pour	la	conception	de	prospectus,	de	brochures,	de
papier	à	en-tête,	de	livrets	et	bien	plus	encore.	Le	programme	est	fourni	avec	une	collection	de
modèles	de	documents	ainsi	qu'une	bibliothèque	clipart	intégrée.

Swift	Publisher	vous	permet	d'imprimer	votre	travail	et	de	l'exporter	en	PDF	ou	dans	d'autres	formats
de	fichier	graphique.

Configuration	système	requise

Mac	OS	X	10.10	ou	version	ultérieure
500	Mo	d'espace	disque	disponible
Connexion	Internet	pour	utiliser	les	services	en	ligne
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Licence
Le	code	de	licence	se	trouve	dans	l'e-mail	de	confirmation	d'achat.

Pour	saisir	ce	code	de	licence	:

1.	 Ouvrez	l'application.

2.	 Affichez	la	zone	de	dialogue	Licence	en	choisissant	Swift	Publisher	5	>	Licence…	dans	le
menu.

3.	 Saisissez	votre	nom	et	votre	code	de	licence.

Nous	vous	recommandons	de	conserver	l'e-mail	qui	contient	votre	code	de	licence	en	lieu	sûr	au	cas	où
vous	devriez	réinstaller	ou	mettre	à	jour	l'application.

La	version	sans	licence	de	Swift	Publisher	est	totalement	opérationnelle.	La	seule	limitation	consiste	en
la	présence	de	«	Version	d'essai	de	Swift	Publisher	»	sous	forme	de	filigrane	lorsque	votre	conception
est	imprimée	ou	exportée.	Pour	supprimer	ce	filigrane,	entrez	le	code	de	licence.

Pour	mettre	à	niveau	la	version	d'essai	vers	la	version	sous	licence	du	programme,	vous	devez	acheter
et	entrer	le	code	de	licence.	Pour	plus	de	détails,	rendez-vous	sur	le	site	de	BeLight	:
http://www.belightsoft.com/buy/

Aucune	licence	n'est	nécessaire	si	l'application	a	été	achetée	sur	l'App	Store	Mac.
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Mise	à	jour	de	Swift	Publisher
Pour	rechercher	les	mises	à	jour	manuellement,	choisissez	Swift	Publisher	5	>	Rechercher	les
mises	à	jour…	dans	le	menu.

Pour	rechercher	les	mises	à	jour	automatiquement,	cochez	la	case	correspondante	dans	les
Préférences	(Commande	+	«	,	»).

Pour	mettre	à	jour	l'application	achetée	sur	l'App	Store	Mac,	utilisez	l'application	App	Store.
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Suppression	de	Swift	Publisher
Pour	supprimer	complètement	le	programme	et	tous	ses	composants,	supprimez	les	fichiers	et	dossiers
suivants	de	ces	chemins	d'accès	:
/Applications/Swift	Publisher	5.app
~/Bibliothèque/Preferences/com.belightsoft.SwiftPublisher5.plist
~/Bibliothèque/Application	Support/Swift	Publisher	5
~/Bibliothèque/Caches/com.belightsoft.SwiftPublisher5

Pour	supprimer	l'application	achetée	sur	l'App	Store	Mac,	supprimez	:
/Applications/Swift	Publisher	5.app
~/Bibliothèque/Containers/com.belightsoft.SwiftPublisher5/

Le	caractère	«	~	»	désigne	le	dossier	de	départ	de	l'utilisateur.

Par	défaut,	le	programme	enregistre	les	modèles	personnalisés	dans	:
~/Bibliothèque/Application	Support/Swift	Publisher	5/My	Templates/
ou	(Mac	App	Store)	:
~/Bibliothèque/Containers/com.belightsoft.SwiftPublisher5/Data/Library/Application	Support/Swift
Publisher	5/My	Templates/
Ne	supprimez	pas	ce	dossier	si	vous	comptez	utiliser	vos	modèles	plus	tard.

Pour	accéder	à	l'un	des	chemins	indiqués	ci-dessus,	copiez-le.	Dans	le	Finder,	choisissez	Aller	>	Aller
au	dossier	(Commande	+	Maj	+	G).	Collez	ensuite	le	chemin	d'accès	dans	le	champ	d'édition,	puis
cliquez	sur	le	bouton	Aller.
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Ressources	Web	utiles
Accueil	Swift	Publisher	:	informations	sur	le	programme.

Ressources	Swift	Publisher	:	articles	utiles	sur	l'utilisation	de	Swift	Publisher.

BeLight	Software	:	page	d'accueil	de	BeLight	Software.

Assistance	BeLight	Software	:	demande	d'assistance	technique.
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Contrat	de	Licence	Utilisateur	Final	de	Swift	Publisher
CE	CONTRAT	DE	LICENCE	(LE	«	CONTRAT	»)	EST	UN	CONTRAT	LÉGAL	ENTRE	VOUS,	QUE	VOUS	SOYEZ
UNE	PERSONNE	PHYSIQUE	OU	MORALE,	ET	BELIGHT	SOFTWARE	(LE	«	CONCÉDANT	»).	SI	VOUS
N'ACCEPTEZ	PAS	TOUTES	ET	CHACUNE	DE	SES	DISPOSITIONS,	VOUS	DEVEZ	CLIQUER	SUR	LE
BOUTON	«	REFUSER	»	ET	NE	PAS	OUVRIR,	NI	UTILISER,	NI	INSTALLER	LE	LOGICIEL.	VOUS	DEVEZ
SOIT	RETOURNER	LE	LOGICIEL,	LA	DOCUMENTATION	ET	L'EMBALLAGE	AU	LIEU	D'ACQUISITION,
SOIT,	DANS	LE	CAS	D'UN	LOGICIEL	TÉLÉCHARGÉ,	SUPPRIMER	CE	LOGICIEL	DE	VOTRE	ORDINATEUR
ET/OU	DE	TOUT	AUTRE	APPAREIL	DE	STOCKAGE	DE	DONNÉES.

REMARQUE	:	Les	clients	de	l'App	Store	Mac	sont	priés	de	se	référer	au	contrat	de	licence	d'utilisateur
final	de	l'App	Store.

1.	GÉNÉRALITÉS
Le	logiciel,	la	documentation	et	toutes	les	images	ou	conceptions	prêtes	à	l'emploi	qui	accompagnent
cette	Licence,	que	ce	soit	sur	un	disque	ou	sur	tout	autre	support	(collectivement	désignés
«	Logiciel	»),	vous	sont	concédés	sous	licence	par	BeLight	Software	(le	«	Concédant	»)	uniquement
pour	une	utilisation	conformément	à	la	présente	Licence	et	le	Concédant	se	réserve	tous	les	droits	qui
ne	vous	sont	pas	expressément	concédés.	Les	droits	concédés	dans	les	présentes	n'incluent	aucun
autre	brevet	ni	droit	de	propriété	intellectuelle.

La	propriété	et	les	droits	de	propriété	intellectuelle	dans	et	afférents	au	contenu	affiché	par	ou	accédé
via	le	Logiciel	appartiennent	au	propriétaire	du	contenu	respectif.	Cette	Licence	ne	vous	concède	aucun
droit	d'utiliser	ledit	contenu.

2.	LICENCE
Par	les	présentes,	le	Concédant	Vous	concède,	et	Vous	acceptez,	une	licence	non	exclusive
d'installation	et	d'utilisation	du	Logiciel	et	de	la	Documentation,	uniquement	conformément	aux
dispositions	de	la	présente	licence.	La	licence	autorise	soit	plusieurs	utilisateurs	à	installer	et	utiliser	le
logiciel	sur	un	seul	ordinateur,	soit	un	seul	utilisateur	à	installer	et	utiliser	le	logiciel	sur	plusieurs
ordinateurs.	La	présente	licence	n'autorise	pas	plusieurs	utilisateurs	à	utiliser	le	Logiciel	sur	plusieurs
ordinateurs.	Vous	acceptez	de	ne	pas	attribuer,	concéder	une	sous-licence,	transférer,	nantir,	donner
en	crédit-bail,	louer	ou	partager	Vos	droits	au	titre	de	la	présente	licence.	Vous	n'êtes	pas	autorisé	à
effectuer	d'ingénierie	inverse,	décompiler,	désassembler	le	Logiciel	sous	licence	à	des	fins	quelles
qu'elles	soient.

Clip	Art	et	images	photo	:	Le	Logiciel	contient	de	nombreuses	images	Clipart	et	images	photo
(collectivement	désignées	ci-après	«	Images	»)	qui	sont	soit	la	propriété	du	Concédant,	soit	concédées
sous	licence	par	un	tiers.	Vous	êtes	libre	d'utiliser,	modifier	et	publier	les	Images	que	vous	souhaitez,
sous	réserve	des	limitations	établies	dans	cette	section.	Vous	êtes	prié	de	consulter	votre	conseil
juridique	en	cas	de	doute	concernant	vos	droits	d'utiliser	un	matériel	quelconque.

Vous	n'êtes	PAS	autorisé	à	revendre,	concéder	une	sous-licence	ou	rendre	la	ou	les	Images	disponibles
pour	les	utiliser	ou	les	distribuer	séparément	ou	indépendamment	d'un	produit	ou	d'une	page	Web.
Vous	n'êtes	PAS	autorisé	à	a)	créer	des	œuvres	choquantes,	obscènes,	diffamatoires	ou	immorales	à
l'aide	des	Images	ni	à	utiliser	les	Images	à	toute	autre	fin	interdite	par	la	loi	;	b)	utiliser	ou	autoriser
l'utilisation	des	Images	ou	toute	partie	de	ces	Images	comme	marque	commerciale	ou	marque	de
service,	ou	à	réclamer	des	droits	de	propriété	intellectuelle	de	quelque	nature	que	ce	soit	relatives	aux
Images	ou	toute	partie	de	ces	Images	;	c)	utiliser	les	Images	au	format	électronique,	en	ligne	ou	dans
des	applications	multimédia,	sauf	si	les	Images	sont	intégrées	à	des	fins	de	visionnage	uniquement	et
aucune	autorisation	ne	vous	est	concédée	pour	télécharger	et/ou	enregistrer	les	Images	pour	des
raisons	quelconques	;	d)	utiliser	les	Images,	sauf	comme	cela	est	expressément	autorisé	par	cette
Licence	;	et	e)	utiliser	les	Images	relatives	à	des	personnes,	des	produits	ou	des	entités	identifiables	à
des	fins	commerciales	ou	d'une	manière	qui	suggèrerait	leur	association	ou	leur	soutien	à	tout	produit
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ou	service.

3.	TRANSFERT
Vous	n'êtes	pas	autorisé	à	distribuer	des	copies	du	Logiciel	incluant	des	images	clipart,	des	images
photo,	des	conceptions	prêtes	à	l'emploi,	dans	leur	intégralité	ou	en	partie,	à	des	tiers	quelconques,	et
vous	ne	pouvez	pas	utiliser,	louer,	prêter,	concéder	une	sous-licence	ou	donner	en	crédit-bail	le
Logiciel	à	des	tiers.	Vous	êtes	toutefois	autorisé	à	transférer	tous	vos	droits	d'utiliser	le	Logiciel	à	une
autre	personne	physique	ou	morale	sous	réserve	que	:	(a)	Vous	lui	transfériez	également	le	présent
Contrat,	le	Logiciel	et	tous	les	autres	logiciels	intégrés	ou	préinstallés	avec	le	Logiciel,	y	compris	toutes
les	copies,	Mises	à	jour	et	versions	antérieures,	à	cette	personne	physique	ou	morale	;	(b)	Vous	ne
conserviez	aucune	copie,	y	compris	les	copies	de	sauvegarde	et	celles	stockées	sur	un	ordinateur	;	et
(c)	le	bénéficiaire	accepte	les	conditions	du	présent	Contrat	ainsi	que	toutes	les	autres	conditions	en
vertu	desquelles	Vous	avez	acheté	légalement	une	licence	du	Logiciel.	Nonobstant	ce	qui	précède,	Vous
vous	interdisez	de	transférer	les	pré-versions	ou	les	copies	non	destinées	à	la	vente	du	Logiciel.

4.	UTILISATION	ILLÉGALE
Vous	n'êtes	pas	autorisé	à	utiliser	le	Logiciel,	directement	ou	indirectement,	à	des	fins	illégales
conformément	aux	lois	et	ordonnances	fédérales,	d'État	ou	locales.	Vous	assumez	l'entière
responsabilité	de	connaître	et	comprendre	les	lois	et/ou	ordonnances	qui	régissent	l'utilisation	du
Logiciel.	Si	Vous	enfreignez	une	loi	ou	une	ordonnance	fédérale,	d'État	ou	locale	par	l'utilisation	directe
ou	indirecte	du	Logiciel,	Vous	assumez	la	totale	responsabilité	légale	de	cet	utilisation	illégale.	Vous
vous	engagez	à	exonérer	le	Concédant	et	à	l'indemniser	de	tous	dommages-intérêts,	coûts	ou
responsabilité	engagés	par	le	Concédant	à	la	suite	de	toute	utilisation,	que	cette	utilisation	se	trouve
ou	non	dans	le	champ	d'application	de	la	présente	licence.

5.	MISES	À	JOUR
Si	le	Logiciel	est	une	Mise	à	jour	d'une	version	antérieure	du	Logiciel,	Vous	devez	posséder	une	licence
valide	de	la	version	antérieure	afin	de	pouvoir	utiliser	la	Mise	à	jour.	Vous	êtes	autorisé	à	continuer	à
utiliser	la	version	antérieure	du	Logiciel	sur	votre	ordinateur	après	que	Vous	avez	reçu	la	Mise	à	jour
afin	de	Vous	aider	dans	la	transition	vers	la	Mise	à	jour,	sous	réserve	que	:	la	Mise	à	jour	et	la	version
antérieure	soient	installées	sur	le	même	ordinateur	;	la	version	antérieure	ou	ses	copies	ne	soient	pas
transférées	à	un	tiers	ou	à	un	autre	ordinateur,	sauf	si	toutes	les	copies	de	la	Mise	à	jour	sont
également	transférées	à	ce	tiers	ou	cet	ordinateur	;	et	que	Vous	reconnaissiez	que	toute	obligation	de
BeLight	Software	de	prendre	en	charge	la	version	antérieure	du	Logiciel	puisse	prendre	fin	dès	la	mise
à	disposition	de	la	Mise	à	jour.

6.	DROITS	DU	CONCÉDANT
Vous	reconnaissez	et	acceptez	que	le	Logiciel	et	la	Documentation	sont	la	propriété	publiée	et	non
publiée	du	Concédant.	Vous	reconnaissez	en	outre	et	Vous	acceptez	que	tous	les	droits,	les	titres	de
propriété	et	les	intérêts	dans	le	Logiciel	et	la	Documentation	appartiennent	au	Concédant.	La	licence
vous	concède	le	droit	d'installer	et	d'utiliser	le	Logiciel	et	la	Documentation	conformément	aux
conditions	de	la	présente	licence.	BeLight	Software	se	réserve	tous	les	droits	non	concédés
expressément	par	les	présentes.	Le	Concédant	ne	transmettra	pas	vos	données	personnelles	à	des
tiers	sans	votre	consentement	exprès.

7.	RÉSILIATION
La	présente	licence	prend	effet	à	Votre	installation	du	logiciel	sur	n'importe	quel	dispositif	et	reste	en
vigueur	jusqu'à	sa	résiliation.	Vous	pouvez	résilier	ce	Contrat	à	tout	moment.	Le	Concédant	peut
immédiatement	résilier	ce	Contrat	de	Licence	si	Vous	violez	une	représentation,	une	garantie,	un
contrat	ou	une	obligation	contenue	ou	mentionnée	dans	ce	Contrat	de	Licence.	En	cas	de	résiliation	de
la	licence,	vous	devez	éliminer	le	Logiciel	et	toutes	les	copies	ou	versions	du	Logiciel	en	détruisant	le
Logiciel.

8.	GARANTIE	LIMITÉE
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BeLight	Software	fournit	une	garantie	de	remboursement	de	trente	(30)	jours	du	Logiciel.	Si,	pendant
cette	période,	vous	n'êtes	pas	satisfait	du	Logiciel	pour	une	raison	quelconque,	BeLight	Software	vous
remboursera	si	vous	retournez	le	Logiciel	et	toutes	les	copies	au	lieu	d'acquisition	dans	les	trente	(30)
jours	à	compter	de	la	date	d'achat	d'origine.	LA	GARANTIE	CI-DESSUS	EST	LA	GARANTIE	UNIQUE	ET
EXCLUSIVE	OFFERTE	PAR	BELIGHT	SOFTWARE.	BELIGHT	SOFTWARE	EXCLUT	TOUTES	LES	AUTRES
GARANTIES,	EXPRESSES	OU	IMPLICITES,	Y	COMPRIS,	NOTAMMENT,	LES	GARANTIES	IMPLICITES	DE
QUALITÉ	LOYALE	ET	MARCHANDE	ET	D'APTITUDE	À	UN	USAGE	PARTICULIER,	RELATIVES	AU	LOGICIEL
SOUS	LICENCE	ET	À	TOUS	LES	MATÉRIELS	L'ACCOMPAGNANT.	BELIGHT	SOFTWARE	ET	SES	AGENTS
NE	PEUVENT	ET	NE	GARANTISSENT	PAS	LES	PERFORMANCES	OU	LES	RÉSULTATS	QUE	VOUS	ÊTES
SUSCEPTIBLE	D'OBTENIR	EN	UTILISANT	CE	LOGICIEL.

9.	LIMITATION	DE	RESPONSABILITÉ
BELIGHT	SOFTWARE	OU	SES	AGENTS	NE	SONT	EN	AUCUN	CAS	RESPONSABLES	ENVERS	VOUS	DE
DOMMAGES-INTÉRÊTS,	RÉCLAMATIONS	OU	COÛTS	DE	QUELQUE	NATURE	QUE	CE	SOIT,	OU	DE	TOUS
DOMMAGES	CONSÉCUTIFS,	INDIRECTS	OU	ACCIDENTELS,	OU	DE	TOUT	MANQUE	À	GAGNER.	LA
RESPONSABILITÉ	GÉNÉRALE	DE	BELIGHT	SOFTWARE	ET	DE	SES	AGENTS	DANS	LE	CADRE	DE	CE
CONTRAT	OU	EN	RAPPORT	AVEC	CE	DERNIER,	EST	LIMITÉE	AU	MONTANT	VERSÉ	POUR
L'ACQUISITION	DU	LOGICIEL,	LE	CAS	ÉCHÉANT.

10.	FRAIS
Le	Logiciel	peut	être	disponible	sous	forme	de	téléchargement	électronique	ou	sur	un	DVD.	Si	vous
téléchargez	une	version	du	Logiciel	sans	Code	de	licence	fourni,	vous	pouvez	enregistrer	votre	copie	du
Logiciel	en	achetant	un	Code	de	licence	pour	la	version	téléchargée	à	l'adresse	:
http://www.belightsoft.com/buy/	Le	Code	de	licence	désactivera	la	fonction	d'impression	limitée	du
Logiciel.	En	achetant	la	version	du	Logiciel	sur	DVD,	votre	Code	de	licence	vous	est	fourni	avec	le	DVD.
Vous	n'êtes	pas	autorisé	à	distribuer	le	Code	de	licence.	En	cliquant	sur	Accepter,	vous	reconnaissez
avoir	payé	au	Concédant	tous	les	frais	de	licence	applicables	au	Logiciel.

11.	DIVISIBILITÉ
Si	une	disposition	du	présent	contrat	est	déclarée	nulle	et	non	exécutoire	par	un	tribunal	d'une
juridiction	compétente,	ladite	déclaration	n'affectera	pas	les	autres	dispositions	du	présent	contrat.

12.	STIPULATIONS	GÉNÉRALES
Ce	Contrat	de	Licence	est	personnel	entre	Vous	et	BeLight	Software.	Il	n'est	pas	transférable	et	toute
tentative	de	Votre	part	de	louer,	donner	en	crédit-bail,	concéder	une	sous-licence,	assigner	ou
transférer	les	droits,	devoirs	et	obligations	ci-après	est	nulle.	VOUS	RECONNAISSEZ	AVOIR	LU	ET
COMPRIS	LE	PRÉSENT	CONTRAT	ET	VOUS	ACCEPTEZ	D'ÊTRE	LIÉ	CONTRACTUELLEMENT	PAR	SES
DISPOSITIONS.	EN	OUTRE,	VOUS	ACCEPTEZ	QUE	LES	PRÉSENTES	CONSTITUENT	LA	DÉCLARATION
COMPLÈTE	ET	EXCLUSIVE	DU	CONTRAT	ENTRE	VOUS	ET	BELIGHT	SOFTWARE.	IL	SE	SUBSTITUE	À
TOUTE	PROPOSITION	OU	CONTRAT	ANTÉRIEUR,	ORAL	OU	ÉCRIT,	ET	À	TOUTE	AUTRE
COMMUNICATION	ENTRE	VOUS	ET	BELIGHT	SOFTWARE	OU	LES	AGENTS	DE	BELIGHT	SOFTWARE,
CONCERNANT	LE	LOGICIEL	SOUS	LICENCE.

Pour	toute	question	concernant	ce	Contrat	ou	pour	toute	demande	d'informations	à	BeLight	Software,
veuillez	utiliser	l'adresse	et	les	coordonnées	fournies	avec	ce	produit	afin	de	contacter	BeLight
Software.
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marques	commerciales	de	BeLight	Software,	Ltd.	Mac,	le	logo	Mac,	Mac	OS	X,	macOS,	iPhoto,	Photos
et	Macintosh	sont	des	marques	commerciales	d'Apple	Computer,	Inc.	Images	numériques	©	1997-
2015	Hemera	Technologies,	Inc.,	©	1994-2017	GSICO,	Inc.	Parties	sous	licence	de	Nova	Development
et	ses	concédants,	y	compris	©	1997-98	Seattle	Support	Group.	Tous	droits	réservés.	Avery	est	une
marque	commerciale	d'Avery	Dennison	Corporation.	L'inclusion	de	«	SPARKLE	»	:	Copyright	(c)	2006
Andy	Matuschak.	Toutes	les	autres	marques	commerciales,	marques	déposées,	produits	et/ou	noms	de
marques	sont	la	propriété	exclusive	de	leurs	détenteurs	respectifs.
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Fenêtre	principale	de	Swift	Publisher

1	–	Barre	d'outils.	C'est	ici	que	vous	pouvez	sélectionner	un	outil	de	texte	ou	de	dessin.

2	–	Panneau	Source.	Vous	pouvez	utiliser	ce	panneau	pour	prévisualiser	le	contenu	de	la	bibliothèque
Clipart	intégrée	et	accéder	à	des	images	stockées	dans	Photos.

3	–	Outils	de	mise	en	page.	Ces	outils	vous	permettent	d'ajouter	ou	de	supprimer	des	pages,	de	définir
l'échelle	de	l'espace	de	travail	et	bien	plus	encore.

4	–	Espace	de	travail.	C'est	ici	que	vous	affichez	et	modifiez	votre	document.

5	–	Règle.	La	règle	vous	permet	de	définir	les	coordonnées	et	la	taille	des	objets	ou	d'ajouter	des
lignes	de	repère.

6	–	Inspecteur.	Il	se	compose	de	plusieurs	onglets	qui	contiennent	les	outils	et	les	propriétés	de
différents	objets.

Barre	d'outils

1	–	Options	d'affichage.
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1.1	–	Afficher	ou	masquer	le	panneau	Source.

1.2	–	Afficher	ou	masquer	les	règles.

1.3	–	Afficher	ou	masquer	la	grille.

1.4	–	Activer	ou	désactiver	le	mode	Aperçu.	Ce	bouton	vous	permet	d'afficher	ou	de	masquer	les	lignes
de	repère,	les	marges	et	d'autres	repères	auxiliaires.

2	–	Outil	Sélection.	Utilisez	cet	outil	pour	sélectionner	et	déplacer	des	objets.	Pour	l'activer,	appuyez
sur	la	touche	V.

3	–	Outils	de	texte.	Il	existe	plusieurs	outils	de	texte.	Pour	les	afficher	tous,	cliquez	en	maintenant	le
bouton	de	la	souris	enfoncé	(ou	cliquez	sur	une	flèche),	puis	sélectionnez	l'outil	nécessaire	dans	le
menu	local.

L'icône	d'outil	de	texte	généralement	affichée	correspond	à	celle	du	dernier	outil	de	texte	utilisé.
Cliquez	une	fois	pour	activer	l'outil	de	texte	affiché	dans	l'icône.	Si	vous	cliquez	une	deuxième	fois	sur
un	outil	déjà	sélectionné,	cet	outil	est	activé	de	manière	permanente.	Au	lieu	de	se	comporter	comme
en	mode	normal,	il	reste	activé	après	l'ajout	d'une	zone	de	texte	pour	que	vous	puissiez	continuer	à
ajouter	d'autres	zones	de	texte.	Pour	désactiver	l'outil,	cliquez	sur	un	autre	outil	tel	que	l'outil	de
sélection.

3.1	–	Texte	normal.	Utilisez	cet	outil	pour	ajouter	des	zones	de	texte,	y	compris	des	zones	de	texte
liées,	où	le	texte	s'enchaîne	d'une	zone	à	une	autre.	Pour	l'activer,	appuyez	sur	la	touche	T.

3.2	–	Texte	circulaire.	Pour	l'activer,	appuyez	sur	la	touche	U.

3.3	–	Texte	vertical.	Pour	l'activer,	appuyez	sur	la	touche	Y.

4	–	Outils	de	dessin	de	formes.	Veuillez	noter	qu'il	existe	plusieurs	outils	correspondant	à	différentes
formes.	Pour	les	afficher	tous,	cliquez	en	maintenant	le	bouton	de	la	souris	enfoncé	(ou	cliquez	sur	une
flèche),	puis	sélectionnez	l'outil	nécessaire	dans	le	menu	local.

Si	vous	cliquez	une	deuxième	fois	sur	un	outil	déjà	sélectionné,	cet	outil	est	activé	de	manière
permanente.	Au	lieu	de	se	comporter	comme	en	mode	normal,	il	reste	activé	après	l'ajout	d'une	forme
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pour	que	vous	puissiez	continuer	à	ajouter	d'autres	formes	du	même	type.	Pour	désactiver	l'outil,
cliquez	sur	un	autre	outil	tel	que	l'outil	de	sélection.

4.1	–	Outil	Rectangle.	Utilisez	cet	outil	pour	tracer	des	rectangles	et	des	carrés.	Pour	l'activer,	appuyez
sur	la	touche	R.

4.2	–	Outil	Cercle.	Utilisez	cet	outil	pour	tracer	des	cercles	et	des	ovales.	Pour	l'activer,	appuyez	sur	la
touche	C.

5	–	Outils	de	dessin	de	lignes.	Veuillez	noter	qu'il	existe	plusieurs	outils	correspondant	a	différents
types	de	lignes.	Pour	les	afficher	tous,	cliquez	en	maintenant	le	bouton	de	la	souris	enfoncé	(ou	cliquez
sur	une	flèche),	puis	sélectionnez	l'outil	nécessaire	dans	le	menu	local.

Si	vous	cliquez	une	deuxième	fois	sur	un	outil	déjà	sélectionné,	cet	outil	est	activé	de	manière
permanente.	Au	lieu	de	se	comporter	comme	en	mode	normal,	il	reste	activé	après	l'ajout	d'une	ligne
pour	que	vous	puissiez	continuer	à	ajouter	d'autres	lignes	du	même	type.	Pour	désactiver	l'outil,
cliquez	sur	un	autre	outil	tel	que	l'outil	de	sélection.

5.1	–	Outil	Ligne.	Utilisez	cet	outil	pour	tracer	des	lignes.	Pour	l'activer,	appuyez	sur	la	touche	L.

5.2	–	Outil	Spline.	Utilisez	cet	outil	pour	tracer	des	lignes	courbes	et	des	polygones.	Pour	l'activer,
appuyez	sur	la	touche	S.

6	–	Zoom	arrière.

7	–	Zoom	avant.

8	–	Importer	des	graphiques	de	sources	différentes.

8.1	–	Ouvrir	le	stock	d'images	en	ligne	Depositphotos	dans	un	navigateur	intégré.	Ce	service	requiert
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une	inscription	préalable.

8.2	–	Importer	une	carte	créée	par	Google.

8.3	–	Concevoir	et	importer	des	graphiques	à	partir	d'Art	Text.	Art	Text	est	une	application	autonome.
Vous	devez	l'installer	et	vous	procurer	une	licence	pour	pouvoir	utiliser	cette	fonctionnalité.

8.4	–	Importer	une	image	à	partir	d'un	fichier.

9	–	Option	permettant	de	partager	votre	document	en	format	PDF.

10	–	Imprimer	le	document	actuel.

11	–	Sélection	ou	modification	des	styles	de	texte.

12	–	Insérer	un	tableau.

13	–	Insérer	un	calendrier.

14	–	Insérer	un	code-barres.

16	–	Afficher	ou	masquer	l'inspecteur.

Panneau	Source

1	–	Clipart	intégré.

2	–	Importez	des	images	à	partir	de	votre	photothèque	Photos	ou	d'un	dossier	de	votre	disque.

3	–	Bibliothèque	de	formes	intelligentes	intégrée.

4	–	Collection	de	conceptions	de	titre.
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Inspecteur
L'inspecteur	se	trouve	sur	le	côté	droit	de	la	fenêtre	principale.	Il	contient	un	ensemble	d'outils
permettant	de	modifier	les	propriétés	des	objets	et	des	documents.	Les	outils	sont	regroupés	dans
différents	onglets.	Pour	ouvrir	l'inspecteur,	sélectionnez	Présentation	>	Afficher	l'inspecteur
(Commande	+	Alt	+	I)	dans	le	menu	ou	cliquez	sur	le	bouton	Inspecteur	dans	la	barre	d'outils.

Onglet	Document

L'onglet	Document	vous	permet	de	définir	la	taille	de	la	page,	la	largeur	des	marges	et	de	saisir	le	nom
de	l'auteur	ainsi	que	le	titre	du	document.	Pour	ouvrir	cet	onglet,	appuyez	sur	Commande	+	1.

Pour	des	informations	détaillées,	reportez-vous	à	la	section	Propriétés	du	document.
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Onglet	Géométrie

L'onglet	Géométrie	vous	permet	de	modifier	la	position,	la	taille	et	l'angle	de	rotation	des	objets.	Il
comporte	également	des	outils	d'alignement.	Pour	ouvrir	cet	onglet,	appuyez	sur	Commande	+	2.

Pour	des	informations	détaillées,	reportez-vous	aux	sections	:

Modification	de	la	taille	des	objets
Alignement	et	répartition	des	objets
Utilisation	des	formes	intelligentes
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Onglet	Apparence

L'onglet	Apparence	vous	permet	de	définir	l'ombre	et	l'opacité	de	l'objet,	ainsi	que	d'autres	propriétés
graphiques.	Pour	ouvrir	cet	onglet,	appuyez	sur	Commande	+	3.

Pour	des	informations	détaillées,	reportez-vous	aux	sections	:

Remplissage	d'objets	avec	des	couleurs
Application	des	réglages	de	contour
Application	de	l'effet	d'ombre
Utilisation	d'images
Utilisation	des	formes	intelligentes
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Onglet	Texte

L'onglet	Texte	contient	des	outils	de	mise	en	forme	du	texte.	Pour	ouvrir	cet	onglet,	appuyez	sur
Commande	+	4.

Pour	des	informations	détaillées,	reportez-vous	à	la	section	Utilisation	du	texte.

Calques	et	panneau	Grille

Un	panneau	situé	en	bas	de	l'inspecteur	vous	donne	accès	à	la	liste	des	calques	de	votre	document	et
aux	réglages	de	grille	situés	dans	des	sections	séparées.	Cliquez	sur	une	icône	d'onglet	pour	ouvrir	une
section	particulière.
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Vous	pouvez	augmenter	ou	diminuer	la	taille	du	panneau	en	faisant	glisser	son	bord	supérieur.	Pour
fermer	le	panneau,	faites	glisser	le	bord	supérieur	tout	en	bas.	Pour	ouvrir	à	nouveau	le	panneau,
faites	glisser	le	bord	supérieur	vers	le	haut.	Vous	pouvez	aussi	ouvrir	le	panneau	Calques	ou	Grille	en
sélectionnant	Présentation	>	Inspecteur.

Pour	des	informations	détaillées,	reportez-vous	aux	sections	:

Gestion	des	calques
Grille
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Zone	de	dialogue	Préférences
La	zone	de	dialogue	Préférences	comporte	des	réglages	qui	sont	appliqués	par	défaut	chaque	fois	que
vous	exécutez	l'application.	Vous	pouvez	contrôler	le	fonctionnement	du	programme	en	les	modifiant.

Pour	ouvrir	la	zone	de	dialogue	Préférences,	choisissez	Swift	Publisher	5	>	Préférences…	dans	le
menu	ou	appuyez	sur	Commande	+	«	,	».

Onglet	Général

Pour	nouveaux	documents	vous	permet	de	spécifier	l'action	que	le	programme	doit	exécuter	au
moment	de	son	lancement	ou	lorsque	vous	choisissez	de	créer	un	document.

Afficher	la	galerie	de	modèles	:	le	programme	ouvre	la	galerie	de	modèles.	Vous	pouvez	alors
ouvrir	et	modifier	l'un	des	modèles	proposés.
Afficher	la	zone	de	dialogue	Nouveau	document	:	le	programme	ouvre	la	zone	de	dialogue
Nouveau	document	où	vous	pouvez	configurer	le	format,	les	marges	et	d'autres	propriétés	de
page,	puis	créer	un	document	vierge.
Créer	un	document	vierge	:	le	programme	ouvre	un	document	vierge	doté	des	propriétés	par
défaut.	Pour	modifier	les	propriétés	par	défaut,	cliquez	sur	le	bouton	Personnaliser.	Cela
permet	d'ouvrir	la	zone	de	dialogue	Nouveau	document.

Format	par	défaut	des	modèles	vous	permet	de	déterminer	si	les	designs	que	vous	ouvrez	à	partir
de	la	galerie	de	modèles	adoptent	le	format	de	page	métrique	ou	américain	(US).

Enregistrement	automatique	détermine	la	fréquence	d'enregistrement	automatique	des	copies	de
votre	document.	Cette	copie	de	sauvegarde	se	trouve	dans	le	même	dossier	que	le	document.	Lorsque
vous	modifiez	l'intervalle	d'enregistrement	automatique,	celui-ci	prend	effet	une	fois	que	l'intervalle
défini	précédemment	est	terminé.	Pour	appliquer	le	nouvel	intervalle	immédiatement,	redémarrez	le
programme.

Unités	de	mesure	définit	les	unités	de	toutes	les	dimensions	et	de	tous	les	contrôles	de
positionnement	dans	le	programme.

Rechercher	quotidiennement	les	mises	à	jour	spécifie	si	le	programme	doit	rechercher
automatiquement	les	mises	à	jour.	Pour	effectuer	une	recherche	manuelle	de	mises	à	jour,	choisissez
Swift	Publisher	5	>	Rechercher	les	mises	à	jour….	Cette	option	n'est	pas	disponible	dans
l'application	achetée	sur	le	Mac	App	Store.

Le	bouton	Valeurs	par	défaut…	rétablit	l'état	par	défaut	des	réglages	de	la	zone	de	dialogue
Préférences.

Pour	réinitialiser	le	programme	s'il	ne	s'ouvre	pas	ou	pour	revenir	à	l'état	où	il	se	trouvait	juste	après
l'installation,	lancez-le	en	maintenant	la	touche	Alt	enfoncée.

Onglet	Design

Les	Repères	intelligents	vous	permettent	d'indiquer	comment	aligner	les	objets	lorsque	vous	les
déplacez	ou	que	vous	les	redimensionnez	à	l'aide	de	la	souris.	Lorsque	l'une	de	ces	options	est	activée,
le	curseur	se	colle	aux	autres	objets,	aux	lignes	de	repère,	aux	marges	de	page	ou	aux	bords	de	page.
Vous	pouvez	aussi	désactiver	temporairement	le	magnétisme	des	objets	en	maintenant	la	touche
Commande	enfoncée	pendant	que	vous	déplacez	ou	redimensionnez	un	objet.

Couleur	des	repères	définit	la	couleur	des	lignes	de	repère	verrouillées	ou	déverrouillées.

Zoom	par	défaut	vous	permet	de	définir	l'échelle	de	document	par	défaut	des	nouveaux	documents.
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Police	par	défaut	vous	permet	de	spécifier	la	police	utilisée	pour	les	nouvelles	zones	de	texte.
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Menus
Swift	Publisher
Fichier
Édition
Insertion
Présentation
Format
Arranger
Fenêtre
Aide

Menu	Swift	Publisher

À	propos	de	Swift	Publisher
5

Affiche	la	zone	de	dialogue	contenant	des	informations	sur	le
programme.

Licence… Permet	d'accéder	aux	informations	de	licence.	(Non	disponible	dans
l'application	achetée	sur	le	Mac	App	Store.)

Rechercher	les	mises	à
jour…

Recherche	les	dernières	mises	à	jour	sur	Internet.	(Non	disponible
dans	l'application	achetée	sur	le	Mac	App	Store.)

Préférences…
(Commande	+	«	,	») Affiche	la	zone	de	dialogue	des	préférences	du	programme.

Acheter	des	images	clipart
supplémentaires… Permet	d'acheter	d'autres	images.

Restaurer	les	achats…
Télécharge	des	images	clipart	supplémentaires	déjà	achetées.
(Disponible	uniquement	dans	l'application	achetée	sur	le	Mac	App
Store.)

Quitter	(Commande	+	Q) Quitte	l'application.

Menu	«	Fichier	»

Nouveau	(Commande	+	N)
Crée	un	document.	En	fonction	des	réglages	spécifiés	dans	les
Préférences,	le	programme	ouvre	un	document	vierge	ou	la	Galerie
de	modèles.

Ouvrir…	(Commande	+	O) Ouvre	un	document	existant.

Ouvrir	récent	> Ouvre	la	liste	des	derniers	documents	sur	lesquels	vous	avez	travaillé.

Fermer	(Commande	+	W) Ferme	la	fenêtre	du	document	ouvert.

Enregistrer…
(Commande	+	S) Enregistre	le	document	actuel.

Dupliquer Ouvre	une	copie	du	document	actuel	dans	une	nouvelle	fenêtre.

Renommer… Renomme	le	document	actuel.

Placer	dans… Transfère	le	document	actuel	à	un	autre	emplacement.

Enregistrer	comme	modèle… Enregistre	le	document	ouvert	sous	forme	de	modèle.
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Exporter…
(Commande	+	Alt	+	E) Enregistre	le	document	ouvert	sous	forme	de	fichier	graphique.

Revenir	à… Annule	toutes	les	modifications	du	document	actuel	effectuées	après
le	dernier	enregistrement.

Page	>	Ajouter Ajoute	une	page	à	la	fin	du	document.	Si	un	document	est	présenté
sous	forme	de	planches,	la	commande	ajoute	une	planche.

Page	>	Insérer Ajoute	une	page	après	la	page	actuelle.	Si	un	document	est	présenté
sous	forme	de	planches,	la	commande	insère	une	planche.

Page	>	Effacer Supprime	la	page	actuelle.	Si	un	document	est	présenté	sous	forme
de	planches,	la	commande	supprime	une	planche.

Page	>	Dupliquer Crée	une	copie	de	la	page	actuelle.	Si	un	document	est	présenté	sous
forme	de	planches,	la	commande	duplique	une	planche.

Page	>	Première	page
(touche	Origine) Se	rend	à	la	première	page.

Page	>	Page	précédente
(touche	Page	précédente) Se	rend	à	la	page	précédente.

Page	>	Page	suivante
(touche	Page	suivante) Se	rend	à	la	page	suivante.

Page	>	Dernière	page
(touche	Fin) Se	rend	à	la	dernière	page.

Page	>	Planche	précédente Se	rend	à	la	planche	précédente.	Cette	option	est	disponible	pour	les
documents	présentés	sous	forme	de	planches.

Page	>	Planche	suivante Se	rend	à	la	planche	suivante.	Cette	option	est	disponible	pour	les
documents	présentés	sous	forme	de	planches.

Imprimer…
(Commande	+	P) Affiche	la	zone	de	dialogue	d'impression.

Menu	«	Édition	»

Annuler	(Commande	+	Z) Annule	la	dernière	opération	que	vous	avez	effectuée.

Rétablir
(Commande	+	Maj	+	Z) Rétablit	la	dernière	opération	annulée.

Couper	(Commande	+	X) Supprime	les	objets	ou	le	texte	sélectionné	et	place	la	sélection	dans
le	Presse-papiers.

Copier	(Commande	+	C) Copie	les	objets	ou	le	texte	sélectionné	dans	le	Presse-papiers.

Coller	(Commande	+	V) Colle	le	contenu	du	Presse-papiers	dans	le	document.

Coller	et	appliquer	le	style
actuel
(Commande	+	Maj	+	Alt	+	V)

Colle	le	texte	du	Presse-papiers	dans	une	zone	de	texte.	Le	texte
inséré	adopte	le	style	utilisé	par	le	texte	existant	dans	la	zone	(ou	le
style	par	défaut	si	la	zone	est	vide).
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Dupliquer	(Commande	+	D) Duplique	les	objets	sélectionnés.

Supprimer	(touche	Suppr) Supprime	les	objets	sélectionnés.

Modifier	le	titre Modifie	un	titre.

Modifier	dans	Art	Text
Ouvre	l'objet	Art	Text	sélectionné	dans	l'application	Art	Text.
(Vous	devez	installer	Art	Text	pour	rendre	cette	commande
disponible.)

Tout	sélectionner
(Commande	+	A) Sélectionne	tous	les	objets	du	calque	actuel	de	la	page	actuelle.

Rechercher	>	Rechercher…
(Commande	+	F) Ouvre	la	zone	de	dialogue	Rechercher.

Rechercher	>	Rechercher	le
suivant	(Commande	+	G)

Recherche	l'occurrence	suivante	d'un	mot	ou	d'une	expression
saisie	dans	la	zone	de	dialogue	Rechercher.

Rechercher	>	Rechercher	le
précédent
(Commande	+	Maj	+	G)

Recherche	l'occurrence	précédente	d'un	mot	ou	d'une
expression	saisie	dans	la	zone	de	dialogue	Rechercher.

Rechercher	>	Rechercher	la
sélection	(Commande	+	E)

Recherche	l'occurrence	suivante	d'un	mot	ou	d'une	expression
que	vous	avez	sélectionnée	dans	la	zone	de	texte.

Rechercher	>	Aller	à	la	sélection
(Commande	+	J) Affiche	les	objets	sélectionnés	dans	la	vue	du	document.

Vérifier	l'orthographe	et	la
grammaire	>	Afficher	les	fautes
d'orthographe	et	de	grammaire
(Commande	+	«	:	»)

Ouvre	la	zone	de	dialogue	Orthographe.

Vérifier	l'orthographe	et	la
grammaire	>	Vérifier	le	document
(Commande	+	«	;	»)

Vérifie	l'orthographe.

Vérifier	l'orthographe	et	la
grammaire	>	Vérifier
l'orthographe	lors	de	la	frappe

Vérifie	l'orthographe	lors	de	la	frappe.

Substitutions Remplace	automatiquement	le	texte	ou	les	symboles.

Transformations Convertit	le	texte	sélectionné	en	lettres	majuscules	ou
minuscules	ou	le	met	en	majuscules.

Démarrer	la	dictée…	(Fn	Fn) Dicte	votre	texte.

Emoji	et	symboles
(Commande	+	Contrôle	+	Espace) Ouvre	le	panneau	Caractères.

Menu	«	Insertion	»

Image	>	Depuis	fichier… Insère	une	image	à	partir	d'un	fichier.

Image	>	Génération
aléatoire… Insère	une	image	générée	de	manière	aléatoire.
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Image	>	Rechercher	sur
internet… Recherche	des	images	sur	internet.

Image	>	Depositphotos… Ouvre	le	stock	d'images	en	ligne	Depositphotos	dans	un	navigateur
intégré.

Forme	intelligente	> Ouvre	la	liste	des	formes	intelligentes.

Texte	>	Zone	de	texte Ajoute	une	zone	de	texte.

Texte	>	Zone	de	texte
vertical Ajoute	une	zone	de	texte	pour	accueillir	du	texte	vertical.

Texte	>	Texte	circulaire Ajoute	un	texte	circulaire.

Texte	>	Zone	de	texte	liée	à
la	page	suivante
(Commande	+	Alt	+	L)

Insère	une	zone	de	texte	liée	à	la	page	suivante.	L'emplacement	et	la
taille	de	la	nouvelle	zone	de	texte	est	la	même	que	la	zone	actuelle.
Une	nouvelle	page	est	ajoutée	au	document,	si	nécessaire.

Tableau Ajoute	un	tableau.

Calendrier Ajoute	un	calendrier.

Carte… Insère	une	carte	de	Google	Maps.	Cette	fonction	nécessite	une
connexion	Internet.

Code-barres	> Ouvre	la	liste	des	codes-barres.

Champ	d'adresse	> Ouvre	la	liste	des	coordonnées	de	contact	afin	de	les	importer	à	partir
de	Contacts.

Données	de	fichier
Ajoute	un	champ	de	données	permettant	d'importer	de	manière
dynamique	des	informations	à	partir	d'un	fichier	spécifié	lors	de	la
fusion	d'impression.

Compteur Ajoute	un	champ	de	données	dont	la	valeur	augmente	ou	diminue	de
manière	dynamique	lors	de	la	fusion	d'impression.

Numéro	de	page Insère	le	numéro	de	page.

Date	et	heure Insère	la	date	et	l'heure	actuelles.

Repère	vertical Insère	une	ligne	de	repère	verticale.

Repère	horizontal Insère	une	ligne	de	repère	horizontale.

Repères	de	mise	en	page… Ouvre	un	outil	qui	vous	permet	d'ajouter	une	grille	de	repères
d'alignement.

Menu	«	Présentation	»

Zoom	>	Zoom	avant
(Commande	+	Contrôle	+	«	+	») Agrandit	la	vue	actuelle.

Zoom	>	Zoom	arrière
(Commande	+	Contrôle	+	«	-	») Fait	un	zoom	arrière	dans	la	vue	actuelle.

Zoom	>	Taille	réelle
(Commande	+	0) Affiche	le	document	grandeur	nature	(100	%).
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Zoom	>	Pleine	largeur Redimensionne	le	document	afin	que	sa	largeur	s'ajuste	à	la	largeur
de	la	fenêtre.

Zoom	>	Pleine	hauteur Redimensionne	le	document	afin	que	sa	hauteur	s'ajuste	à	la	hauteur
de	la	fenêtre.

Zoom	>	Adapter	à	la	page Redimensionne	le	document	afin	que	la	page	actuelle	tienne	dans	la
fenêtre.

Pages	de	contenu Affiche	les	pages	ordinaires	sur	l'espace	de	travail.

Gabarits Affiche	les	gabarits	sur	l'espace	de	travail.

Rotation	de	la	vue	de	90°	à
gauche

Fait	pivoter	la	page	de	90	degrés	dans	le	sens	inverse	des	aiguilles
d'une	montre.

Rotation	de	la	vue	de	90°	à
droite

Fait	pivoter	la	page	de	90	degrés	dans	le	sens	des	aiguilles	d'une
montre.

Annuler	la	rotation Annule	la	rotation	de	la	page.

Afficher/Masquer	les	calques
au-dessus	du	calque	actif

Rend	visibles	ou	invisibles	tous	les	objets	des	calques	au-dessus	du
calque	actuel.

Afficher/Masquer	le	panneau
Source
(Commande	+	Alt	+	S)

Affiche	ou	masque	le	panneau	Source.

Afficher/Masquer
l'inspecteur
(Commande	+	Alt	+	I)

Affiche	ou	masque	le	panneau	de	l'inspecteur.

Inspecteur	>	Document
(Commande	+	1) Ouvre	l'onglet	Document	de	l'inspecteur.

Inspecteur	>	Géométrie
(Commande	+	2) Ouvre	l'onglet	Géométrie	de	l'inspecteur.

Inspecteur	>	Apparence
(Commande	+	3) Ouvre	l'onglet	Apparence	de	l'inspecteur.

Inspecteur	>	Texte
(Commande	+	4) Ouvre	l'onglet	Texte	de	l'inspecteur.

Inspecteur	>	Calques
(Commande	+	5) Ouvre	la	liste	des	calques.

Inspecteur	>	Grille
(Commande	+	6) Ouvre	les	réglages	de	grille.

Afficher/Masquer	la	grille
(Commande	+	Alt	+	\) Affiche	ou	masque	la	grille.

Afficher/Masquer	les	règles
(Commande	+	R) Affiche	ou	masque	les	règles.

Activer/Désactiver	le	mode
Aperçu	(Commande	+	\)

Affiche	ou	masque	les	lignes	de	repère,	les	marges	et	les	autres
objets	non	imprimables.
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Afficher/Masquer	l'Aperçu	de
pages
(Commande	+	Alt	+	P)

Affiche	ou	masque	le	panneau	Pages.

Afficher/Masquer	la	barre
d'outils
(Commande	+	Alt	+	T)

Affiche	ou	masque	la	barre	d'outils.

Personnaliser	la	barre
d'outils… Ouvre	la	zone	de	dialogue	Personnaliser	la	barre	d'outils.

Menu	«	Format	»

Afficher/Masquer	les	polices
(Commande	+	T) Affiche	ou	masque	la	sous-fenêtre	Police.

Afficher/Masquer	les
couleurs	(Commande	+	Maj
+	C)

Affiche	ou	masque	la	sous-fenêtre	Couleurs.

Police	>	Gras
(Commande	+	B)
Police	>	Italique
(Commande	+	I)
Police	>	Souligné
(Commande	+	U)
Police	>	Contour
(Commande	+	Maj	+	O)

Modifie	les	propriétés	du	texte	sélectionné.

Police	>	Plus	grand
(Commande	+	«	+	»)
Police	>	Plus	petit
(Commande	+	«	-	»)

Augmente/réduit	la	taille	du	texte	sélectionné.

Police	>	Crénage
Police	>	Ligature
Police	>	Ligne	de	base

Modifie	les	propriétés	du	texte	sélectionné.

Texte	>	Aligner	à	gauche
(Commande	+	«	{	»)
Texte	>	Centrer
(Commande	+	«	|	»)
Texte	>	Aligner	à	droite
(Commande	+	«	}	»)
Texte	>	Justifier

Aligne	le	texte	à	gauche,	à	droite,	le	centre	ou	le	justifie.

Texte	>	Autoriser	la	césure Autorise	la	césure.

Texte	>	Alterner	la	direction
d'écriture Alterne	la	direction	d'écriture.

Image	>	Modifier… Ouvre	la	zone	de	dialogue	Modifier	l'image.

Image	>	Recadrer
(Commande	+	K) Recadre	l'image	sélectionnée.

Image	>	Taille	d'origine Affiche	l'image	à	sa	taille	d'origine.

Image	>	Mosaïque Crée	une	image	en	mosaïque.
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Tableau	>	Ajouter	une
rangée	au-dessus Ajoute	une	rangée	au-dessus	de	la	rangée	actuelle.

Tableau	>	Ajouter	une
rangée	en	dessous Ajoute	une	rangée	en	dessous	de	la	rangée	actuelle.

Tableau	>	Ajouter	une
colonne	avant Ajoute	une	colonne	à	gauche	de	la	colonne	actuelle.

Tableau	>	Ajouter	une
colonne	après Ajoute	une	colonne	à	droite	de	la	colonne	actuelle.

Tableau	>	Diviser	en
rangées Divise	la	cellule	sélectionnée	en	deux	rangées.

Tableau	>	Diviser	en
colonnes Divise	la	cellule	sélectionnée	en	deux	colonnes.

Tableau	>	Supprimer	la
rangée Supprime	la	rangée	sélectionnée.

Tableau	>	Supprimer	la
colonne Supprime	la	colonne	sélectionnée.

Tableau	>	Effacer	les
cellules Supprime	le	contenu	des	cellules	sélectionnées.

Tableau	>	Fusionner	les
cellules Fusionne	les	cellules	sélectionnées.

Tableau	>	Modifier	le
tableau…

Ouvre	la	zone	de	dialogue	pour	modifier	le	nombre	de	rangées	ou	de
colonnes.

Zone	de	texte	>	Convertir	le
texte	en	image Transforme	le	texte	sélectionné	en	image.

Zone	de	texte	>	Séparer	la
zone	de	texte Sépare	une	zone	de	texte	sélectionnée.

Calendrier	>	Modifier	le
calendrier…

Ouvre	la	zone	de	dialogue	vous	permettant	de	modifier	les	propriétés
du	calendrier	sélectionné.

Modifier	les	styles	de	texte… Ouvre	la	zone	de	dialogue	vous	permettant	de	modifier	les	propriétés
des	styles	de	texte.

Créer	un	style	de	texte	à
partir	de	la	sélection…

Crée	un	nouveau	style	de	texte	à	l'aide	des	propriétés	du	texte
sélectionné.
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Menu	«	Arranger	»

Avancer
(Commande	+	Alt	+	F)
Mettre	au	premier	plan
(Commande	+	Maj	+	F)
Reculer
(Commande	+	Alt	+	B)
Envoyer	à	l'arrière-plan
(Commande	+	Maj	+	B)

Déplace	les	objets	sélectionnés	devant	ou	derrière	d'autres	objets.

Calques	>	Ajouter	un	calque Ajoute	un	calque	devant	le	calque	actuel.

Calques	>	Supprimer	le
calque Supprime	le	calque	actuel.

Calques	>	Passer	au	calque
supérieur	(Cmd	+	]) Active	le	calque	supérieur.

Calques	>	Passer	au	calque
inférieur	(Cmd	+	[) Active	le	calque	inférieur.

Calques	>	Visible Rend	le	calque	actuel	visible	ou	invisible.

Calques	>	Imprimable Rend	le	calque	actuel	imprimable	ou	non	imprimable.

Placer	la	sélection	sur	le
calque	>	… Place	les	objets	sélectionnés	sur	le	calque	spécifié.

Retournement	horizontal Retourne	l'image	sélectionnée	horizontalement.

Retournement	vertical Retourne	l'image	sélectionnée	verticalement.

Rotation	de	90°	à	gauche Fait	pivoter	l'objet	sélectionné	de	90	degrés	dans	le	sens	inverse	des
aiguilles	d'une	montre.

Rotation	de	90°	à	droite Fait	pivoter	l'objet	sélectionné	de	90	degrés	dans	le	sens	des	aiguilles
d'une	montre.

Aligner	>	Bords	gauches Aligne	les	bords	gauches	des	objets	sélectionnés.

Aligner	>	Bords	droits Aligne	les	bords	droits	des	objets	sélectionnés.

Aligner	>	Bords	supérieurs Aligne	les	bords	supérieurs	des	objets	sélectionnés.

Aligner	>	Bords	inférieurs Aligne	les	bords	inférieurs	des	objets	sélectionnés.

Aligner	>	Centres	verticaux Aligne	verticalement	les	centres	des	objets	sélectionnés.

Aligner	>	Centres
horizontaux Aligne	horizontalement	les	centres	des	objets	sélectionnés.

Répartir	>	Espacer
horizontalement Crée	un	espacement	horizontal	égal	entre	les	objets	sélectionnés.

Répartir	>	Espacer
verticalement Crée	un	espacement	vertical	égal	entre	les	objets	sélectionnés.

Répartir	>	Centrer
horizontalement

Crée	un	espacement	horizontal	égal	entre	les	centres	des	objets
sélectionnés.
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Répartir	>	Centrer
verticalement

Crée	un	espacement	vertical	égal	entre	les	centres	des	objets
sélectionnés.

Centrer	verticalement
(Commande	+	Maj	+	V)

Déplace	les	objets	sélectionnés	en	les	centrant	verticalement	sur	la
page.

Centrer	horizontalement
(Commande	+	Maj	+	H)

Déplace	les	objets	sélectionnés	en	les	centrant	horizontalement	sur
la	page.

Grouper
(Alt	+	Commande	+	G) Regroupe	les	objets	sélectionnés.

Dégrouper
(Alt	+	Maj	+	Commande	+	G) Dégroupe	les	objets	sélectionnés.

Verrouiller/Déverrouiller	les
repères Verrouille	ou	déverrouille	toutes	les	lignes	de	repère.

Supprimer	tous	les	repères Supprime	toutes	les	lignes	de	repère.

Menu	«	Fenêtre	»

Placer	dans	le	Dock
(Commande	+	M) Place	la	fenêtre	actuellement	active	dans	le	Dock.

Zoom Fait	un	zoom	sur	la	fenêtre	actuelle.

Tout	ramener	au	premier
plan

Place	toutes	les	fenêtres	de	l'application	devant	les	fenêtres	des
autres	applications	actives.

Menu	«	Aide	»

Aide	Swift	Publisher	5 Ouvre	la	documentation	de	l'Aide	fournie	avec	l'application.

Site	Web	de	BeLight
Software Site	web	du	développeur	de	Swift	Publisher.

Ressources	utiles	en	ligne Ressources	utiles	du	site	Web	BeLight	Software	concernant	Swift
Publisher.

Enregistrement	en	ligne… Envoie	vos	informations	d'enregistrement	au	développeur.	(Non
disponible	dans	l'application	achetée	sur	le	Mac	App	Store.)

Envoyer	un	commentaire… Vous	permet	d'envoyer	un	commentaire	aux	développeurs	par
courrier	électronique.

Didacticiels	vidéo Permet	de	visualiser	des	didacticiels	vidéo	en	ligne	depuis	le
programme.

32



Raccourcis	clavier

Utilisation	de	documents

Commande	+	N Crée	un	document.

Commande	+	O Ouvre	un	document	existant.

Commande	+	W Ferme	le	document	actif.

Commande	+	S Enregistre	le	document	actuel.

Commande	+	Maj	+	S Enregistre	le	document	actif	sous	un	autre	nom	de	fichier.

Commande	+	Alt	+	E Enregistre	le	document	ouvert	sous	forme	de	fichier	graphique.

Commande	+	Q Quitte	l'application.

Commande	+	P Imprime	le	document	actuel.

Utilisation	des	objets

	

Commande	+	Z Annule	la	dernière	opération.

Commande	+	Maj	+	Z Rétablit	la	dernière	opération.

Commande	+	X Coupe	les	objets	sélectionnés	dans	le	Presse-papiers.

Commande	+	C Copie	les	objets	sélectionnés	dans	le	Presse-papiers.

Commande	+	V Colle	le	contenu	du	Presse-papiers	dans	le	document.

Commande	+	Alt	+	Maj	+	V
Colle	le	texte	du	Presse-papiers	dans	une	zone	de	texte.	Le	texte
inséré	adopte	le	style	utilisé	par	le	texte	existant	dans	la	zone	(ou	le
style	par	défaut	si	la	zone	est	vide).

Commande	+	D Duplique	les	objets	sélectionnés.

Suppr Supprime	les	objets	sélectionnés.

Commande	+	A Sélectionne	tous	les	objets	du	calque	actif	sur	la	page	actuelle.

Commande	+	Alt	+	F Avance	les	objets	sélectionnés.

Commande	+	Maj	+	F Place	les	objets	sélectionnés	au	premier	plan.

Commande	+	Alt	+	B Recule	les	objets	sélectionnés.

Commande	+	Maj	+	B Envoie	les	objets	sélectionnés	à	l'arrière-plan.

Commande	+	Maj	+	H Déplace	les	objets	sélectionnés	en	les	centrant	horizontalement	sur	la
page.

Commande	+	Maj	+	V Déplace	les	objets	sélectionnés	en	les	centrant	verticalement	sur	la
page.

Commande	+	K Recadre	l'image	sélectionnée.
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Flèche Déplace	les	objets	sélectionnés.

Maj	+	flèche Déplace	les	objets	sélectionnés	(déplacement	plus	important).

Commande	+	Alt	+	[flèche
gauche]

Fait	pivoter	l'objet	sélectionné	dans	le	sens	inverse	des	aiguilles
d'une	montre	par	incréments	de	1	degré.

Commande	+	Alt	+	[flèche
droite]

Fait	pivoter	l'objet	sélectionné	dans	le	sens	des	aiguilles	d'une
montre	par	incréments	de	1	degré.

Commande	+	Alt	+	Maj	+	[flèche
gauche]

Fait	pivoter	l'objet	sélectionné	dans	le	sens	inverse	des	aiguilles
d'une	montre	par	incréments	de	5	degrés.

Commande	+	Alt	+	Maj	+	[flèche
droite]

Fait	pivoter	l'objet	sélectionné	dans	le	sens	des	aiguilles	d'une
montre	par	incréments	de	5	degrés.

Commande	+	Alt	+	G Regroupe	les	objets	sélectionnés.

Commande	+	Alt	+	Maj	+	G Dégroupe	les	objets	sélectionnés.

Alt	+	Maj	+	clic Ajoute	un	point	d'ancrage	à	une	courbe.

Utilisation	de	pages

Origine Se	rend	à	la	première	page.

Page	précédente Se	rend	à	la	page	précédente.

Page	suivante Se	rend	à	la	page	suivante.

Fin Se	rend	à	la	dernière	page.

Utilisation	de	calques

Commande	+	«	]	» Ajoute	le	calque	au-dessus	du	calque	actuel.

Commande	+	«	[	» Ajoute	le	calque	en	dessous	du	calque	actuel.

Utilisation	des	fenêtres	et	des	zones	de	dialogue

	

Commande	+	Contrôle	+	«	+	» Effectue	un	zoom	avant.

Commande	+	Contrôle	+	«	-	» Effectue	un	zoom	arrière.

Commande	+	0 Affiche	le	document	grandeur	nature	(100	%).

Commande	+	M Place	la	fenêtre	active	dans	le	Dock.

Commande	+	W Ferme	la	fenêtre	du	document	actif.

Commande	+	«	,	» Affiche	la	zone	de	dialogue	Préférences	de	l'application.

Commande	+	Maj	+	C Affiche	ou	masque	la	sous-fenêtre	Couleurs.

Commande	+	T Affiche	ou	masque	la	sous-fenêtre	Polices.
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Commande	+	R Affiche	ou	masque	les	règles.

Commande	+	\ Active	ou	désactive	le	mode	Aperçu.

Commande	+	1 Ouvre	l'onglet	Document	de	l'inspecteur.

Commande	+	2 Ouvre	l'onglet	Géométrie	de	l'inspecteur.

Commande	+	3 Ouvre	l'onglet	Apparence	de	l'inspecteur.

Commande	+	4 Ouvre	l'onglet	Texte	de	l'inspecteur.

Commande	+	Alt	+	T Affiche	ou	masque	la	barre	d'outils.

Commande	+	Contrôle	+	F Active	ou	désactive	le	mode	plein	écran.

Commande	+	Alt	+	S Affiche	ou	masque	le	panneau	Source.

Commande	+	Alt	+	I Affiche	ou	masque	le	panneau	de	l'inspecteur.

Commande	+	Alt	+	P Affiche	ou	masque	le	panneau	Pages.

Utilisation	du	texte

Commande	+	B Met	le	texte	en	gras.

Commande	+	I Met	le	texte	en	italique.

Commande	+	U Souligne	le	texte.

Commande	+	Maj	+	O Donne	un	contour	au	texte.

Commande	+	«	+	» Augmente	la	taille	de	la	police.

Commande	+	«	-	» Réduit	la	taille	de	la	police.

Commande	+	«	{	» Aligne	à	gauche.

Commande	+	«	}	» Aligne	à	droite.

Commande	+	«	|	» Centre	le	texte.

Commande	+	Retour Quitte	le	mode	d'édition	de	texte.

Commande	+	«	:	» Ouvre	la	zone	de	dialogue	Orthographe.

Commande	+	«	;	» Vérifie	l'orthographe.

Commande	+	Alt	+	L Insère	une	zone	de	texte	liée	à	la	page	suivante.

Utilisation	de	la	souris

Maintenir	la	touche	Maj
enfoncée	lorsque	vous
utilisez	des	poignées

Passe	du	redimensionnement	proportionnel	au	redimensionnement
non	proportionnel	et	vice	versa.

Commande	+	souris Active	ou	désactive	le	magnétisme	des	objets.

Alt	+	souris Duplique	les	objets.
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Maj	+	clic Sélectionne/désélectionne	un	objet	sans	modifier	les	propriétés	des
autres	objets.

Contrôle	+	clic	ou	clic	droit
sur	un	objet Affiche	le	menu	contextuel	(menu	local)	de	l'objet.

Recherche

Commande	+	F Ouvre	la	zone	de	dialogue	Rechercher.

Commande	+	G Recherche	l'occurrence	suivante	d'un	mot	ou	d'une	expression	saisie
dans	la	zone	de	dialogue	Rechercher.

Commande	+	Maj	+	G Recherche	l'occurrence	précédente	d'un	mot	ou	d'une	expression
saisie	dans	la	zone	de	dialogue	Rechercher.

Commande	+	E Recherche	l'occurrence	suivante	d'un	mot	ou	d'une	expression	que
vous	avez	sélectionnée	dans	la	zone	de	texte.

Commande	+	J Affiche	les	objets	sélectionnés	dans	la	vue	du	document.

Utilisation	des	gestes	de	trackpad	sur	les	ordinateurs	pris	en	charge

Pincement	ouvrant/fermant Effectue	un	zoom	avant	ou	arrière.

Défilement	avec	deux	doigts Fait	défiler	verticalement	ou	horizontalement.

Activation	des	outils

V Outil	Sélection

T Outil	Zone	de	texte

Y Outil	Texte	vertical

U Outil	Texte	circulaire

R Outil	Rectangle

C Outil	Cercle

L Outil	Ligne

S Outil	Spline
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Création	d'un	document
Il	existe	plusieurs	manières	de	créer	un	document.	Si	la	Galerie	de	modèles	est	ouverte,	sélectionnez
l'un	des	modèles	et	cliquez	sur	le	bouton	Nouveau.

Si	la	Galerie	de	modèles	n'est	pas	ouverte,	choisissez	Fichier	>	Nouveau	(Commande	+	N)	dans	le
menu.	En	fonction	des	réglages	Pour	nouveaux	documents	sélectionnés	dans	la	zone	de	dialogue
Préférences,	le	programme	ouvrira	la	Galerie	de	modèles,	la	zone	de	dialogue	Nouveau	document	ou
un	nouveau	document.

Zone	de	dialogue	Nouveau	document

La	zone	de	dialogue	Nouveau	document	vous	permet	de	vérifier	et	de	modifier	les	principaux	réglages
de	document.

Les	réglages	de	taille	de	page,	d'orientation	et	de	marge	s'appliquent	à	toutes	les	pages	d'un	nouveau
document.	Vous	pouvez	toujours	modifier	ces	réglages	plus	tard	en	utilisant	l'inspecteur.	Soyez
toutefois	prudent	lorsque	vous	configurez	l'option	Mode	d'affichage.	Le	mode	d'affichage	en	planche
ou	en	page	unique	ne	peut	être	sélectionné	que	dans	la	zone	de	dialogue	Nouveau	document,	avant	de
créer	le	document,	et	ne	peut	plus	être	modifié	par	la	suite.

L'option	Mode	d'affichage	vous	permet	de	choisir	l'une	des	dispositions	de	documents.	L'espace	de
travail	peut	afficher	une	page	à	la	fois	ou	une	planche.
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Ouverture	d'un	document	existant
Pour	ouvrir	un	document	existant,	choisissez	l'une	des	méthodes	suivantes	:

Si	la	fenêtre	principale	est	active,	choisissez	Fichier	>	Ouvrir...	dans	le	menu
(Commande	+	O).
Ou	cliquez	sur	le	nom	de	votre	document	dans	le	menu	Fichier	>	Ouvrir	récent.
Enfin,	vous	pouvez	également	double-cliquer	sur	l'icône	du	document	dans	le	Finder.

Remarque	:	si	vous	avez	oublié	le	nom	de	votre	document	Swift	Publisher	et	que	le	document	ne
figure	pas	dans	la	liste	du	menu	Fichier	>	Ouvrir	récent,	essayez	de	le	retrouver	dans	le	Finder	en
recherchant	l'extension	de	fichier	«	spub	».

Utilisation	d'iCloud

Si	vous	possédez	un	compte	iCloud,	vous	avez	la	possibilité	d'ouvrir	vos	documents	depuis	votre
espace	de	stockage	iCloud.	L'option	iCloud	est	disponible	dans	la	zone	de	dialogue	Ouvrir	le	fichier.
Seule	l'édition	App	Store	du	programme	est	compatible	avec	iCloud.
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Enregistrement	d'un	document
Pour	enregistrer	un	document,	choisissez	Fichier	>	Enregistrer...	Si	vous	enregistrez	un	nouveau
document,	le	programme	vous	demande	de	lui	attribuer	un	nom	et	un	dossier	de	destination.

Le	système	d'exploitation	enregistre	automatiquement	des	versions	des	documents	modifiés.	Grâce	à
cette	fonctionnalité,	il	n'est	pas	nécessaire	d'enregistrer	vos	documents	pendant	que	vous	travaillez.
Étant	donné	que	la	fonction	d'enregistrement	automatique	a	certaines	limites,	nous	vous
recommandons	d'enregistrer	régulièrement	votre	travail	manuellement.

Pour	créer	une	copie	de	la	version	actuelle	d'un	document	ouvert,	choisissez	Fichier	>	Dupliquer.
Cette	commande	ne	crée	pas	immédiatement	un	nouveau	fichier.	Vous	devez	enregistrer
manuellement	le	fichier	dupliqué.

Création	de	modèles

Vous	pouvez	enregistrer	un	document	sous	forme	de	modèle	afin	de	pouvoir	le	réutiliser
ultérieurement	comme	base	pour	de	nouveaux	documents.	Pour	ce	faire,	choisissez	Fichier	>
Enregistrer	comme	modèle...	Pour	plus	d'informations,	reportez-vous	à	la	section	Utilisation	de
modèles.

Enregistrement	automatique

Vous	pouvez	choisir,	dans	les	Préférences	du	programme,	la	fréquence	à	laquelle	le	programme
enregistre	automatiquement	des	copies	de	votre	document.	Cette	fonction	est	utile	pour	éviter	de
perdre	des	données	en	cas	de	panne	d'électricité	ou	de	problèmes	avec	le	logiciel.

Utilisation	d'iCloud

Si	vous	possédez	un	compte	iCloud,	vous	avez	la	possibilité	d'enregistrer	vos	documents	dans	votre
espace	de	stockage	iCloud.	L'option	iCloud	est	disponible	dans	les	zones	de	dialogue	Enregistrer	et
Enregistrer	sous.	Cette	fonctionnalité	est	disponible	uniquement	si	le	programme	a	été	téléchargé
depuis	l'App	Store.
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Utilisation	de	modèles
Swift	Publisher	est	fourni	avec	une	collection	de	modèles.	Il	s'agit	de	conceptions	regroupées	en
catégories	(brochures,	prospectus,	etc.).	Pour	accéder	aux	modèles,	ouvrez	la	Galerie	de	modèles	en
sélectionnant	Fichier	>	Nouveau…	Si	cette	commande	ouvre	un	document	vierge,	vous	devez	alors
modifier	les	réglages	du	programme.	Dans	la	zone	de	dialogue	Préférences,	paramétrez	Pour	nouveaux
documents	sur	Afficher	la	galerie	de	modèles.

Outre	les	modèles	contenant	des	conceptions	graphiques	prêtes	à	l'emploi,	des	modèles	vierges	vous
sont	proposés.	Ces	modèles	présentent	différents	types	de	mises	en	page.

Vous	pouvez	également	créer	vos	propres	modèles	et	les	utiliser	comme	base	pour	de	futurs
documents.	Pour	enregistrer	un	document	sous	forme	de	modèle,	choisissez	Fichier	>	Enregistrer
comme	modèle...	dans	le	menu.	Le	programme	enregistre	les	modèles	dans	le	dossier	Mes	modèles.
Pour	accéder	au	contenu	de	ce	dossier,	sélectionnez	la	catégorie	Mes	modèles	de	la	galerie	de
modèles.

Pour	supprimer	un	modèle	personnalisé	ou	modifier	le	nom	de	fichier,	sélectionnez	la	catégorie	Mes
modèles,	puis	cliquez	sur	l'icône	de	flèche	dans	la	barre	de	sélection.

Lorsque	vous	enregistrez	un	document	créé	à	partir	d'un	modèle	standard	ou	personnalisé,	les
modifications	n'affectent	pas	le	fichier	d'origine.	En	effet,	le	modèle	en	lui-même	reste	inchangé.
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Propriétés	du	document
La	plupart	des	propriétés	du	document	se	trouvent	dans	l'onglet	Document	de	l'inspecteur.

Les	contrôles	Taille	de	la	page	vous	permettent	de	définir	la	taille	des	pages	de	votre	document.

Orientation	vous	permet	de	choisir	une	orientation	de	page	portrait	ou	paysage.	Ce	contrôle	ne	fait
pas	pivoter	le	contenu	de	la	page.

Simuler	la	couleur	du	papier	modifie	la	couleur	du	papier	sur	l'espace	de	travail	pour	vous	montrer
l'aspect	qu'aura	votre	document	après	impression	sur	du	papier	de	couleur.	La	couleur	sélectionnée	ne
sera	ni	imprimée,	ni	exportée.

Les	commandes	Marges	du	document	vous	permettent	de	définir	la	zone	de	travail,	indiquée	par	un
cadre	affiché	autour	des	bords	de	la	page.	Le	taille	des	marges	est	la	même	pour	toutes	les	pages	dans
le	document,	sauf	si	vous	utilisez	des	gabarits.	Pour	plus	de	détails,	reportez-vous	à	la	section	Lignes
de	repère	et	repères	de	marge.
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Vous	pouvez	fournir	des	détails	qui	seront	enregistrés	dans	le	document	en	remplissant	les	champs	de
la	section	Infos.
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Création	de	livrets

Préparation	d'un	livret

La	création	de	livrets	est	similaire	à	la	création	de	documents	multipages	standard,	mais	il	est
nécessaire	de	penser	à	certains	détails	au	préalable.

Taille	du	papier

Vous	devez	penser	au	format	de	papier	sur	lequel	vous	allez	imprimer.	La	plupart	des	utilisateurs	sont
susceptibles	d'imprimer	sur	une	imprimante	de	bureau.	Elles	prennent	en	charge	certains	formats	de
papier	parmi	lesquels	vous	devez	faire	votre	choix.	Selon	la	taille	du	papier	choisi,	calculez	la	taille	de
page	de	votre	document	(généralement	la	moitié	de	la	taille	du	papier).	Vous	trouverez	ci-dessous	une
explication	détaillée	à	ce	propos.

Pages	de	gauche	et	de	droite

Les	pages	qui	se	font	face	doivent	avoir	une	conception	en	miroir	étant	donné	que	les	marges
intérieures	et	extérieures	diffèrent	souvent	et	que	le	numéro	de	page	se	trouve	sur	le	bord	extérieur.

Le	programme	ne	permet	pas	de	réaliser	cette	opération	automatiquement.	Par	conséquent,	si	les
pages	de	gauche	et	de	droite	de	votre	livret	doivent	avoir	une	mise	en	page	différente	(en	miroir),
utilisez	des	gabarits	gauche	et	droit	différents.

Taille	de	la	page	et	taille	du	papier

Avant	de	commencer	votre	travail	sur	un	livret,	vous	devez	connaître	la	différence	entre	la	taille	de	la
page	et	la	taille	du	papier.

Swift	Publisher	permet	de	créer	des	livrets	à	deux	volets.	Deux	pages	de	votre	document	seront
imprimées	sur	un	côté	d'une	feuille	de	papier.	La	taille	du	papier	est	deux	fois	plus	grande	que	la	taille
de	la	page.

Page	du	document

Disposition	horizontale	des	pages
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Disposition	verticale	des	pages

Voici	quelques	exemples.	Si	vous	sélectionnez	le	format	Demi-lettre	dans	l'onglet	Document	de
l'inspecteur,	vous	devez	choisir	Lettre	dans	la	zone	de	dialogue	Imprimer.	Si	vous	indiquez	A5	dans
l'inspecteur,	choisissez	A4	dans	la	zone	de	dialogue	Imprimer.

Vous	pouvez	imprimer	sur	du	papier	autre	que	le	format	double	page.	Dans	ce	cas,	cochez	la	case
Adapter	à	la	taille	du	papier	dans	la	zone	de	dialogue	Imprimer.

Lorsque	vous	imprimez,	n'oubliez	pas	d'effectuer	les	opérations	suivantes	:

Définissez	la	taille	de	la	page	dans	l'inspecteur.
Définissez	la	taille	du	papier	dans	la	zone	de	dialogue	Imprimer.	Vous	devrez	peut-être	activer
l'option	Adapter	à	la	taille	du	papier.
Cochez	la	case	Formater	en	livret.	Choisissez	l'orientation	verticale	ou	horizontale.
Vérifiez	si	votre	imprimante	prend	en	charge	l'impression	recto	verso	(impression	automatique
sur	les	deux	côtés	du	papier).	Si	ce	n'est	pas	le	cas,	sélectionnez	le	recto	à	imprimer	dans	la
zone	de	dialogue	Imprimer	du	système,	puis	retournez	les	feuilles	de	papier	manuellement
pour	imprimer	du	côté	verso.

Lorsque	vous	exportez	en	format	PDF,	n'oubliez	pas	d'effectuer	les	opérations	suivantes	:

Définissez	la	taille	de	la	page	dans	l'inspecteur.
Cochez	la	case	Formater	en	livret.	Choisissez	l'orientation	verticale	ou	horizontale.

Imposition

L'application	réalise	automatiquement	l'imposition	lorsque	vous	avez	coché	l'option	Formater	en
livret.

La	fonction	d'imposition	réordonne	les	pages	afin	qu'une	fois	les	feuilles	imprimées	et	pliées,	les	pages
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se	trouvent	dans	l'ordre	correct.	Dans	une	mise	en	page	à	double	volet,	il	est	possible	de	placer	quatre
pages	sur	une	feuille	:	deux	sur	un	côté	et	deux	sur	l'autre.

Ordre	des	pages	normal

Document
d'origine

	 	

Ordre	des	pages	lors	de	l'impression	avec	imposition

Feuilles
du	livret
Recto

Feuilles
du	livret
Verso
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Impression
Pour	imprimer	avec	les	réglages	par	défaut,	sélectionnez	Fichier	>	Imprimer	(Commande	+	P),	puis
cliquez	sur	le	bouton	Imprimer.

Pour	imprimer	à	l'aide	des	options	avancées	:

1.	 Sélectionnez	Fichier	>	Imprimer	(Commande	+	P	pour	ouvrir	la	zone	de	dialogue
Imprimer.	Elle	s'affiche	généralement	en	mode	simple	par	défaut.

Cliquez	sur	le	bouton	Afficher	les	détails	pour	ouvrir	les	réglages	d'impression	avancés.
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Swift	Publisher	possède	ses	propres	options	d'impression	(2).	Elles	sont	affichées	par	défaut.

2.	 Définissez	les	réglages	généraux	(1).	Soyez	attentif	aux	éléments	suivants	:
•	Les	préréglages	(généralement,	les	réglages	par	défaut	sont	sélectionnés	ici)
•	La	taille	du	papier

3.	 Dans	la	section	Swift	Publisher	:
•	Sélectionnez	Adapter	à	la	taille	du	papier	(3)	si	la	Taille	du	papier	dans	la	zone	de
dialogue	Imprimer	est	différente	de	la	Taille	de	la	page	dans	l'onglet	Document	de
l'inspecteur.	Cette	option	est	normalement	désactivée.
•	Pour	imprimer	un	livret,	cochez	la	case	Formater	en	livret	(5).	Choisissez	l'orientation	de
page	(6)	du	livret.
•	Si	vous	voulez	utiliser	la	fonction	de	fusion	d'impression	pour	imprimer	des	coordonnées	de
contact,	cliquez	sur	le	bouton	Liste	d'impression	(7)	et	sélectionnez	les	contacts
correspondants.
•	Définissez	le	paramètre	Quantité	si	votre	document	contient	des	champs	dynamiques
comme	Compteur	ou	Données	de	fichier.

4.	 Vérifiez	les	autres	réglages	d'impression	proposés	par	le	système	d'exploitation	et	le	pilote
d'impression.	Pour	accéder	à	ces	réglages,	choisissez	les	catégories	correspondantes	dans	le
menu	déroulant	(2).

Si	vous	voulez	imprimer	sur	les	deux	faces	du	papier	à	l'aide	d'une	imprimante	recto	verso,
ouvrez	la	section	Mise	en	page	(2)	et	réglez	l'option	Recto	verso	sur	Reliure	côté	long	ou
Reliure	côté	court.	
Sur	une	imprimante	ne	disposant	pas	de	la	fonction	recto	verso,	ouvrez	la	section	Gestion	du
papier	(2).	Réglez	ensuite	l'option	Pages	à	imprimer	sur	Pages	impaires	ou	Pages	paires,
imprimez	sur	l'un	des	côtés	de	toutes	les	pages,	retournez	le	papier,	puis	imprimez	sur	l'autre
côté	après	avoir	sélectionné	l'autre	option.

5.	 Veillez	à	ce	que	l'aperçu	affiche	correctement	votre	document.

6.	 Cliquez	sur	le	bouton	Imprimer.
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Les	réglages	Copies	et	Quantité	produisent	le	même	résultat	lorsque	votre	document	ne	contient	pas
de	champs	dynamiques	ni	de	codes-barres	avec	des	valeurs	dynamiques.	En	l'occurrence,	le	champ
Quantité	définit	le	nombre	de	copies	à	imprimer,	de	même	que	le	champ	Copies.	La	situation	change
si	vous	ajoutez	un	champ	de	texte	Compteur	ou	Données	de	fichier,	ou	un	code-barres	dont	les
données	sont	importées	depuis	un	fichier	ou	générées	par	un	compteur.	Dans	ce	cas,	Copies	définit	là
encore	le	nombre	exact	de	copies	à	imprimer,	alors	que	Quantité	indique	le	nombre	de	versions	du
document	où	les	champs	dynamiques	et	les	codes-barres	ont	une	nouvelle	valeur	dans	chaque	version.

Fusionner	l'impression

Si	vous	avez	ajouté	un	ou	plusieurs	champs	d'adresse	à	votre	document,	vous	pouvez	sélectionner	un
ou	plusieurs	contacts	dont	vous	souhaitez	insérer	les	coordonnées	dans	ces	champs.	Pour	cela,	cliquez
sur	le	bouton	Liste	d'impression.	Le	programme	peut	importer	des	coordonnées	à	partir	de	Contacts
d'Apple.

Si	une	personne	supplémentaire	est	sélectionnée,	le	programme	imprime	une	copie	supplémentaire	de
votre	document	(telle	qu'une	copie	supplémentaire	de	tout	le	livret).	Le	nombre	de	personnes
sélectionnées	est	indiqué	sous	le	bouton	Liste	d'impression.	Pour	indiquer	le	nombre	total	de	copies,
multipliez	le	nombre	de	contacts	sélectionnés	par	la	Quantité.

Pour	vous	assurer	que	des	données	automatiquement	insérées	tiennent	dans	l'espace	donné,	cliquez
sur	le	bouton	PDF	dans	la	zone	de	dialogue	Imprimer,	puis	sélectionnez	Ouvrir	le	PDF	dans	Aperçu.
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Exportation
Les	documents	sont	généralement	exportés	dans	un	format	graphique	afin	de	pouvoir	les	visualiser	sur
un	autre	ordinateur	ou	de	les	envoyer	à	un	atelier	d'impression.

Pour	exporter	votre	document	:

1.	 Sélectionnez	Fichier	>	Exporter…	dans	le	menu.

2.	 Saisissez	un	nom	de	fichier,	puis	choisissez	l'endroit	où	vous	souhaitez	l'enregistrer.

3.	 Choisissez	un	type	de	fichier	graphique	dans	la	liste	déroulante	Format.	Les	différences	entre
les	formats	de	fichier	sont	décrites	ci-dessous.

4.	 Cliquez	sur	Options…	pour	un	réglage	plus	précis.

5.	 Cliquez	sur	Enregistrer.

Remarque	:	vous	ne	pourrez	pas	modifier	des	objets	dans	un	document	enregistré	dans	un	format
graphique	comme	TIFF,	JPEG,	etc.

Remarque	:	il	existe	deux	méthodes	pour	donner	un	effet	d'ombre	au	texte.	La	première	consiste	à
utiliser	les	ombres	dans	la	sous-fenêtre	Polices	du	système.	L'autre	méthode	consiste	à	utiliser	les
contrôles	d'ombre	situés	dans	l'onglet	Apparence	de	l'inspecteur.	Lorsque	vous	exportez	vers	un	fichier
graphique,	nous	vous	recommandons	d'utiliser	la	seconde	méthode.	Si	les	ombres	de	l'image	exportée
ne	s'affichent	pas	correctement,	utilisez	un	autre	outil	pour	appliquer	des	ombres.

Pour	exporter	au	format	PDF,	vous	pouvez	également	utiliser	la	zone	de	dialogue	Imprimer	du
système.	Cliquez	sur	le	bouton	PDF,	puis	choisissez	Enregistrer	au	format	PDF	dans	le	menu	local.

Options	d'exportation

Cliquez	sur	le	bouton	Options...	dans	la	zone	de	dialogue	Exporter	pour	accéder	à	ces	réglages.

Format	PDF	:

Fonds	perdus	et	traits	de	coupe.
Qualité	d'image.	Le	programme	est	capable	de	modifier	la	résolution	des	images	rastérisées
lors	de	la	création	d'un	fichier	PDF.	Cela	vous	permet	de	contrôler	la	taille	du	fichier	PDF
résultant.	Pour	une	impression	de	haute	qualité,	sélectionnez	Originale	ou	Optimale.	Pour	créer
un	fichier	PDF	plus	petit	à	envoyer	par	e-mail	ou	à	publier	sur	Internet,	choisissez	Inférieure
ou	Écran.	Notez	que	tous	les	options	proposées	ici	,	à	l'exception	de	l'option	Originale,
convertissent	les	images	dans	la	palette	de	couleurs	RVB.
Filtres	Quartz	vous	permet	d'appliquer	des	effets	graphiques	à	toutes	les	images	du	PDF.
Convertir	le	texte	en	courbes	transforme	tout	le	texte	en	image	vectorielle.	Le	réglage	de
cette	option	peut	vous	aider	à	éviter	des	problèmes	de	polices	ou	peut	s'avérer	nécessaire
lorsque	vous	envoyez	un	fichier	PDF	à	un	atelier	d'impression.
Pages.	Cette	option	vous	permet	de	définir	une	ou	plusieurs	pages	à	exporter.
Formater	en	livret	classe	les	pages	d'un	document	à	deux	volets	dans	le	bon	ordre.
Flux	PDF.	Vous	pouvez	ici	choisir	un	flux	de	production	standard	ou	personnalisé	pour
effectuer	des	actions	sur	le	PDF	créé.

Format	TIFF	:

Fonds	perdus	et	traits	de	coupe.
Résolution.
Compression	LZW.	Comprime	l'image	TIFF	pour	réduire	la	taille	du	fichier.
Modèle	de	couleur.	Vous	pouvez	choisir	d'enregistrer	l'image	en	couleurs	RVB	ou	CMJN.
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Format	JPEG	:

Fonds	perdus	et	traits	de	coupe.
Résolution.
Qualité	(taux	de	compression).
Modèle	de	couleur.	Vous	pouvez	choisir	d'enregistrer	l'image	en	couleurs	RVB	ou	CMJN.

Format	PNG	:

Fonds	perdus	et	traits	de	coupe.
Résolution.
Fond	transparent.	Vous	pouvez	choisir	d'enregistrer	l'image	avec	ou	sans	transparence
(canal	alpha).

Format	EPS	:

Fonds	perdus	et	traits	de	coupe.
Convertir	le	texte	en	courbes	transforme	tout	le	texte	en	image	vectorielle.	Le	réglage	de
cette	option	peut	vous	aider	à	éviter	des	problèmes	de	polices	ou	peut	s'avérer	nécessaire
lorsque	vous	envoyez	votre	fichier	EPS	à	un	atelier	d'impression.

Attention	:	l'activation	de	l'option	Convertir	le	texte	en	courbes	peut	augmenter	significativement
la	taille	du	fichier	obtenu.

Les	fonds	perdus	sont	une	zone	supplémentaire	le	long	des	bords	de	votre	page.	En	ajoutant	des	fonds
perdus,	vous	augmentez	la	taille	de	la	page.	Les	fonds	perdus	servent	à	imprimer	au-delà	des	bordures
du	document,	sur	des	feuilles	de	papier	de	taille	supérieure	qui	seront	ensuite	découpées.	Pour	en
savoir	plus	sur	les	fonds	perdus	et	leur	utilité,	consultez	la	section	Fonds	perdus.

Choix	d'un	format	graphique	pour	l'exportation

Si	vous	n'êtes	pas	sûr	du	format	à	utiliser,	contactez	l'atelier	d'impression	ou	le	lieu	où	vous	allez
utiliser	votre	document.

Le	format	TIFF	procure	une	qualité	d'image	supérieure	comparée	au	format	JPEG.	L'inconvénient	du
format	TIFF	est	que	l'exportation	du	document	prend	plus	de	temps.	De	plus,	les	fichiers	TIFF	peuvent
être	plus	volumineux	pour	une	même	résolution.

Le	format	JPEG	peut	être	utilisé	pour	les	images,	mais	pas	toujours	pour	le	texte	et	les	éléments
graphiques	comme	les	lignes	fines.	Utilisez	JPEG	lorsque	vous	souhaitez	créer	un	aperçu	de	qualité
inférieure	de	votre	document,	l'envoyer	par	e-mail	ou	l'intégrer	à	un	site	Web.

Dans	la	plupart	des	cas,	le	format	PDF	est	le	meilleur.	Les	fichiers	PDF	sont	peu	volumineux	grâce	à
une	compression	efficace.	Ce	format	est	optimal	pour	les	documents	qui	associent	du	texte	à	des
éléments	graphiques.	Les	fichiers	PDF	peuvent	contenir	des	données	dans	un	format	vectoriel.
Contrairement	aux	formats	TIFF	et	JPEG,	un	fichier	PDF	peut	contenir	un	document	de	plusieurs	pages.

Exportation	au	format	PDF	et	EPS	avec	des	couleurs	CMJN

Contrairement	aux	autres	formats	pris	en	charge,	les	formats	PDF	et	EPS	ne	proposent	pas	d'option
permettant	de	sélectionner	le	modèle	de	couleurs.	Le	programme	conserve	les	couleurs	d'origine	des
objets	lorsqu'il	crée	un	fichier	PDF	ou	EPS.	Cela	signifie	que	devez	penser	au	modèle	de	couleurs	dès	le
début	de	votre	travail	sur	un	nouveau	document.

Un	fichier	PDF	est	considéré	se	trouver	dans	l'espace	de	couleurs	CMJN	si	tous	les	objets	sont	en	CMJN.
Si	vous	utilisez	des	objets	RVB	et	CMJN	dans	le	même	document,	un	logiciel	graphique	reconnaîtra	le
fichier	exporté	comme	un	fichier	RVB.

50



Pour	un	fichier	totalement	CMJN,	il	est	nécessaire	de	sélectionner	toutes	les	propriétés	de	couleur
d'objet	à	l'aide	des	curseurs	CMJN	dans	la	sous-fenêtre	Couleurs	standard.	Par	exemple,	pour	un	objet
texte,	il	est	nécessaire	de	sélectionner	les	couleurs	CMJN	pour	le	texte	lui-même,	le	cadre	de	la	zone
de	texte	et	l'arrière-plan	de	la	zone	de	texte.

Pour	ouvrir	les	curseurs	CMJN,	affichez	la	sous-fenêtre	Couleurs	(Commande	+	Maj	+	C),	ouvrez
l'onglet	Curseurs	de	couleur,	puis	sélectionnez	Curseurs	CMJN	dans	le	menu	local.

Pour	connaître	le	modèle	de	couleurs	d'une	image,	ouvrez-la	dans	l'application	Aperçu.	Ouvrez	la	sous-
fenêtre	Infos	(Commande	+	I).	L'onglet	Général	affiche	le	modèle	de	couleurs.

Rappelez-vous	également	que	certains	contenus	graphiques	créés	ou	modifiés	dans	le	programme	sont
toujours	en	RVB	:

les	ombres,
les	images	modifiées	à	l'aide	de	I'éditeur	d'images	intégré,
les	images	créées	à	l'aide	du	générateur	d'images,
les	images	créées	à	l'aide	du	module	Art	Text,
les	images	clipart	intégrées.
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Fonds	perdus
Les	imprimeurs	professionnels	utilisent	du	papier	plus	grand	que	la	taille	finale	des	pages	afin	de
pouvoir	imprimer	au-delà	des	bords,	puis	de	les	découper.	On	utilise	ce	terme	car	une	partie	du	fond
de	l'image	n'est	pas	conservée	et	sera	donc	perdue.

Imaginez	que	vous	deviez	imprimer	un	livret	avec	un	arrière-plan	de	couleur	couvrant	la	totalité	de	la
page.	Si	vous	vous	contentez	de	l'imprimer,	il	se	peut	que	vous	obteniez	des	bords	blancs	indésirables
en	cas	d'impression	ou	de	découpe	mal	centrée.	Lorsqu'un	fond	perdu	est	imprimé	au-delà	des	bords
de	la	page,	on	évite	les	problèmes	de	bords	blancs	indésirables.

Les	images	ci-dessous	vous	montrent	comment	fonctionne	la	commande	Fonds	perdus.	Dans	l'image
de	gauche,	l'option	Fonds	perdus	est	désactivée.	L'illustration	est	découpée	exactement	le	long	du	bord
du	document.	L'image	de	droite	est	un	exemple	d'impression	avec	fonds	perdus.	Une	partie	de
l'illustration	est	imprimée	au-delà	du	bord	du	document.
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Mise	en	page
Chaque	document	se	compose	d'un	ou	de	plusieurs	calques.	Deux	calques	existent	par	défaut	(arrière-
plan	et	avant-plan).

Chaque	calque	est	un	espace	isolé	où	vous	pouvez	placer	des	objets.	Les	calques	sont	empilés	dans	la
structure.	On	peut	assimiler	les	calques	à	des	transparents	superposés.	Vous	pouvez	voir	les	objets
d'un	calque	inférieur	à	travers	une	zone	vide	du	calque	supérieur.

Un	calque	permet	d'isoler	plusieurs	objets	et	de	gérer	conjointement	leurs	propriétés.	Lorsque	vous
modifiez	les	propriétés	d'un	calque,	tous	les	objets	sur	ce	calque	sont	affectés.	Par	exemple,	si	vous
rendez	un	calque	invisible,	tous	ses	objets	deviennent	invisibles.

Vous	pouvez	attribuer	un	gabarit	à	toute	page	standard	(page	de	contenu).	Un	gabarit	contient	sa
propre	pile	de	calques.	Lorsqu'un	gabarit	est	attribué,	il	est	placé	derrière	le	calque	de	niveau	inférieur
de	la	page	de	contenu.	En	général,	les	pages	de	contenu	sont	utilisées	pour	les	objets	standard	(texte
et	éléments	graphiques).	Les	gabarits	sont	utilisés	pour	des	objets	qui	apparaissent	au	même
emplacement	sur	plusieurs	pages	(numéros	de	page,	décoration	en	arrière-plan,	etc.).

La	mise	en	page	la	plus	simple	est	constituée	de	pages	de	contenu	(sans	gabarit)	dotées	d'un	seul
calque.	Cela	équivaudrait	à	un	éditeur	de	texte	standard.	Une	mise	en	page	sophistiquée	peut
comprendre	une	page	de	contenu	dotée	de	plusieurs	calques	et	un	gabarit	doté	de	ses	propres	calques.

La	pile	de	calques	est	la	même	pour	toutes	les	pages	du	document.	Cela	signifie	que	si	vous	ajoutez	un
calque	à	n'importe	quelle	page	de	contenu,	ce	calque	apparaît	sur	toutes	les	autres	pages,	y	compris
les	gabarits.	Si	vous	masquez	un	calque,	les	objets	sur	ce	calque	disparaissent	de	toutes	les	pages.
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Gestion	des	calques
Dans	Swift	Publisher,	le	flux	de	production	est	basé	sur	les	calques	afin	de	vous	aider	à	gérer	les
créations	complexes	tout	en	encombrant	au	minimum	votre	espace	de	travail.	Les	calques	servent
généralement	à	isoler	le	texte,	les	illustrations,	l'arrière-plan	et	d'autres	éléments	de	conception.	En
règle	générale,	un	calque	est	consacré	au	texte	et	un	autre	aux	images	et	aux	éléments	d'arrière-plan.
Un	nouveau	document	possède	deux	calques	(avant-plan	et	arrière-plan).	Vous	pouvez	ajouter	autant
de	calques	que	nécessaire.

Chaque	calque	se	trouve	sur	toutes	les	pages	de	votre	document,	y	compris	les	gabarits.	La
modification	de	la	visibilité	d'un	calque	ou	le	fait	de	le	rendre	non	imprimable	a	une	incidence	sur	les
objets	situés	sur	ce	calque	dans	la	totalité	de	votre	projet.	Admettons	que	vous	vouliez	imprimer	un
brouillon	de	votre	document	pour	en	réviser	le	texte.	Vous	pouvez	rendre	invisibles	les	calques
contenant	des	images	d'arrière-plan	afin	de	n'imprimer	que	le	texte.

Vous	pouvez	gérer	les	calques	à	l'aide	de	la	commande	Arranger	>	Calques	dans	le	menu	ou	du
panneau	Calques	en	bas	de	l'inspecteur.	Pour	ouvrir	la	liste	de	calques,	sélectionnez	Présentation	>
Inspecteur	>	Calques.

1	–	Le	nom	du	calque	actif	est	mis	en	surbrillance.	Pour	activer	un	autre	calque,	cliquez	sur	son	nom.

2	–	Propriété	Imprimable.	Les	objets	sur	des	calques	non	imprimables	sont	visibles,	mais	ne	sont	ni
imprimés	ni	exportés.

3	–	Propriété	Visible.	Les	objets	sur	des	calques	invisibles	sont	invisibles.	Ils	ne	sont	ni	imprimés	ni
exportés.	Vous	ne	pouvez	pas	modifier	un	calque	invisible.

4	–	Cliquez	sur	l'icône	de	stylo	pour	renommer	un	calque.	Vous	devez	activer	un	calque	pour	pouvoir	le
renommer.

Activation	d'un	calque

Vous	ne	pouvez	modifier	que	les	objets	qui	se	trouvent	sur	le	calque	actif.

Pour	activer	un	calque,	sélectionnez	son	nom	dans	le	menu	Arranger	>	Calques	ou	le	menu	local.
Vous	pouvez	aussi	cliquer	sur	le	nom	du	calque	dans	l'inspecteur.

Création	de	calques

Pour	créer	un	calque,	choisissez	Ajouter	un	calque	dans	le	menu	Arranger	>	Calques	ou	le	menu
local.	Une	autre	manière	d'ajouter	un	calque	consiste	à	cliquer	sur	le	bouton	«	plus	»	en	dessous	de	la
liste	des	calques.
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Suppression	de	calques

Pour	supprimer	le	calque	actif,	choisissez	Supprimer	le	calque	dans	le	menu	Arranger	>	Calques
ou	le	menu	local.	Une	autre	manière	de	supprimer	un	calque	consiste	à	cliquer	sur	le	bouton	«	moins	»
en	dessous	de	la	liste	des	calques.

Il	n'est	pas	possible	de	supprimer	le	dernier	calque,	car	le	document	doit	en	contenir	au	moins	un.

Sachez	que	lorsque	vous	supprimez	le	calque,	vous	supprimez	également	tous	les	objets	de	ce	calque
sur	toutes	les	pages.

Rendre	un	calque	non	imprimable

Pour	rendre	un	calque	non	imprimable,	décochez	Imprimable	dans	le	menu	Arranger	>	Calques	ou
cliquez	sur	l'icône	Imprimable	dans	le	menu	local.

Pour	rendre	un	calque	imprimable,	faites	l'inverse.

Rendre	un	calque	invisible

Pour	rendre	un	calque	invisible,	décochez	Visible	dans	le	menu	Arranger	>	Calques	ou	cliquez	sur
l'icône	Visible	dans	le	menu	local.

Pour	rendre	un	calque	visible,	faites	l'inverse.

Pour	modifier	un	calque	invisible,	vous	devez	le	rendre	visible.

Réorganisation	des	calques	dans	la	pile	de	calques

Pour	modifier	la	position	d'un	calque	dans	la	pile	de	calques,	ouvrez	le	panneau	Calques	dans
l'inspecteur,	puis	faites	glisser	le	nom	du	calque	jusqu'à	un	nouvel	emplacement.	Pour	placer	un	calque
en	première	position	(devant	tous	les	autres),	faites-le	glisser	en	haut	de	la	liste.	Pour	placer	un	calque
en	dernière	position	(derrière	tous	les	autres),	faites-le	glisser	en	bas	de	la	liste.
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Déplacement	d'objets
Vous	ne	pouvez	sélectionner	et	déplacer	que	les	objets	sur	le	calque	actif.

Pour	déplacer	un	objet,	faites-le	glisser	avec	la	souris.

Pour	un	déplacement	précis,	sélectionnez	un	objet	et	utilisez	les	touches	de	direction.	Pour	déplacer
l'objet	par	incréments	plus	grands,	maintenez	la	touche	Maj	enfoncée	et	utilisez	les	touches	de
direction.

Dans	l'onglet	Géométrie	de	l'Inspecteur,	vous	pouvez	saisir	les	coordonnées	de	l'objet	pour	le
positionner	à	un	emplacement	exact.	Il	est	possible	de	changer	les	unités	de	mesure	dans	les
Préférences	du	programme	(Commande	+	«	,	»).

Lorsque	vous	déplacez	un	objet	avec	la	souris,	il	est	aimanté	automatiquement	aux	lignes	de	repère	et
aux	bords	des	autres	objets.	Vous	pouvez	désactiver	la	fonction	de	magnétisme	en	maintenant	la
touche	Commande	enfoncée	pendant	que	vous	déplacez	l'objet.	Pour	désactiver	cette	fonction	en
permanence,	décochez	les	cases	Aligner	sur...	dans	les	Préférences	du	programme.	Lorsque	le	bord
de	l'objet	que	vous	déplacez	est	aligné	sur	un	autre	objet,	un	repère	intelligent	(une	ligne	pointillée
bleue)	s'affiche.

Les	commandes	Arranger	>	Centrer	horizontalement	et	Arranger	>	Centrer	verticalement
placent	l'objet	sélectionné	au	centre	de	la	page,	le	long	de	l'axe	horizontal	ou	vertical.	Les	mêmes
commandes	se	trouvent	dans	l'onglet	Géométrie	de	l'inspecteur.

Déplacement	d'un	objet	vers	un	autre	calque

Le	déplacement	d'un	objet	décrit	ci-avant	en	modifie	la	position	sur	la	page.	En	outre,	vous	pouvez
déplacer	un	objet	depuis	un	calque	vers	un	autre.	Ainsi,	l'objet	est	déplacé	vers	un	autre	calque	sans
que	ses	coordonnées	sur	la	page	ne	soient	modifiées.

Pour	déplacer	un	objet	vers	un	autre	calque,	sélectionnez	le	nom	de	ce	calque	dans	le	menu	Arranger
>	Placer	la	sélection	sur	le	calque.

Les	objets	de	chaque	calque	forment	une	pile	dans	le	calque.	Lorsque	vous	ajoutez	des	objets	à	un
document,	chaque	objet	suivant	est	placé	au-dessus	des	objets	existants.	En	d'autres	termes,	une
image	ajoutée	ultérieurement	couvrira	les	images	ajoutées	précédemment.

Vous	pouvez	réorganiser	des	objets	situés	sur	un	même	calque	en	les	plaçant	devant	ou	derrière
d'autres	objets	à	l'aide	des	commandes	suivantes	:

Avancer	(Alt	+	Commande	+	F)	place	l'objet	sélectionné	un	niveau	au-dessus.
Mettre	au	premier	plan	(Maj	+	Commande	+	F)	place	l'objet	tout	en	haut.
Reculer	(Alt	+	Commande	+	B)	place	l'objet	sélectionné	en	bas.
Envoyer	à	l'arrière-plan	(Maj	+	Commande	+	B)	place	l'objet	sélectionné	en	dessous	des
autres.

Dans	certains	cas,	il	se	peut	que	vous	deviez	sélectionner	un	objet	totalement	couvert	par	un	autre
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objet	sur	le	même	calque,	ce	qui	n'est	pas	facile.	C'est	par	exemple	le	cas	lorsque	vous	souhaitez
redimensionner	ou	déplacer	une	image	utilisée	comme	arrière-plan	d'un	texte.	La	méthode	la	plus
facile	pour	accéder	à	des	objets	de	niveau	inférieur	est	de	cliquer	plusieurs	fois	sur	la	pile	d'objets	tout
en	maintenant	la	touche	Commande	enfoncée.	Chaque	fois	que	vous	cliquez,	l'objet	situé	derrière
l'objet	actuel	est	sélectionné.	Si	l'objet	de	premier	plan	n'est	pas	transparent	(une	image,	par
exemple),	vous	ne	voyez	que	les	poignées	de	sélection	des	objets	situés	derrière.
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Alignement	et	répartition	des	objets

Alignement	des	objets

Pour	aligner	les	bords	ou	les	centres	de	deux	objets	ou	plus,	sélectionnez-les,	puis	cliquez	sur	l'un	des
boutons	d'alignement	dans	l'onglet	Géométrie	de	l'inspecteur.	Ces	commandes	se	trouvent	également
dans	le	menu	Arranger	>	Aligner.

Répartition	des	objets

Pour	uniformiser	les	distances	entre	les	côtés	ou	les	centres	de	plusieurs	objets,	utilisez	les	boutons
dans	l'onglet	Géométrie	de	l'inspecteur.	Les	commandes	de	répartition	se	trouvent	dans	le	menu
Arranger	>	Répartir.	Trois	objets	au	moins	doivent	être	sélectionnés.

Emplacement	d'origine	des	images	:

Répartition	des	centres	:

Répartition	des	espacements	:
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Règles
Les	règles	peuvent	être	affichées	sur	les	côtés	supérieur	et	gauche	de	l'espace	de	travail.

Pour	afficher	ou	masquer	les	règles,	utilisez	Présentation	>	Afficher	les	règles	et	Présentation	>
Masquer	les	règles	(Commande	+	R)	dans	le	menu.

La	coordonnée	zéro	de	toute	page	se	trouve	dans	son	coin	supérieur	gauche.	La	position	exacte	d'un
objet	est	définie	par	le	coin	supérieur	gauche	de	son	cadre	de	sélection.

Les	unités	de	mesure	des	règles	et	commandes	de	l'inspecteur	sont	indiquées	dans	le	coin	des	règles.
Pour	changer	rapidement	d'unité	de	mesure,	cliquez	sur	l'unité	de	mesure	actuelle	dans	le	coin	des
règles,	par	exemple	«	pouces	»,	puis	choisissez	une	autre	unité	de	mesure.	Vous	pouvez	également
choisir	les	unités	de	mesure	dans	l'onglet	Général	des	Préférences.

Lorsque	vous	déplacez	un	objet	avec	la	souris,	les	règles	affichent	les	coordonnées	de	son	centre	et	de
ses	côtés.
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Lignes	de	repère	et	repères	de	marge

Lignes	de	repère

Les	lignes	de	repère	(ou	repères)	servent	à	aligner	plus	précisément	les	objets.	Elles	permettent
également	de	diviser	visuellement	la	page	en	plusieurs	parties.

Chaque	repère	est	commun	et	visible	sur	tous	les	calques	de	la	page	correspondante	(page	de
contenu).	Tout	repère	que	vous	positionnez	est	visible	sur	tous	les	calques	de	la	page	correspondante
(page	de	contenu).	Les	repères	du	gabarit	appliqué	aux	pages	de	contenu	sont	également	affichés.

Pour	ajouter	un	repère	:

Sélectionnez	Insertion	>	Repère	vertical	ou	Insertion	>	Repère	horizontal	dans	le
menu.	Lorsque	vous	ajoutez	un	repère	de	cette	manière,	celui-ci	est	automatiquement	centré,
soit	horizontalement,	soit	verticalement.
Placez	le	curseur	au-dessus	de	la	règle	verticale	ou	horizontale,	appuyez	sur	le	bouton	gauche
de	la	souris,	puis	déplacez	le	pointeur	de	la	souris	vers	l'espace	de	travail.	Relâchez	le	bouton
où	vous	le	souhaitez	pour	placer	le	repère.
Cliquez	avec	le	bouton	droit	de	la	souris	à	l'endroit	de	l'espace	de	travail	où	vous	voulez	placer
un	repère,	puis	sélectionnez	soit	Ajouter	repère	vertical,	soit	Ajouter	repère	horizontal
dans	le	menu	contextuel.

Pour	déplacer	un	repère,	faites-le	glisser	avec	la	souris.	Lorsque	vous	déplacez	un	repère,	sa	position
exacte	s'affiche	en	regard	du	curseur.

Pour	introduire	une	coordonnée	exacte,	ouvrez	le	menu	contextuel	d'un	repère	afin	d'y	saisir	les
coordonnées.

Pour	verrouiller	un	repère,	faites	un	clic	droit	dessus,	puis	sélectionnez	Verrouiller	le	repère	dans	le
menu	contextuel.	Pour	verrouiller	tous	les	repères,	sélectionnez	Arranger	>	Verrouiller	les	repères
dans	le	menu.	Le	verrouillage	des	repères	permet	d'éviter	de	les	déplacer	accidentellement.	Pour
déverrouiller	les	repères,	utilisez	le	menu	contextuel	ou	principal.

Pour	supprimer	un	repère	:

Glissez-déposez-le	sur	la	règle	parallèle	au	guide.
Faites	un	clic	droit	sur	le	repère,	puis	choisissez	Supprimer	le	repère.

Les	repères	ne	sont	pas	affichés	en	mode	Aperçu.

Vous	pouvez	modifier	la	couleur	des	repères	dans	l'onglet	Design	des	Préférences.

Vous	pouvez	choisir	les	unités	de	mesure	dans	l'onglet	Général	des	Préférences.

Grille	de	repères

Vous	pouvez	placer	plusieurs	repères	sur	la	page	entière	pour	créer	un	type	de	grille.	Pour	ce	faire,
sélectionnez	Insertion	>	Repères	de	mise	en	page…	dans	le	menu.	Sélectionnez	ensuite	l'un	des
deux	modes	Grille	ou	Lignes	et	colonnes	en	activant	l'onglet	correspondant.

Une	grille	de	repères	est	constituée	de	lignes	de	repère	régulières.	Vous	pouvez	les	déplacer	et	les
supprimer	individuellement,	comme	indiqué	ci-dessus.	Si	vous	avez	besoin	d'une	grille	régulière,	vous
pouvez	l'activer	dans	l'inspecteur.

L'onglet	Grille	permet	d'ajouter	des	repères	avec	des	espacements	égaux.	Une	option	permet	de
verrouiller	les	repères	après	leur	création.
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Ce	mode	est	utile	si	vous	devez	disposer	un	grand	nombre	d'objets	sur	la	page.

L'onglet	Lignes	et	colonnes	vous	permet	de	diviser	la	page	en	plusieurs	lignes	et	colonnes.	Cela	peut
s'avérer	utile	pour	ajouter	des	colonnes	de	texte	à	votre	création.

61



Le	paramètre	Gouttière	vous	permet	d'ajouter	des	espaces	entre	les	colonnes	ou	les	rangées.

La	case	Supprimer	les	repères	de	mise	en	page	existants	vous	permet	de	conserver	ou	de
supprimer	les	lignes	de	repère	présentes	dans	votre	mise	en	page.

Une	autre	option	vous	permet	de	déterminer	si	les	nouveaux	repères	doivent	être	disposés	sur	la	page
entière	ou	uniquement	dans	la	zone	des	marges	de	page.	Comparez	l'image	ci-dessous	avec	celle	ci-
dessus.

Repères	de	marge

Les	repères	de	marge	(marges	de	page)	vous	permettent	de	définir	l'espace	de	travail	sur	la	page.	Les
marges	de	page	sont	similaires	à	un	cadre.	L'espace	entre	les	repères	de	marge	et	les	bords	de	page
sont	généralement	laissés	sans	contenu	textuel.

Vous	pouvez	définir	les	réglages	de	marge	dans	l'onglet	Document	de	l'inspecteur.

La	taille	de	marge	est	commune	à	toutes	les	pages	de	contenu	du	document.	Lorsqu'un	gabarit	est
appliqué,	les	marges	communes	sont	remplacées	par	les	marges	de	ce	gabarit.	Pour	afficher	des
marges	différentes,	appliquez	des	gabarits	avec	des	marges	différentes.	Pour	obtenir	des	pages	de
gauche	et	de	droite,	créez	deux	gabarits	avec	des	marges	de	page	en	miroir.
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Les	marges	ne	sont	pas	affichées	en	mode	Aperçu.
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Grille
La	grille	peut	vous	aider	à	placer	des	objets	sur	une	page.	Elle	peut	aussi	vous	être	utile	lorsque	vous
redimensionnez	un	objet	à	l'aide	de	la	souris.

Pour	afficher	ou	masquer	la	grille,	cochez	la	case	Afficher	la	grille	dans	le	panneau	inférieur	de
l'inspecteur.	Vous	pouvez	également	utiliser	la	commande	Présentation	>	Afficher/Masquer	la
grille	(Commande	+	Alt	+	\)	dans	le	menu	principal.

L'inspecteur	vous	permet	de	déterminer	l'espacement	entre	les	lignes	verticales	et	horizontales	de	la
grille.	Pour	modifier	les	unités	de	mesure,	utilisez	l'onglet	Général	des	Préférences.

La	grille	s'applique	globalement	à	tous	les	calques	des	pages	de	contenu	et	des	gabarits.	Elle	est	visible
derrière	tous	les	objets	d'une	page.

Lorsque	vous	déplacez	ou	redimensionnez	un	objet,	les	bords	de	cet	objet	peuvent	se	coller	à	la	grille.
Pour	désactiver	le	magnétisme	sans	masquer	la	grille,	maintenez	la	touche	Commande	enfoncée.

La	grille	n'est	ni	imprimée	ni	exportée.
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Affichage	de	pages	dans	la	fenêtre	principale
Les	outils	qui	permettent	de	travailler	sur	des	pages	se	trouvent	sous	la	barre	d'outils.

1	–	Ouvre	le	panneau	Pages.	Ce	panneau	affiche	les	vignettes	de	toutes	les	pages.	Il	vous	permet
d'ajouter	et	de	supprimer	des	pages.

2	–	Échelle	du	document.

3	–	Pour	ouvrir	une	page	donnée,	saisissez	son	numéro	ici.

4	–	Affiche	des	pages	de	contenu	ou	des	gabarits.

Pour	travailler	avec	des	calques,	utilisez	le	panneau	Calques	dans	l'inspecteur.

Taille	et	orientation	de	la	page

Le	format	et	l'orientation	de	page	sont	les	mêmes	pour	toutes	les	pages	du	document.	Vous	pouvez
modifier	ces	réglages	dans	l'onglet	Document	de	l'inspecteur.

Vous	pouvez	faire	pivoter	l'affichage	de	pages	individuelles	ainsi	que	leur	contenu.	Pour	ce	faire,
choisissez	Présentation	>	Rotation	de	la	vue	de	90º	à	gauche	ou	Présentation	>	Rotation	de	la
vue	de	90º	à	droite.	Si	vous	ajoutez	un	objet	à	une	page	que	vous	avez	pivotée,	la	rotation	de	celui-
ci	dépend	de	l'orientation	d'origine	de	la	page.

Pour	afficher	la	page	avec	son	orientation	d'origine,	sélectionnez	Présentation	>	Annuler	la
rotation.

Affichage	des	calques

Vous	pouvez,	normalement,	voir	le	contenu	du	calque	actif	et	des	calques	qui	se	trouvent	en	dessous.
Pour	afficher	un	aperçu	de	la	page	telle	qu'elle	sera	imprimée	ou	exportée,	activez	le	calque	de	niveau
supérieur.

Pour	créer	le	calque	d'arrière-plan,	il	peut	s'avérer	nécessaire	de	voir	le	contenu	de	l'avant-plan.	Pour
activer	ce	mode	d'affichage,	choisissez	Présentation	>	Afficher	les	calques	au-dessus	du	calque
actif.

Vous	pouvez	masquer	individuellement	les	calques.	Pour	masquer	un	calque,	cliquez	sur	son	icône
représentant	un	œil	dans	la	liste	des	calques.	Pour	l'afficher,	cliquez	à	nouveau	sur	cette	icône.

Pages	individuelles	et	planches

Le	contenu	peut	s'afficher	dans	la	fenêtre	principale	sous	forme	de	pages	de	document	individuelles	ou
de	planches.	Dans	ce	dernier	cas,	deux	pages	opposées	sont	affichées	ensemble.	La	manière	dont	vos
documents	sont	affichés	dans	l'espace	de	travail	dépend	du	type	de	document	que	vous	sélectionnez
lorsque	vous	créez	un	document.	Le	programme	ne	vous	permet	pas	de	passer	d'un	mode	d'affichage
à	l'autre	pendant	que	vous	modifiez	le	document.

65



Mode	Aperçu

En	mode	Aperçu,	le	programme	affiche	ce	que	vous	voyez	dans	l'aperçu	d'impression.	Il	n'affiche	pas
les	objets	auxiliaires	comme	les	lignes	de	repère,	les	repères	de	mise	en	page	et	les	cadres	de	zone	de
texte.	Les	objets	qui	se	trouvent	sur	des	calques	masqués	ou	non	imprimables	sont	également
invisibles.

Pour	activer	le	mode	Aperçu,	sélectionnez	Présentation	>	Mode	Aperçu	(Commande	+	\)	ou

cliquez	sur	le	bouton	Mode	Aperçu	dans	la	barre	d'outils	 .
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Panneau	Pages
Le	panneau	Pages	vous	permet	de	gérer	les	pages	de	votre	document.

Pour	ouvrir	le	panneau	Pages,	cliquez	sur	le	bouton	 	situé	sous	la	barre	d'outils	ou	sélectionnez
Présentation	>	Afficher	l'Aperçu	de	pages	dans	le	menu	principal.

1	–	Ajoute	une	page	à	la	fin	du	document.

2	–	Supprime	la	page	actuelle.

3	–	Menu	local	des	pages.	Il	contient	des	commandes	permettant	d'ajouter	et	de	supprimer	des	pages,
d'appliquer	des	gabarits	et	bien	plus	encore.

4	–	Vignette	de	page.

5	–	Numéro	de	page.

6	–	Nom	du	gabarit	appliqué.	Aucun	nom	de	gabarit	n'est	affiché	si	aucun	gabarit	n'est	appliqué	à	la
page.

7	–	La	page	actuelle	est	mise	en	surbrillance.

Glissez-déposez	les	vignettes	de	page	pour	modifier	l'ordre	des	pages.

Lorsque	votre	document	est	affiché	dans	l'espace	de	travail	sous	forme	de	planches,	le	panneau	Pages
affiche	l'aperçu	de	chaque	paire	de	pages	opposées	comme	s'il	s'agissait	d'une	seule	entité.	Dans	ce
mode	d'affichage,	le	programme	ajoute	ou	supprime	des	planches	plutôt	que	des	pages	individuelles.
Si	vous	faites	glisser	une	page	pour	la	placer	à	un	nouvel	endroit,	toute	la	planche	est	déplacée.
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Ajout	et	suppression	de	pages
Pour	ajouter	une	page	après	la	page	actuelle,	affichez	le	panneau	Pages,	puis	cliquez	sur	le	«	+	»	situé
à	gauche.	Vous	pouvez	également	afficher	le	panneau	Pages,	puis	choisir	Insérer	une	page	dans	le
menu	local.

Pour	ajouter	une	page	à	la	fin	du	document,	affichez	le	panneau	Pages.	Ouvrez	le	menu	local	en
cliquant	sur	l'icône	d'engrenage,	puis	choisissez	Ajouter	la	page.

Pour	ajouter	une	copie	de	la	page	actuelle,	affichez	le	panneau	Pages,	puis	choisissez	Dupliquer	la
page	dans	le	menu	local.

Pour	supprimer	la	page	actuelle,	affichez	le	panneau	Pages,	puis	cliquez	sur	le	«	-	»	situé	à	gauche.
Vous	pouvez	également	afficher	le	panneau	Pages,	puis	choisir	Supprimer	la	page	dans	le	menu
local.

Vous	pouvez	supprimer	plusieurs	pages	sélectionnées.

Pour	sélectionner	plusieurs	pages	:

Cliquez	sur	les	pages	tout	en	maintenant	la	touche	Commande	enfoncée.
Pour	sélectionner	la	première	et	la	dernière	page	ainsi	que	toutes	les	autres	pages,
sélectionnez	la	première	page,	maintenez	la	touche	Maj	enfoncée,	puis	sélectionnez	la
dernière	page.
Sélectionnez	une	page	paire	ou	impaire.	Faites	un	clic	droit	sur	le	panneau	Pages,	puis
choisissez	Sélectionner	les	pages	paires/impaires	pour	sélectionner	le	reste	des	pages
paires	ou	impaires.
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Modification	de	l'ordre	des	pages
Pour	modifier	l'ordre	des	pages,	ouvrez	le	panneau	Pages	et	faites	glisser	la	vignette	de	page	jusqu'à
un	nouvel	emplacement.	Vous	pouvez	également	sélectionner	plusieurs	pages	et	les	déplacer
ensemble.

Pour	sélectionner	plusieurs	pages	:

Cliquez	sur	les	pages	tout	en	maintenant	la	touche	Commande	enfoncée.
Pour	sélectionner	la	première	et	la	dernière	page	ainsi	que	toutes	les	autres	pages,
sélectionnez	la	première	page,	maintenez	la	touche	Maj	enfoncée,	puis	sélectionnez	la
dernière	page.
Sélectionnez	une	page	paire	ou	impaire.	Faites	un	clic	droit	sur	le	panneau	Pages,	puis
choisissez	Sélectionner	les	pages	paires/impaires	pour	sélectionner	le	reste	des	pages
paires	ou	impaires.
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Navigation	dans	le	document
Pour	ouvrir	la	page	suivante	ou	précédente,	cliquez	sur	les	flèches	en	regard	de	la	zone	de	numéro	de
page,	sous	la	barre	d'outils.	Vous	pouvez	également	utiliser	les	touches	Page	suivante	ou	Page
précédente.

Pour	vous	rendre	directement	à	une	page,	saisissez	son	numéro	dans	la	zone	de	numéro	de	page,	puis
appuyez	sur	Retour.

Vous	pouvez	également	afficher	une	page	spécifique	en	la	sélectionnant	dans	le	panneau	Pages.
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Numérotation	des	pages
Pour	ajouter	un	numéro	sur	la	page	actuelle,	choisissez	Insertion	>	Numéro	de	page.

Vous	ne	pouvez	pas	modifier	le	contenu	du	champ	de	numéro	de	page.	Lorsque	vous	réorganisez,
ajoutez	ou	supprimez	des	pages,	les	numéros	de	page	sont	automatiquement	mis	à	jour.

Pour	modifier	la	mise	en	forme	du	numéro	de	page	comme	la	taille,	la	couleur	ou	la	police	du	texte,
utilisez	l'onglet	Texte	de	l'inspecteur.

Numéros	de	page	sur	les	gabarits

Il	est	courant	d'ajouter	des	numéros	de	page	sur	des	gabarits.	Pour	ce	faire,	appliquez	un	gabarit	aux
pages	de	votre	document.	Ensuite,	ajoutez	un	champ	de	numéro	de	page	à	ce	gabarit.

Le	numéro	de	page	ajouté	à	la	page	de	contenu	n'est	affiché	que	sur	cette	page,	tandis	que	le	numéro
de	page	ajouté	à	un	gabarit	apparaît	sur	toutes	les	pages	auxquelles	vous	avez	appliqué	ce	gabarit.

Le	champ	de	numéro	de	page	d'un	gabarit	présente	des	symboles	qui	correspondent	au	format	de
numéro	de	page.	Ce	champ	devient	effectivement	un	numéro	de	page	sur	les	pages	de	contenu.

Vous	pouvez	numéroter	les	pages	en	commençant	par	n'importe	quelle	page.	Cela	peut	s'avérer	utile
lorsque	la	première	page	est	la	couverture	et	que	le	numéro	de	page	ne	doit	pas	y	figurer.	Pour
commencer	la	numérotation	des	pages	à	partir	de	la	page	2,	double-cliquez	sur	le	champ	de	numéro
de	page,	puis	paramétrez	Démarrer	à	partir	de	la	page	sur	2.

Vous	pouvez	exclure	la	ou	les	premières	pages	de	la	numérotation.	Cela	peut	s'avérer	nécessaire	si	la
page	1	suit	des	pages	sans	numéro	ou	avec	une	numérotation	qui	leur	est	propre,	comme	la	table	de
matières	dans	un	livre	de	grande	taille.	Pour	afficher	un	numéro	1	à	la	page	2,	double-cliquez	sur	le
champ	de	numéro	de	page,	puis	réglez	l'option	Première	page	sur	2.	Notez	toutefois	que	pour	que	les
numéros	de	page	corrects	s'affichent	sur	les	pages	suivantes,	vous	devez	soit	placer	le	champ	de
numéro	de	page	sur	un	gabarit,	soit	spécifier	la	même	valeur	de	Première	page	sur	toutes	les	pages.

Format	du	numéro	de	page

Pour	modifier	le	format	de	numéro	de	page,	double-cliquez	deux	fois	sur	le	champ	de	numéro	de	page,
puis	sélectionnez	un	autre	format	dans	la	liste	déroulante.

Le	programme	propose	plusieurs	formats	prédéfinis	affichés	dans	le	champ	de	texte	Format	à	l'aide	de
symboles	spéciaux	et	de	texte	constant.

Symboles	spéciaux	:

#P	:	remplacé	automatiquement	par	le	numéro	de	page	actuel.
#C	:	remplacé	automatiquement	par	le	nombre	de	pages	du	document.
#a	:	remplacé	automatiquement	par	le	nombre	de	pages	affiché	en	lettres	minuscules.
#A	:	remplacé	automatiquement	par	le	nombre	de	pages	affiché	en	lettres	majuscules.

Exemple	:	dans	un	document	de	quatre	pages,	le	format	«	#P	sur	#C	»	est	remplacé	par	«	1	sur	4	»,
«	2	sur	4	»,	«	3	sur	4	»	et	«	4	sur	4	».
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Vous	pouvez	ajouter	du	texte	personnalisé	au	format.	Vous	pouvez,	par	exemple,	taper	«	–=	#P	=–	»
dans	la	zone	d'édition	du	Format	pour	obtenir	des	numéros	de	page	comme	:
–=	56	=–
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Gabarits
Les	gabarits	vous	aident	à	créer	efficacement	des	pages	uniformes.	Grâce	aux	gabarits,	vous	pouvez,
par	exemple,	créer	un	arrière-plan	une	fois	et	l'appliquer	à	toutes	les	pages	de	votre	projet.	Le	gabarit
joue	ainsi	le	rôle	de	l'arrière-plan	et	il	vous	suffit	d'ajouter	des	éléments	spécifiques	à	chaque	page.	De
même,	si	ensuite	vous	voulez	modifier	cet	arrière-plan	universel,	les	modifications	sont	appliquées	à
toutes	les	pages	auxquelles	vous	avez	appliqué	ce	gabarit.

Pour	différencier	les	gabarits	des	pages	ordinaires	dans	cette	documentation,	nous	appelons	ces
dernières	des	«	pages	de	contenu	».

Un	nouveau	document	contient	un	gabarit	qui	n'est	appliqué	à	aucune	page	de	contenu.	Vous	pouvez
ajouter	autant	de	gabarits	que	vous	le	voulez.

Lorsque	vous	ajoutez	une	nouvelle	page	de	contenu,	aucun	gabarit	ne	lui	est	appliqué	par	défaut.

Pour	utiliser	les	mêmes	gabarits	dans	plusieurs	documents,	créez	un	document	modèle	contenant	ces
gabarits,	puis	créez	votre	document	à	l'aide	de	ce	modèle.

Aperçu	et	modification	des	gabarits

Pour	prévisualiser	ou	modifier	les	gabarits,	cliquez	sur	Pages	de	contenu	sous	la	barre	d'outils,	puis

sélectionnez	Gabarits.	Cliquez	ensuite	sur	le	bouton	 	pour	ouvrir	le	panneau	Pages,	puis
sélectionnez	le	gabarit	nécessaire.

Vous	pouvez	également	basculer	depuis	les	pages	de	contenu	vers	les	gabarits	et	vice	versa	à	l'aide
des	commandes	de	menu	Présentation	>	Pages	de	contenu	et	Présentation	>	Gabarits.	La
couleur	d'arrière-plan	de	la	fenêtre	principale	devient	bleue	pour	vous	indiquer	que	vous	êtes	passé	de
pages	de	contenu	à	des	gabarits.

Lorsque	vous	activez	le	mode	gabarits,	le	panneau	Pages	affiche	des	vignettes	des	gabarits.	Les	outils
de	ce	panneau	s'adaptent	afin	de	pouvoir	les	utiliser	avec	les	gabarits.

Vous	pouvez	modifier	des	gabarits	de	la	même	manière	que	des	pages	de	contenu.

Ajout	et	suppression	de	gabarits

Cliquez	sur	Pages	de	contenu	sous	la	barre	d'outils,	puis	sélectionnez	Gabarits.	Cliquez	ensuite	sur	le

bouton	 	pour	ouvrir	le	panneau	Pages.	Dans	le	panneau	Pages,	cliquez	sur	le	bouton	«	+	»	pour
ajouter	un	gabarit.	Pour	supprimer	un	gabarit,	sélectionnez-le	dans	le	panneau	Pages,	puis	cliquez	sur
le	bouton	«	–	».

Un	document	doit	posséder	au	moins	un	gabarit,	c'est	pourquoi	la	suppression	d'un	gabarit	unique	est
impossible.
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Un	nom	est	automatiquement	attribué	aux	nouveaux	gabarits	avec	les	lettres	«	B	»,	«	C	»,	etc.	Si	vous
supprimez	le	gabarit	B,	tous	les	gabarits	suivants	sont	renommés	:	C	devient	B,	D	devient	C	et	ainsi	de
suite.

Application	de	gabarits

Pour	appliquer	un	gabarit,	sélectionnez	une	ou	plusieurs	pages	de	contenu	dans	le	panneau	Pages.
Ensuite,	faites	un	clic	droit	sur	la	page	sélectionnée.	Choisissez	Appliquer	le	gabarit	dans	le	menu
contextuel,	puis	précisez	le	gabarit	que	vous	souhaitez	appliquer.

Le	nom	du	gabarit	appliqué	est	indiqué	dans	le	panneau	Pages,	près	du	coin	supérieur	gauche	de	la
vignette	de	la	page.

S'il	n'est	pas	nécessaire	qu'une	page	soit	dotée	d'un	gabarit,	choisissez	Aucun	gabarit	dans	la	liste	des
gabarits.

Mise	en	page	des	gabarits

Vous	pouvez	définir	individuellement	les	marges	de	page	de	tout	gabarit	dans	l'onglet	Document	de
l'inspecteur.	Une	page	de	contenu	affiche	automatiquement	les	marges	de	page	du	gabarit	appliqué.

Les	lignes	de	repère	ajoutées	à	un	gabarit	apparaissent	sur	toutes	les	pages	de	contenu	qui	se	basent
sur	ce	gabarit.	Pour	déplacer,	verrouiller	ou	supprimer	ces	lignes	de	repère,	ouvrez	le	gabarit
correspondant.

Gabarits	et	planches

Si	votre	document	est	organisé	sous	forme	de	planches	plutôt	que	de	pages	individuelles,	ses	gabarits
sont	également	organisés	sous	forme	de	planches.	L'application	d'un	gabarit	à	une	planche	ou	la
modification	d'un	gabarit	sur	une	planche	a	des	effets	sur	les	deux	pages	de	cette	planche.
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Planches
Lorsque	vous	ouvrez	un	livre,	deux	pages	opposées	vous	sont	présentées.	Ces	deux	pages	constituent
une	planche.	Le	programme	vous	permet	de	travailler	avec	des	pages	individuelles	ou	des	planches.

Il	est	important	de	ne	pas	oublier	de	choisir	un	mode	d'affichage	avant	de	créer	un	document,	car	le
passage	d'un	mode	à	l'autre	n'est	pas	possible	pendant	la	modification	du	document.

La	modification	d'un	document	sous	forme	de	planches	est	utile	lorsqu'un	objet	ou	un	design	couvre
deux	pages	opposées.

Le	mode	d'affichage	sous	forme	de	planches	requiert	des	documents	possédant	un	nombre	pair	de
pages.	La	première	page	et	la	dernière	page	ne	possèdent	pas	de	pages	opposées.	Il	est	impossible
d'ajouter,	de	supprimer	ou	de	réordonner	des	pages	individuelles.	Ces	opérations	ne	sont	possibles
qu'avec	des	planches.

Les	pages	d'une	planche	adoptent	le	système	de	coordonnées	universel.	L'origine	(point	zéro)	est
située	dans	le	coin	supérieur	gauche	de	la	page	de	gauche.

Les	gabarits	sont	organisés	sous	forme	de	planches	de	la	même	manière	que	les	pages	de	contenu.	Le
gabarit	de	gauche	d'une	planche	est	toujours	appliqué	aux	pages	de	contenu	de	gauche,	tandis	que	le
gabarit	de	droite	est	appliqué	aux	pages	de	droite.

Il	n'est	pas	possible	de	diviser	les	pages	d'une	planche	pour	insérer	d'autres	pages	entre	elles.
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Sélection	d'objets
Pour	modifier	les	propriétés	d'un	objet,	il	vous	faut,	en	principe,	le	sélectionner.

Pour	sélectionner	des	objets	à	l'aide	de	la	souris,	activez	l'outil	Sélection	(généralement	activé	par
défaut).

Pour	sélectionner	un	objet	unique,	cliquez	dessus.

Pour	sélectionner	plusieurs	objets,	cliquez	sur	chacun	d'eux	en	maintenant	la	touche	Maj	enfoncée.
Vous	pouvez	également	sélectionner	plusieurs	objets	à	l'aide	d'un	cadre	englobant	ces	objets	en
cliquant	et	en	maintenant	le	bouton	gauche	de	la	souris	enfoncée.

Pour	sélectionner	tous	les	objets	du	calque	actif	de	la	page	actuelle,	choisissez	Édition	>	Tout
sélectionner	(Commande	+	A).

Pour	désélectionner	un	objet,	cliquez	sur	n'importe	quel	espace	vierge	sur	ou	hors	de	la	page.
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Modification	de	la	taille	des	objets
Pour	redimensionner	un	objet	avec	la	souris,	sélectionnez-le	et	faites	glisser	une	des	poignées	de	sa
bordure.

Pour	redimensionner	un	objet	tout	en	conservant	ses	proportions,	faites	glisser	l'une	de	ses	poignées
d'angle.	Si	vous	redimensionnez	en	maintenant	la	touche	Maj	enfoncée,	le	rapport	entre	la	largeur	et
la	hauteur	ne	sera	pas	conservé.

Pour	ne	modifier	que	la	largeur	ou	la	hauteur	d'un	objet,	faites	glisser	une	poignée	située	au	milieu	de
la	bordure	de	l'objet.	Si	vous	effectuez	cette	opération	en	maintenant	la	touche	Maj	enfoncée,	le
programme	conserve	les	proportions	de	l'objet.

Vous	pouvez	aussi	saisir	les	dimensions	exactes	d'un	objet	dans	l'onglet	Géométrie	de	l'inspecteur.	Il
est	possible	de	modifier	les	unités	de	mesure	dans	les	Préférences	du	programme.

Si	l'option	Conserver	les	proportions	est	activée	dans	l'inspecteur,	le	programme	redimensionne	les
objets	en	conservant	leurs	proportions	quelle	que	soit	la	méthode	que	vous	utilisez.

Redimensionnement	d'un	groupe	d'objets

Il	est	possible	de	redimensionner	des	groupes	ainsi	que	plusieurs	objets	sélectionnés	(que	nous
appellerons	«	groupe	temporaire	»).	Le	redimensionnement	d'un	groupe	ou	d'un	groupe	temporaire	à
l'aide	de	la	souris	modifie	les	limites	du	groupe	de	la	même	manière	que	pour	un	objet	unique.	Si
l'option	Conserver	les	proportions	est	activée	pour	l'ensemble	du	groupe	ou	l'un	des	objets	du
groupe,	les	proportions	des	limites	du	groupe	sont	conservées	de	même	que	celles	de	tous	les	objets.
Si	l'option	Conserver	les	proportions	n'est	activée	pour	aucun	des	objets,	vous	pouvez	définir
n'importe	quelles	proportions	pour	les	limites	du	groupe	et	ces	proportions	seront	appliquées	à	tous	les
objets.

Si	vous	sélectionnez	plusieurs	objets	et	que	vous	saisissez	de	nouvelles	valeurs	de	largeur	et	de
hauteur	dans	l'inspecteur,	ces	valeurs	sont	appliquées	séparément	à	chacun	des	objets	sélectionnés.
Le	programme	tiendra	compte	individuellement	des	options	Conserver	les	proportions	de	chaque
objet.

Enfin,	si	vous	utilisez	l'inspecteur	pour	redimensionner	un	groupe,	de	nouvelles	valeurs	de	largeur	et
de	hauteur	seront	appliquées	aux	limites	du	groupe.	La	taille	des	objets	sera	modifiée	respectivement.
L'option	Conserver	les	proportions,	lorsqu'elle	est	activée	pour	l'un	des	objets	ou	la	totalité	du
groupe,	conserve	les	proportions	du	groupe	et	de	tous	les	objets	qu'il	contient.
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Rotation	d'objets
Pour	faire	pivoter	un	objet	sélectionné,	utilisez	l'onglet	Géométrie	de	l'inspecteur.	Il	est	également
possible	de	retourner	les	images	verticalement	et	horizontalement.	En	revanche,	cette	action	n'est	pas
possible	avec	du	texte.	Pour	ce	faire,	vous	devez	convertir	le	texte	en	image	en	choisissant	Convertir
le	texte	en	image	dans	son	menu	contextuel.

Pour	faire	pivoter	un	objet	avec	la	souris,	sélectionnez-le	et	déplacez	le	curseur	sur	une	poignée
d'angle.	Une	fois	que	le	curseur	a	pris	la	forme	d'une	flèche	bidirectionnelle,	faites	glisser	la	poignée
pour	faire	pivoter	l'objet.

Il	est	possible	de	faire	pivoter	plusieurs	objets	simultanément.	Lorsque	vous	faites	pivoter	un	groupe
d'objets,	ils	se	déplacent	autour	d'un	centre	commun.
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Groupement	d'objets
Il	est	possible	de	regrouper	des	objets.	Un	groupe	d'objets	se	comporte	comme	un	objet	unique
lorsque	vous	le	déplacez	ou	redimensionnez.

Pour	grouper	des	objets	sélectionnés,	choisissez	Arranger	>	Grouper	(Commande	+	Alt	+	G)	dans
le	menu.

Pour	dégrouper	des	objets,	sélectionnez	le	groupe,	puis	choisissez	Arranger	>	Dégrouper
(Commande	+	Alt	+	Maj	+	G)	dans	le	menu.

Les	groupes	imbriqués	sont	pris	en	charge.	Un	groupe	imbriqué	est	un	groupe	qui	inclut	un	groupe	de
plus	petite	taille.

Certaines	commandes	disponibles	pour	des	objets	individuels	peuvent	être	verrouillées	lorsque	ces
objets	se	trouvent	dans	un	groupe.
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Remplissage	d'objets	avec	des	couleurs
Les	commandes	de	couleur	de	remplissage	se	trouvent	dans	l'onglet	Apparence	de	l'inspecteur
(Commande	+	3).

Vous	pouvez	remplir	un	objet	avec	une	couleur	unie	ou	avec	un	dégradé	linéaire	ou	radial.	Vous
pouvez	sélectionner	ces	options	dans	le	menu	déroulant.

Pour	activer	l'outil	de	remplissage	avec	une	couleur,	cochez	la	case	Remplir.

Couleur	de	remplissage

Cliquez	sur	le	bouton	de	couleur	pour	sélectionner	une	couleur.

Pour	teinter	un	objet,	réglez	l'Opacité	de	la	couleur	sélectionnée	sur	moins	de	100	%.

L'option	Couleur	vous	permet	également	de	modifier	la	couleur	d'arrière-plan	d'une	zone	de	texte.

Remplissage	dégradé	linéaire

1	–	Les	deux	couleurs	de	base.

2	–	Inverse	les	couleurs	de	base.

3	–	Modifie	le	pourcentage	de	chaque	couleur	de	base.

4	–	Déplacez	la	poignée	dans	le	contrôle	pour	modifier	l'angle	et	l'emplacement	de	la	zone	de	transition
de	couleur.	Maintenez	la	touche	Commande	enfoncée	pour	que	l'angle	soit	constant.	Maintenez	la
touche	Alt	enfoncée	pour	que	le	pourcentage	de	couleurs	de	base	reste	constant.	Maintenez	la	touche
Maj	enfoncée	pour	se	limiter	à	des	angles	divisibles	par	45	degrés.

Lorsque	vous	déplacez	la	poignée	depuis	le	côté	du	contrôle	vers	son	centre,	les	couleurs	changent.
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Remplissage	dégradé	radial

1	–	Les	deux	couleurs	de	base.

2	–	Inverse	les	couleurs	de	base.

3	–	Modifie	le	pourcentage	de	chaque	couleur	de	base.

4	–	Faites	glisser	la	poignée	à	l'intérieur	de	ce	contrôle	pour	déplacer	les	couleurs	hors	du	centre.
Maintenez	la	touche	Commande	enfoncée	pour	que	l'angle	soit	constant.	Maintenez	la	touche	Alt
enfoncée	pour	faire	pivoter	la	poignée	le	long	du	cercle.	Maintenez	la	touche	Maj	enfoncée	pour	se
limiter	à	des	angles	divisibles	par	45	degrés.
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Application	des	réglages	de	contour
Vous	pouvez	appliquer	un	Contour	à	n'importe	quelle	ligne	droite	ou	courbe	que	vous	tracez,	aux
formes	intelligentes	et	aux	bordures	d'autres	objets.

Les	réglages	de	Contour	se	trouvent	dans	l'onglet	Apparence	de	l'inspecteur.

Vous	pouvez	modifier	la	couleur	et	l'opacité	de	votre	contour	à	l'aide	du	bouton	de	couleur.

Dans	le	menu	local,	vous	pouvez	choisir	des	tirets,	des	pointillés	et	d'autres	types	de	contours.

La	commande	Épaisseur	vous	permet	d'ajuster	l'épaisseur	du	contour.
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Application	de	l'effet	d'ombre
Pour	régler	l'effet	d'ombre,	utilisez	l'onglet	Apparence	de	l'inspecteur.

1	–	Angle	de	l'ombre.

2	–	Couleur	et	opacité	de	l'ombre.

3	–	Distance	entre	l'ombre	et	l'objet.

4	–	Flou	de	l'ombre.

Les	commandes	d'ombre	dans	l'inspecteur	et	le	panneau	Polices	standard	produisent	des	effets
d'ombre	différents	et	indépendants.
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Utilisation	du	texte
La	plupart	des	outils	de	mise	en	forme	du	texte	se	trouvent	dans	l'onglet	Texte	de	l'inspecteur.

Ajout	et	édition	de	texte
Ajout	et	édition	de	texte	vertical
Ajout	et	édition	de	texte	circulaire
Suppression	de	texte
Mise	en	forme	du	texte
Ajustement	du	texte
Vérification	de	l'orthographe
Recherche	et	remplacement	de	texte
Ajout	de	liens	hypertexte

Certaines	opérations	communes	à	différents	types	d'objets	sont	décrites	dans	:

Sélection	d'objets
Modification	de	la	taille	des	objets
Rotation	d'objets
Groupement	d'objets
Remplissage	d'objets	avec	des	couleurs
Application	des	réglages	de	contour
Application	de	l'effet	d'ombre
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Ajout	et	édition	de	texte

Plusieurs	outils	de	texte	sont	empilés	sur	le	même	bouton	dans	la	barre	d'outils.	Pour	les	afficher,
cliquez	en	maintenant	le	bouton	de	la	souris	enfoncé	pour	faire	apparaître	le	menu	local.	Choisissez
ensuite	l'outil	nécessaire.	L'icône	affichée	dans	la	barre	d'outils	est	généralement	celle	du	dernier	outil
utilisé.	Vous	pouvez	activer	cet	outil	de	texte	particulier	en	cliquant	simplement	sur	l'icône.

Pour	saisir	du	texte,	il	vous	faut	ajouter	une	zone	de	texte	destinée	à	contenir	votre	texte.

Pour	ajouter	une	zone	de	texte,	activez	l'outil	Texte	dans	la	barre	d'outils.	Cliquez	ensuite	sur	l'espace
de	travail.

Pour	tracer	une	zone	de	texte	:

1.	 Cliquez	sur	l'outil	Texte	dans	la	barre	d'outils.

2.	 Cliquez	sur	l'espace	de	travail.

Pour	tracer	une	zone	de	texte	d'une	taille	particulière	:

1.	 Activez	l'outil	Texte	dans	la	barre	d'outils.

2.	 Positionnez	le	curseur	de	la	souris	où	vous	souhaitez	placer	le	coin	de	la	nouvelle	zone	de
texte.

3.	 Appuyez	sur	le	bouton	gauche	de	la	souris,	puis,	tout	en	le	maintenant	enfoncé,	déplacez	la
souris	pour	tracer	une	zone	de	texte.

4.	 Relâchez	le	bouton	de	la	souris.

Pour	éditer	le	texte,	double-cliquez	dessus.

Pour	quitter	le	mode	d'édition	de	texte,	cliquez	hors	de	la	zone	de	texte	ou	appuyez	sur
Commande	+	Retour.

Ajout	et	édition	de	texte	vertical

1.	 Cliquez	sur	l'espace	de	travail	à	l'aide	de	l'outil	Texte	vertical.

2.	 Saisissez	votre	texte.

3.	 Redimensionnez	la	zone	de	texte	ajoutée,	si	nécessaire.

Pour	éditer	le	texte	vertical,	double-cliquez	dessus.

Pour	quitter	le	mode	d'édition	de	texte,	cliquez	hors	de	la	zone	de	texte	ou	appuyez	sur
Commande	+	Retour.

Lors	de	l'édition	de	texte	vertical,	le	texte	est	affiché	horizontalement.

Certains	outils	de	mise	en	forme	de	texte,	comme	les	listes	à	puces	ou	l'espacement	entre	les	lignes,
ne	fonctionnement	pas	avec	le	texte	vertical.

Ajout	et	édition	de	texte	circulaire

1.	 Activez	l'outil	Texte	circulaire,	puis	cliquez	sur	l'espace	de	travail.
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2.	 Saisissez	votre	texte	dans	l'éditeur	de	texte	flottant,	puis	appliquez	la	mise	en	forme
nécessaire.	Fermez	l'éditeur	de	texte.

3.	 Redimensionnez	la	zone	de	texte	ajoutée,	si	nécessaire.

Pour	éditer	le	texte	circulaire,	double-cliquez	dessus.

Pour	inverser	l'orientation	d'un	texte	circulaire,	retournez	verticalement	la	zone	de	texte.	Pour	ce	faire,
sélectionnez-la.	Ensuite,	faites	glisser	vers	le	bas	une	poignée	située	au	milieu	du	côté	supérieur	de	la
zone	de	texte	jusqu'à	ce	que	le	texte	se	trouve	dans	l'orientation	opposée.

Certains	outils	de	mise	en	forme	de	texte,	comme	les	listes	à	puces	ou	l'espacement	de	marge,	ne
fonctionnement	pas	avec	le	texte	circulaire.

Suppression	de	texte

Pour	supprimer	une	zone	de	texte,	sélectionnez-la,	puis	appuyez	sur	la	touche	Supprimer.

Mise	en	forme	du	texte

Les	outils	de	mise	en	forme	du	texte	se	trouvent	dans	l'onglet	Texte	de	la	fenêtre	de	l'inspecteur.
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Modification	de	la	police	et	de	la	couleur	du	texte

Pour	modifier	la	police,	sélectionnez	la	zone	de	texte	ou	mettez	une	partie	du	texte	en	surbrillance,
puis	cliquez	sur	le	bouton	Polices	dans	l'inspecteur.	Vous	pouvez	également	appuyer	sur
Commande	+	T.

Pour	modifier	la	couleur,	sélectionnez	la	zone	de	texte	ou	mettez	une	partie	du	texte	en	surbrillance,
puis	cliquez	sur	le	bouton	de	couleur	dans	l'inspecteur.	Vous	pouvez	aussi	appuyer	sur
Commande	+	Maj	+	C.

Modification	de	la	taille	de	la	police

Pour	modifier	la	taille	de	la	police,	utilisez	la	barre	coulissante	Taille	ou	les	boutons	«	T	».	Vous	pouvez
également	taper	la	taille	de	la	police	dans	la	zone	d'édition.

Alignement

Pour	aligner	le	texte	dans	la	zone	de	texte,	utilisez	les	boutons	Alignement	dans	l'onglet	Texte	de
l'inspecteur.

Modification	de	la	couleur,	de	la	largeur	et	du	motif	du	cadre	de	la	zone	de
texte

Pour	afficher	le	contour	d'une	zone	de	texte,	cochez	la	case	Contour	dans	l'onglet	Apparence	de
l'inspecteur.	C'est	ici	que	vous	pouvez	définir	l'épaisseur,	la	couleur	et	choisir	le	motif	de	la	ligne.

Modification	de	la	couleur	d'arrière-plan	d'une	zone	de	texte

Pour	modifier	la	couleur	d'arrière-plan	d'une	zone	de	texte	:

1.	 Sélectionnez	une	zone	de	texte.

2.	 Dans	l'onglet	Apparence	de	l'inspecteur,	cochez	la	case	Remplir.

3.	 Cliquez	sur	le	bouton	Couleur,	puis	choisissez	une	nouvelle	couleur.

Application	d'ombres

Pour	ajouter	une	ombre	au	texte	:

1.	 Sélectionnez	une	zone	de	texte.

2.	 Dans	l'onglet	Apparence	de	l'inspecteur,	cochez	la	case	Ombre.

3.	 Définissez	les	paramètres	d'ombre.

Les	ombres	sont	appliquées	à	la	totalité	de	la	zone	de	texte.
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Réglages	d'espacement

Vous	pouvez	modifier	les	réglages	d'espacement	du	texte	par	défaut	à	l'aide	des	paramètres
Espacement	dans	l'onglet	Texte	de	l'inspecteur.

Entre	les	caractères	:	modifie	la	distance	entre	les	caractères.	Il	est	possible	d'appliquer	cet	outil	à	la
totalité	de	la	zone	de	texte	sélectionnée	ou	à	une	partie	sélectionnée	du	texte.

Entre	les	lignes	:	modifie	la	distance	entre	les	lignes.	Il	est	possible	d'appliquer	cet	outil	à	la	totalité
de	la	zone	de	texte	sélectionnée	ou	à	une	partie	sélectionnée	du	texte.

Avant	le	paragraphe	:	modifie	l'espace	avant	le	paragraphe	actuel	(où	se	trouve	le	curseur	de	texte).

Après	le	paragraphe	:	modifie	l'espace	après	le	paragraphe	sélectionné	(où	se	trouve	le	curseur	de
texte).

Espacement	de	marge	vous	permet	de	contrôler	l'espacement	entre	le	texte	et	la	bordure	de	la	zone
de	texte.	Si	vous	augmentez	cette	valeur,	vous	augmentez	la	distance	entre	le	texte	et	sa	bordure	de
tous	les	côtés.

Création	de	listes

Pour	créer	une	liste,	sélectionnez	une	partie	de	votre	texte	ou	la	totalité	d'une	zone	de	texte.	Ensuite,
dans	l'onglet	Texte	de	l'inspecteur,	cliquez	sur	le	menu	local	Listes	pour	sélectionner	le	type	de	liste
(numérotée,	à	puces,	etc.).

Ajustement	du	texte

Vous	pouvez	ajuster	du	texte	autour	des	images	ou	des	cadres	de	texte.
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Pour	ajuster	le	texte	autour	d'un	objet	:

1.	 Sélectionnez	l'objet,	faites	un	clic	droit	dessus,	puis	sélectionnez	Mettre	au	premier	plan
dans	le	menu	contextuel.	Cette	opération	est	nécessaire,	car	le	texte	doit	se	trouver	derrière
l'objet.

2.	 Activez	l'option	L'objet	provoque	un	ajustement	dans	l'onglet	Texte	de	l'inspecteur.

3.	 Cliquez	sur	l'un	des	quatre	boutons	pour	sélectionner	le	type	d'ajustement	autour	de	l'objet.

4.	 Modifiez,	si	nécessaire,	l'espace	entre	l'objet	et	le	texte	en	modifiant	Espace	dans	l'inspecteur.

Vous	souhaiterez	peut-être	ajuster	du	texte	autour	d'une	image	sur	fond	transparent.	Étant	donné	que
le	programme	ne	prend	pas	en	compte	la	transparence,	le	texte	s'ajusterait	autour	du	bord	de	l'image
et	non	pas	autour	de	la	partie	visible.
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Dans	ce	cas,	vous	devez	définir	le	contour	de	l'image	à	l'aide	de	l'outil	Spline,	puis	ajuster	le	texte	non
pas	autour	de	l'image	mais	du	contour	ainsi	créé.
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Lorsque	vous	êtes	satisfait(e)	du	résultat,	désactivez	le	Contour	pour	le	rendre	invisible.
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Vérification	de	l'orthographe

Pour	vérifier	l'orthographe	et	la	grammaire,	sélectionnez	Édition	>	Vérifier	l'orthographe	et	la
grammaire	>	Vérifier	le	document	(Commande	+	«	:	»).	Si	votre	texte	contient	des	fautes
d'orthographe,	le	programme	indique	la	première	erreur	par	une	ligne	pointillée	rouge.	Répétez	la
commande	pour	afficher	les	mots	mal	orthographiés	les	uns	après	les	autres.

Pour	afficher	les	corrections	possibles	d'un	mot	mal	orthographié,	sélectionnez	Édition	>	Vérifier
l'orthographe	et	la	grammaire	>	Afficher	les	fautes	d'orthographe	et	de	grammaire
(Commande	+	«	:	»).

Pour	que	les	mots	mal	orthographiés	soient	soulignés	pendant	la	frappe,	sélectionnez	Édition	>
Vérifier	l'orthographe	et	la	grammaire	>	Vérifier	l'orthographe	lors	de	la	frappe.

Recherche	et	remplacement	de	texte

Le	programme	vous	permet	de	rechercher	et	remplacer	un	mot,	un	nombre	ou	une	expression.

Double-cliquez	sur	une	zone	de	texte	pour	entrer	en	mode	d'édition	de	texte,	puis	sélectionnez	Édition
>	Rechercher	>	Rechercher	dans	le	menu.	Saisissez	le	mot	que	vous	recherchez	dans	la	zone	de
texte	Rechercher,	puis	cliquez	sur	Suivant.

Si	vous	devez	remplacer	ce	mot,	saisissez	le	nouveau	mot	dans	la	zone	de	texte	Remplacer,	puis
cliquez	sur	Suivant	et	Remplacer.

Sélectionnez	un	mot	et	choisissez	Édition	>	Rechercher	>	Rechercher	la	sélection.	Le	mot
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sélectionné	devient	ainsi	le	critère	de	la	recherche.

Si	vous	avez	sélectionné	une	partie	du	texte,	l'option	Aller	à	la	sélection	fait	défiler	le	texte	vers	le
bas,	le	cas	échéant,	pour	rendre	la	sélection	visible.

Ajout	de	liens	hypertexte

Il	est	possible	de	créer	un	fichier	PDF	contenant	des	liens	vers	des	pages	Web.	Pour	cela	:

1.	 Ajoutez	une	adresse	URL	à	une	zone	de	texte.	Vous	pouvez	saisir	l'adresse	en	adoptant	l'un
des	formats	ci-dessous	:
http://www.belightsoft.com
http://www.belightsoft.com/products/swiftpublisher/downloads.php
www.belightsoft.com
belightsoft.com
Il	est	important	d'utiliser	des	noms	de	site	et	de	domaine	valides.	Testez	votre	lien	dans	un
navigateur	Web	pour	vous	assurer	qu'il	fonctionne.

2.	 Sélectionnez	l'URL,	faites	un	clic	droit	dessus,	puis	sélectionnez	Créer	un	lien	dans	le	menu
contextuel.	Attention,	ne	sélectionnez	pas	de	caractère	d'espace	avant	ou	après	l'URL.

3.	 Vous	pouvez	à	présent	modifier	et	mettre	en	forme	le	texte	visible	sans	incidence	sur	le	lien.
Sélectionnez	le	texte	associé	au	lien	et	tapez	ce	que	vous	voulez,	modifiez	la	couleur	ou	la
police.	Pour	que	le	lien	soit	affiché	de	manière	standard	(bleu	et	souligné),	vous	devez	changer
la	couleur	du	texte	en	bleu	et	activer	l'option	Format	>	Police	>	Souligné	dans	le	menu
principal.

Vous	pouvez	aussi	ajouter	une	adresse	e-mail	dans	le	format	suivant	:
mailto:support@belightsoft.com

Le	préfixe	«	mailto:	»	doit	précéder	l'adresse	si	vous	voulez	qu'un	programme	de	courrier	électronique
s'ouvre	lorsque	l'on	clique	sur	le	lien.
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Zones	de	texte	liées

Zones	de	texte	liées	et	enchaînement	du	texte

Vous	pouvez	créer	une	série	de	zones	de	texte	reliées	les	unes	aux	autres.	Le	texte	de	ces	zones	peut
ainsi	s'enchaîner	d'une	zone	à	une	autre.	Si	le	texte	déborde	d'une	première	zone	de	texte,	la	partie
excédentaire	est	transférée	dans	la	ou	les	zones	suivantes.	Si	vous	redimensionnez	l'une	des	zones	de
texte	liées	pour	qu'elle	contienne	une	partie	de	texte	plus	importante	ou	plus	petite,	le	reste	du	texte
est	réarrangé	en	conséquence	dans	les	zones	suivantes.

Les	zones	de	texte	liées	peuvent	servir	à	créer	du	texte	sur	plusieurs	colonnes.	Elles	permettent	aussi
de	créer	des	documents	de	plusieurs	pages	où	le	texte	s'étend	de	manière	continue	sur	plusieurs
pages.

Si	trois	zones	de	texte	sont	reliées	comme	dans	l'illustration,	le	texte	commence	dans	la	zone	de	texte
de	gauche	et	continue	dans	les	deuxième	et	troisième	zones.	Dès	lors,	par	rapport	à	la	zone	de	texte
du	milieu,	la	zone	de	gauche	précède	et	la	zone	de	droite	suit.	Veuillez	noter	que	les	lignes	de	liaison
présentes	dans	l'illustration	ci-dessous	ne	sont	pas	affichées	dans	le	programme.

Une	zone	de	texte	peut	être	reliée	à	une	zone	située	avant	elle	(la	précédente)	et	à	une	autre	située
après	elle	(la	suivante).	Le	programme	ne	permet	pas	de	relier	la	première	zone	de	texte	à	la	dernière
afin	de	constituer	une	boucle.

Seules	les	zones	de	texte	régulières	peuvent	être	reliées.	Les	zones	de	texte	verticales	ou	circulaires
ne	prennent	pas	cette	fonction	en	charge.

Ajout	de	zones	de	texte	liées

Outre	les	poignées	de	redimensionnement	régulières,	les	zones	de	texte	disposent	de	deux	contrôles
carrés	placés	sur	leur	cadre.	Ces	contrôles	sont	visibles	lorsque	la	zone	de	texte	est	sélectionnée.	Nous
les	appellerons	contrôles	de	liaison.	Ils	sont	décrits	en	détail	plus	loin	dans	ce	document.	Ces	contrôles
vous	permettent	d'ajouter	des	zones	de	texte	liées	avant	et	après	une	zone	de	texte	sélectionnée.
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Pour	ajouter	une	zone	de	texte	liée	après	la	zone	actuelle,	cliquez	sur	le	contrôle	de	liaison	de	droite.
Cela	permet	d'activer	l'outil	d'ajout	de	zone	de	texte.	Cliquez	ensuite	sur	la	page	pour	créer	une	zone
de	texte	de	taille	par	défaut.	Vous	pouvez	aussi	dessiner	une	nouvelle	zone	de	texte	tant	que	l'outil
d'ajout	de	zone	de	texte	est	activé.

Pour	ajouter	une	zone	de	texte	liée	avant	la	zone	actuelle,	utilisez	le	contrôle	de	gauche.

Il	est	possible	d'ajouter	une	zone	de	texte	liée	lorsque	les	contrôles	de	gauche	et	de	droite	sont	vides
ou	lorsque	le	contrôle	de	droite	possède	une	icône	«	plus	»	rouge.

Contrôles	de	liaison	de	zones	de	texte

Les	deux	contrôles	de	zone	de	texte	sont	situés	respectivement	sur	le	côté	gauche	et	le	côté	droit	du
cadre	de	la	zone	de	texte.	Ils	se	présentent	par	défaut	sous	forme	de	carrés	blancs.	Ils	peuvent	inclure
une	icône	en	fonction	de	leur	état.

Les	contrôles	de	liaison	sont	visibles	lorsqu'une	zone	de	texte	est	sélectionnée.

Ils	indiquent	l'état	de	la	zone	de	texte.	En	cliquant	sur	ces	contrôles,	vous	pouvez	activer	l'outil	d'ajout
de	zone	de	texte	liée	ou	un	autre	outil	permettant	de	lier	des	zones	de	texte.
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Contrôle État
Signification
de	l'état	du
contrôle

Actions

Gauche
Vierge

Un	contrôle
vierge	situé	en
haut	à	gauche
indique	qu'il
s'agit	du	début
du	texte.

La	zone	de
texte	n'est	pas
précédée	de
zones	de	texte
liées.

En	cliquant	sur	ce
contrôle,	vous	pouvez
soit	ajouter	une	zone
de	texte	liée,	soit	relier
la	zone	de	texte
actuelle	à	une	autre.
Dans	les	deux	cas,	une
deuxième	zone	de
texte	devient	la
première	d'une	série
de	zones	de	texte
liées.

Flèche	vers	l'intérieur

Une	flèche
indique	que	le
texte
commence	dans
une	autre	zone
de	texte	et
continue	dans	la
zone	de	texte
actuelle.

Cette	zone	de
texte	fait	partie
d'une	série	de
zones	de	texte,
mais	n'est	pas
la	première.

Pas	d'actions.

Vierge

Un	contrôle
vierge	situé	en
bas	à	droite
indique	que	le
texte	se	termine
dans	la	zone	de
texte	actuelle.	Il
y	a
suffisamment
de	place	dans	la
zone	pour
contenir	le
texte.

La	zone	de
texte	n'est	pas
suivie	de	zones
de	texte	liées.

En	cliquant	sur	ce
contrôle,	vous	pouvez
soit	ajouter	une	zone
de	texte	liée,	soit	relier
la	zone	de	texte
actuelle	à	une	autre.
Dans	les	deux	cas,	une
deuxième	zone	de
texte	devient	la
dernière	d'une	série	de
zones	de	texte	liées.
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Droite

Flèche	vers
l'extérieur

Une	flèche
indique	que	le
texte	continue
dans	une	autre
zone	de	texte
liée	à	la	zone	de
texte	actuelle.

La	zone	de
texte	fait	partie
d'une	série	de
zones	de	texte,
mais	n'est	pas
la	dernière.

Pas	d'actions.

Plus	rouge

Un	plus	rouge
indique	qu'il	n'y
a	pas	assez	de
place	pour
afficher	tout	le
texte	dans	la
zone	de	texte
actuelle.

La	zone	de
texte	est	une
zone	isolée	ou
la	dernière
d'une	série.

En	cliquant	sur	ce
contrôle,	vous	pouvez
soit	ajouter	une	zone
de	texte	liée,	soit	relier
la	zone	de	texte
actuelle	à	une	autre.
Dans	les	deux	cas,	une
deuxième	zone	de
texte	devient	la
dernière	d'une	série	de
zones	de	texte	liées.
La	partie	invisible	du
texte	apparaîtra	dans
la	nouvelle	zone.

Liaison	et	séparation	de	zones	de	texte

Pour	relier	deux	zones	de	texte,	cliquez	sur	le	contrôle	de	liaison	de	droite	de	l'une	des	zones	de	texte
pour	activer	l'outil	de	liaison.	Cliquez	ensuite	sur	une	deuxième	zone	de	texte.	La	deuxième	zone	de
texte	est	alors	reliée	à	la	première.	Veuillez	noter	que	le	programme	ne	peut	pas	fusionner	le	texte
lorsque	vous	reliez	des	zones	de	texte	contenant	déjà	du	texte.	Le	texte	de	la	deuxième	zone	de	texte
disparaît.

Pour	lier	la	deuxième	zone	de	texte	avant	la	première,	vous	devez	activer	l'outil	de	liaison	en	cliquant
sur	le	contrôle	de	gauche	de	la	première	zone	de	texte.	Dans	ce	cas,	le	texte	de	la	deuxième	zone	est
conservé,	tandis	que	le	texte	de	la	première	zone	disparaît.

Tant	que	l'outil	de	liaison	est	activé,	vous	pouvez	placer	le	curseur	sur	d'autres	zones	de	texte	pour
voir	si	une	liaison	est	possible.	La	possibilité	de	liaison	est	indiquée	par	une	flèche	dotée	d'une	icône	de
chaîne.

Si	vous	cliquez	sur	un	emplacement	vide	ou	si	la	liaison	n'est	pas	possible,	le	programme	ajoute	une
nouvelle	zone	de	texte	reliée	à	la	première.
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Vous	pouvez	aussi	utiliser	cette	méthode	pour	ajouter	une	zone	de	texte	à	un	groupe	de	zones	de
texte	déjà	reliées.	Il	est	possible	d'ajouter	une	nouvelle	zone	de	texte	au	début	ou	à	la	fin	de	la
séquence,	mais	jamais	au	milieu.

Pour	séparer	une	zone	de	texte	de	la	zone	suivante,	cliquez	dessus	en	maintenant	le	bouton	droit	de	la
souris	enfoncé	et	sélectionnez	la	commande	Séparer	la	zone	de	texte	dans	le	menu	contextuel.	Et	ce
n'est	que	si	vous	invoquez	la	commande	en	cliquant	sur	la	dernière	zone	de	texte	qu'elle	sera	séparée
de	la	précédente.

Si	vous	séparez	deux	zones	de	texte	contenant	du	texte,	tout	le	texte	est	transféré	dans	la	zone	qui
contenait	initialement	le	début	du	texte.
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Styles	de	texte
Il	peut	s'avérer	nécessaire	d'appliquer	la	même	mise	en	forme,	plusieurs	fois,	à	différentes	parties	du
texte.	Vous	voulez,	par	exemple,	que	les	titres	des	chapitres	soient	uniformes,	c'est-à-dire	qu'ils	aient
la	même	police,	la	même	taille	et	la	même	couleur.	Vous	pouvez	enregistrer	ces	propriétés	de	texte
sous	forme	de	style	de	texte	et	les	appliquer	ultérieurement	en	cliquant	simplement	avec	la	souris.

Pour	appliquer	un	style	de	texte	à	un	paragraphe,	sélectionnez	ce	paragraphe,	cliquez	sur	le	bouton

Style	 	dans	la	barre	d'outils,	puis	choisissez	un	style.

Les	styles	de	Swift	Publisher	sont	des	styles	de	paragraphe.	Il	est	possible	de	les	appliquer	à	la	totalité
du	paragraphe,	mais	pas	à	une	partie	du	texte	dans	le	paragraphe.

Pour	enregistrer	la	mise	en	forme	du	texte	existant	comme	nouveau	style	de	texte,	sélectionnez	ce
texte,	puis	choisissez	Format	>	Créer	un	style	de	texte	à	partir	de	la	sélection...

Les	styles	personnalisés	sont	enregistrés	dans	le	document	et	ne	sont	pas	disponibles	pour	une
utilisation	dans	d'autres	documents.	Pour	utiliser	le	même	jeu	de	styles	dans	de	nouveaux	documents,
créez	un	modèle	de	document.

Éditeur	de	style	de	texte

Une	liste	des	styles	de	texte	est	affichée	sur	la	gauche	de	cet	éditeur.	Vous	pouvez	ajouter	et
supprimer	des	styles	à	l'aide	des	boutons	«	+	»	et	«	-	».

La	partie	supérieure	de	l'éditeur	affiche	un	aperçu	du	style	actuel.	Les	contrôles	situés	au	milieu	de
l'éditeur	vous	permettent	de	modifier	les	propriétés	du	style	sélectionné.
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Alignement	du	texte	à	l'aide	des	taquets	de	tabulation
Lorsque	vous	entrez	en	mode	d'édition	de	texte,	des	taquets	de	tabulation	sont	affichés	dans	la	barre
de	règle.	Les	taquets	de	tabulation	sont	des	indicateurs	qui	vous	permettent	d'aligner	le	texte	dans	des
colonnes.

Pour	afficher	ou	masquer	la	barre	de	règle,	appuyez	sur	Commande	+	R.

Les	taquets	de	tabulation	fonctionnent	avec	la	touche	Tabulation.	Lorsque	vous	appuyez	sur
Tabulation	(un	symbole	de	tabulation	est	ajouté),	le	curseur	se	rend	directement	à	la	position	du
taquet	de	tabulation	suivant.	Le	symbole	de	tabulation	apparaît	dans	le	texte	sous	forme	d'un	espace
de	largeur	variable	qui	dépend	de	la	distance	entre	les	taquets	de	tabulation	contigus	et	la	quantité	de
texte	alignée	sur	ces	taquets.

1	–	Taquet	de	tabulation	gauche.	Le	texte	est	placé	à	droite.

2	–	Taquet	de	tabulation	droite.	Le	texte	est	placé	à	gauche.

3	–	Taquet	de	tabulation	centrée.	Le	texte	est	centré	par	rapport	à	la	position	du	taquet	de	tabulation.

4	–	Taquet	de	tabulation	décimale.	Les	virgules	décimales	sont	alignées	sur	l'emplacement	du	taquet
de	tabulation.	Ce	taquet	de	tabulation	est	utilisé	pour	les	nombres.

5	-	Ce	taquet	de	tabulation	définit	l'emplacement	où	le	texte	commence.	Seul	un	taquet	de	tabulation
de	ce	type	peut	être	présent.	Vous	ne	pouvez	pas	le	supprimer.

6	–	Ce	taquet	de	tabulation	définit	le	retrait	du	paragraphe.	Seul	un	taquet	de	tabulation	de	ce	type
peut	être	présent.	Vous	ne	pouvez	pas	le	supprimer.

7	–	Ce	taquet	de	tabulation	définit	l'emplacement	où	le	texte	finit.	Seul	un	taquet	de	tabulation	de	ce
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type	peut	être	présent.	Vous	ne	pouvez	pas	le	supprimer.

	

Pour	ajouter	un	taquet	de	tabulation,	faites	un	clic	droit	sur	la	barre	de	règle,	puis	sélectionnez	le	type
de	taquet	de	tabulation	dans	le	menu	local.

Vous	pouvez	ajouter	autant	de	taquets	de	tabulation	Gauche,	Droite,	Centrée	et	Décimale	que	vous	le
souhaitez.

Pour	supprimer	un	taquet	de	tabulation,	glissez-déposez-le	hors	de	la	barre	de	règle.

Pour	modifier	le	type	de	taquet	de	tabulation,	faites	un	clic	droit	dessus,	puis	sélectionnez	un	autre
type	dans	le	menu	local.

Pour	déplacer	un	taquet	de	tabulation,	faites-le	glisser	jusqu'à	un	nouvel	emplacement.

Pour	aligner	du	texte	sur	plusieurs	lignes,	les	taquets	de	tabulation	de	ces	lignes	doivent	avoir	la	même
position	et	être	du	même	type.	Vous	devez	sélectionner	toutes	les	lignes,	puis	définir	les	taquets	de
tabulation.

Vous	pouvez	définir	des	taquets	de	tabulation	individuellement	pour	n'importe	quelle	ligne.
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Utilisation	d'images
Le	programme	vous	permet	soit	d'utiliser	des	images	fournies	avec	lui,	soit	d'en	importer	à	partir	de
fichiers	graphiques	ou	de	l'application	Photos.	Vous	pouvez	accéder	aux	images	à	partir	du	panneau
Source.

1	–	Clipart	intégré.

2	–	Importez	des	images	à	partir	de	votre	photothèque	Photos	ou	d'un	dossier	de	votre	disque.

3	–	Bibliothèque	de	formes	intelligentes	intégrée.

4	–	Collection	de	conceptions	de	titre.

Pour	trouver	une	image	dans	le	clipart,	utilisez	l'outil	de	recherche	situé	en	bas	de	l'onglet	Clipart.

Pour	effectuer	une	recherche	sur	Internet,	utilisez	la	commande	de	menu	Insertion	>	Image	>
Rechercher	sur	internet…	Le	résultat	de	la	recherche	est	affiché	dans	votre	navigateur	Web.	Pour
ajouter	une	image	à	votre	document,	faites-la	glisser	depuis	le	navigateur	et	déposez-la	sur	l'espace
de	travail.

Certaines	opérations	communes	à	différents	types	d'objets	sont	décrites	dans	les	sections
correspondantes	:

Sélection	d'objets
Modification	de	la	taille	des	objets
Rotation	d'objets
Groupement	d'objets
Remplissage	d'objets	avec	des	couleurs
Application	des	réglages	de	contour
Application	de	l'effet	d'ombre

Ajout	d'une	image	à	un	document

Depuis	le	clipart	:

1.	 Ouvrez	le	clipart	dans	le	panneau	Source.

2.	 Sélectionnez	une	catégorie	d'images	dans	le	menu	local.

3.	 Cliquez	sur	la	vignette	d'une	image	ou	faites-la	glisser	et	déposez-la	sur	l'espace	de	travail.
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Depuis	la	photothèque	Photos	:

1.	 Ouvrez	la	photothèque	Photos	dans	le	panneau	Source.

2.	 Cliquez	sur	une	image	ou	faites-la	glisser	et	déposez-la	sur	l'espace	de	travail.

Depuis	un	fichier	:

Choisissez	Insertion	>	Image	>	Depuis	fichier…	dans	le	menu	principal.
Vous	pouvez	aussi	faire	glisser	une	image	depuis	un	dossier	et	la	déposer	sur	le	document.

Pour	afficher	des	images	provenant	d'un	dossier	dans	le	panneau	Source	:

1.	 Ouvrez	l'onglet	avec	la	photothèque	Photos	dans	le	panneau	Source.

2.	 Cliquez	sur	l'élément	Dossier	personnalisé.

3.	 Cliquez	sur	une	icône	de	flèche	et	naviguez	jusqu'au	dossier	contenant	les	images.

Insertion	d'images	générées

Le	générateur	d'images	intégré	peut	créer	des	images	destinées	à	des	arrière-plans	ou	de	la
décoration.	Pour	plus	d'informations,	reportez-vous	à	la	section	Utilisation	de	générateurs	d'image.

Propriétés	de	l'image

Les	propriétés	d'image	se	trouvent	dans	l'onglet	Apparence	de	l'inspecteur.
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Pour	teinter	une	image,	cochez	la	case	Remplir.	Ensuite,	cliquez	sur	le	bouton	de	couleur	pour	choisir
une	couleur.

Pour	modifier	la	transparence	de	l'image,	utilisez	l'outil	Opacité.

Vous	pouvez	déposer	une	image	dans	une	forme	intelligente	ou	une	autre	image	sélectionnée.	Les
options	Remplir,	Étirer	et	Adapter	permettent	de	définir	comment	l'image	est	ajustée	à	l'intérieur	de	la
forme.	Cette	opération	est	décrite	dans	la	section	Utilisation	de	formes	intelligentes.

L'outil	de	création	de	mosaïque	d'image	crée	de	nombreuses	copies	à	échelle	réduite	de	l'image	dans	la
zone	occupée	par	l'image	d'origine.	Cette	fonction	peut	être	utilisée	pour	créer	des	arrière-plans.	Il	est
plus	facile	de	comprendre	le	sens	de	la	valeur	numérique	lorsque	l'image	a	sa	taille	d'origine	(Format
>	Image	>	Taille	d'origine).	Lorsque	vous	définissez	une	valeur	de	1,	l'image	correspond
exactement	au	cadre.	Lorsque	vous	définissez	une	valeur	de	2,	l'image	devient	deux	fois	plus	petite
(soit	4	copies	par	cadre).	Une	valeur	inférieure	à	1	rend	l'image	plus	grande	que	le	cadre.	Le	fait	de
redimensionner	le	cadre	ne	modifie	pas	l'échelle	de	l'image	à	l'intérieur	de	celui-ci.

Pour	mettre	une	image	en	mosaïque,	sélectionnez-la,	puis	choisissez	Format	>	Image	>	Mosaïque
dans	le	menu	ou	cliquez	sur	le	menu	Étirer	dans	l'inspecteur,	puis	sélectionnez	Mosaïque.	Utilisez	la
barre	coulissante	Mosaïque	pour	ajuster	le	nombre	de	mosaïques	et	leur	taille.
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Masquage	d'images

			

Cliquez	sur	le	cadre	d'image	de	Masque	dans	l'inspecteur,	puis	sélectionnez	un	masque	dans	la
bibliothèque.	Pour	utiliser	un	masque	personnalisé,	cliquez	sur	Masque	personnalisé...	sous	la
bibliothèque,	puis	sélectionnez	un	fichier	graphique.

Recadrage	d'images

L'outil	Recadrer	vous	permet	d'utiliser	une	partie	d'une	image	dans	votre	création.

Pour	recadrer	une	image,	faites	un	clic	droit	dessus,	puis	choisissez	Recadrer.	Les	poignées	rouges	sur
le	cadre	d'image	indiquent	que	vous	êtes	en	mode	recadrage.	Déplacez	ces	poignées	pour	afficher	la
partie	souhaitée	de	l'image.	Pour	quitter	le	mode	recadrage,	cliquez	à	nouveau	sur	Recadrer	dans	le
menu	contextuel.

Lorsque	le	mode	recadrage	est	activé,	vous	pouvez	déplacer	l'image	dans	son	cadre.
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Modification	d'images

Pour	modifier	une	image	à	l'aide	de	l'éditeur	d'images	intégré,	double-cliquez	sur	l'image.
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Utilisation	des	formes	intelligentes
Une	forme	intelligente	est	une	image	vectorielle.	Vous	pouvez	activer	ou	désactiver	son	contour,	lui
appliquer	une	couleur	ou	un	remplissage	dégradé	et	placer	une	image	à	l'intérieur.	Il	est	possible	de
contrôler	manuellement	la	forme	de	certaines	formes	intelligentes.

Les	formes	intelligentes	se	trouvent	dans	l'onglet	Clipart	du	panneau	Source.	Pour	ajouter	une	forme
intelligente	à	votre	conception,	glissez	et	déposez-en	une	sur	l'espace	de	travail.

La	plupart	des	outils	qui	fonctionnent	avec	des	images	ordinaires	peuvent	aussi	être	utilisés	avec	les
formes	intelligentes.

Certaines	opérations	communes	à	différents	types	d'objets	sont	décrites	dans	:

Sélection	d'objets
Modification	de	la	taille	des	objets
Rotation	d'objets
Groupement	d'objets
Remplissage	d'objets	avec	des	couleurs
Application	des	réglages	de	contour
Application	de	l'effet	d'ombre

Insertion	d'une	image	dans	une	forme	intelligente

Pour	insérer	une	image	dans	une	forme	intelligente,	sélectionnez	cette	forme	intelligente.	Prenez
l'image	et	déplacez-la	au-dessus	de	la	forme	intelligente.	Lorsque	cette	forme	intelligente	est	mise	en
surbrillance,	déposez	l'image	dedans.

Pour	insérer	une	image	depuis	un	fichier,	sélectionnez	Forme	intelligente,	cliquez	sur	le	bouton	Image
dans	l'onglet	Apparence	de	l'inspecteur,	puis	sélectionnez	Image	personnalisée…	et	le	fichier
graphique	correspondant.

107



Pour	supprimer	l'image	d'une	forme	intelligente,	cliquez	sur	le	bouton	Image	dans	l'onglet	Apparence
de	l'inspecteur,	puis	sélectionnez	Effacer	l'image.

Vous	pouvez	choisir	la	manière	dont	l'image	apparaît	dans	la	forme	intelligente	à	l'aide	du	menu
déroulant	sous	le	bouton	Image.	Les	options	suivantes	sont	disponibles	:	Remplir,	Étirer,	Adapter,
Mosaïque.	L'option	Recadrer	de	cette	liste	déroulante	s'active	lorsque	vous	recadrez	une	image.

Forme	intelligente	d'origine.

Image	d'origine.
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Remplir	:	les	proportions	de
l'image	restent	inchangées.
Il	est	possible	que	certaines
parties	de	l'image	ne	soient
pas	visibles.

Étirer	:	la	totalité	de	l'image
s'adapte	à	la	forme
intelligente,	mais	l'image
peut	être	déformée.

Adapter	:	la	totalité	de
l'image	s'adapte	à	la	forme
intelligente	sans
modification	des
proportions.	Un	espace
vierge	peut	être	apparent
dans	la	forme	intelligente.

Mosaïque	:	plusieurs	copies
de	l'image	sont	placées	dans
la	forme	intelligente.

Vous	pouvez	déposer	une	nouvelle	image	dans	une	forme	intelligente	qui	comporte	déjà	une	image.	En
fonction	de	l'option	sélectionnée,	la	nouvelle	image	s'étire,	remplit	ou	s'ajuste	dans	les	limites	de
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l'image	précédente	dans	la	forme	intelligente.

Modification	de	la	forme

Vous	pouvez	modifier	la	courbure	et	le	nombre	de	côtés	de	certaines	formes	intelligentes	dans	l'onglet
Géométrie	de	l'inspecteur.

Vous	pouvez,	par	exemple,	modifier	le	nombre	de	pointes	de	cette	étoile	à	cinq	branches	à	l'aide	du
curseur	Nombre	de	côtés.	Vous	pouvez	modifier	l'angle	à	l'aide	du	curseur	Courbe.

Outre	les	formes	intelligentes,	la	bibliothèque	contient	une	collection	de	cercles,	de	rectangles,	de
flèches	et	d'autres	images	vectorielles.	Elles	se	trouvent	dans	la	catégorie	Symboles	du	clipart	intégré.
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Modification	d'images
Pour	modifier	une	image,	double-cliquez	dessus.

Les	fonctionnalités	de	modification	d'image	sont	disponibles	grâce	aux	filtres	Core	Image.

La	liste	des	filtres	est	organisée	en	catégories	(couleur,	flou,	etc.).	Certains	filtres	possèdent	des
paramètres	ajustables.

Lorsque	vous	sélectionnez	un	filtre	ou	que	vous	modifiez	l'un	de	ses	paramètres,	l'image	de	la	zone
d'aperçu	change	en	temps	réel.

Certains	filtres	vous	permettent	de	modifier	l'image	à	l'aide	de	la	souris.	Une	icône	circulaire	réticule)
située	en	regard	du	nom	vous	indique	cette	possibilité.	Sélectionnez	un	filtre	de	ce	type,	placez	le
curseur	de	la	souris	sur	l'image,	puis	déplacez	la	souris	tout	en	maintenant	le	bouton	gauche	de	la
souris	enfoncé.	L'image	change	en	fonction	de	la	position	du	réticule.

Pour	modifier	la	taille	de	l'image,	cliquez	sur	le	bouton	Taille,	puis	attribuez	de	nouvelles	dimensions	à
l'image.
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Utilisation	de	générateurs	d'image

Génération	d'images

Pour	accéder	aux	générateurs	d'images,	choisissez	Insertion	>	Image	>	Génération	aléatoire	dans
le	menu.

Certains	générateurs	d'images	(comme	Carrés	tournants)	affichent	une	image	en	fonction	des
paramètres	que	vous	avez	définis.	D'autres	génèrent	des	images	complètement	aléatoires	(comme
Poussière	d'étoile).	Pour	obtenir	une	autre	image	générée	automatiquement,	cliquez	sur	le	bouton
Rendu.

Si	vous	décidez	d'ouvrir	l'une	des	images	générées	précédemment,	utilisez	les	boutons	d'historique
«	<	»	et	«	>	».

Lorsque	vous	sélectionnez	un	générateur,	le	programme	affiche	une	image	générée	à	partir	de
l'ensemble	des	paramètres	par	défaut.

Pour	certains	générateurs,	l'affichage	d'une	image	peut	parfois	prendre	du	temps.	Si	vous	jouez	avec
les	paramètres	(surtout	la	couleur)	pour	arriver	à	une	combinaison	qui	vous	convient,	il	est
recommandé	de	définir	une	plus	petite	taille	d'image.	Pour	un	aperçu,	il	est	suffisant	de	choisir	200	x
200	pixels.	Vous	pouvez	ensuite	modifier	la	taille	de	l'image	pour	la	générer	à	nouveau	avec	une
qualité	supérieure.

Paramètres	du	générateur

1	–	Liste	des	générateurs.

2	–	Paramètres	du	générateur.

3	–	Génère	une	autre	image.
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4	–	Historique	des	images	générées.	Vous	pouvez	afficher	l'image	précédente	ou	suivante.

Les	générateurs	possèdent	différents	ensembles	de	paramètres.	Ces	paramètres	peuvent	être	divisés
selon	les	groupes	suivants	:

Forme	:	certains	générateurs	utilisent	plusieurs	petites	images	afin	d'en	créer	une	plus	grande
et	vous	permettent	de	sélectionner	l'image	à	utiliser.
Paramètres	numériques	tels	que	l'angle,	la	taille,	la	résolution,	etc.
Schéma	couleur	:	définit	le	nombre	de	couleurs	à	utiliser	dans	l'image.	La	couleur	de	base
provient	de	la	commande	«	Couleur	».

•	Opposé	:	deux	couleurs	(couleur	sélectionnée	et	couleur	complémentaire)	et	jusqu'à
quatre	de	leurs	teintes.
•	Triadic	:	trois	couleurs	(couleur	sélectionnée	et	deux	couleurs	complémentaires)	et
jusqu'à	quatre	de	leurs	teintes.
•	Tetradic	:	quatre	couleurs	(couleur	sélectionnée	et	trois	couleurs	complémentaires)	et
jusqu'à	quatre	de	leurs	teintes.
•	Monoétape	:	une	couleur	de	base	et	quatre	de	ses	teintes.
•	Mononoir	:	une	couleur	de	base	et	quatre	de	ses	teintes,	plus	foncées	que	la	couleur	de
base.
•	Monoblanc	:	une	couleur	de	base	et	quatre	de	ses	teintes,	plus	claires	que	la	couleur	de
base.
•	Mono	:	une	couleur	de	base	et	un	nombre	illimité	de	teintes.

Le	sélecteur	de	couleur	est	de	l'un	des	types	suivants	:
•	Couleur
•	Plage	de	couleurs	:	vous	pouvez	déplacer	séparément	les	curseurs	de	couleur.	Pour	les
déplacer	simultanément,	faites	glisser	l'un	d'eux	en	maintenant	la	touche	Maj	enfoncée.

Couleur	fond	:	couleur	de	l'arrière-plan	de	l'image.	Elle	peut	être	appliquée	aux	images	avec
un	arrière-plan	transparent.

Taille	de	l'image

Pour	modifier	ou	vérifier	la	taille	de	l'image,	cliquez	sur	le	bouton	Taille.
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Utilisation	des	titres
Le	panneau	Source	contient	une	bibliothèque	de	styles	que	vous	pouvez	utiliser	pour	créer	des	titres	et
d'autres	designs	basés	sur	du	texte.	Vous	devez	cliquer	sur	l'icône	«	a	»	pour	ouvrir	la	bibliothèque.	Si
le	panneau	Source	est	masqué,	sélectionnez	Présentation	>	Afficher	le	panneau	Source.

Pour	ajouter	un	titre	à	votre	document,	faites	glisser	le	design	de	votre	choix	et	déposez-le	sur	l'espace
de	travail.	Le	programme	va	alors	ouvrir	automatiquement	un	éditeur	de	texte	dans	lequel	vous
pourrez	taper	ou	coller	du	texte.	Pour	ouvrir	l'éditeur	de	texte	par	la	suite,	double-cliquez	sur	un	titre.

Bien	que	certains	titres	puissent	ressembler	à	des	images	et	d'autres	à	du	texte,	les	titres	constituent
un	type	d'objets	distinct.	Les	titres	possèdent	une	quantité	limitée	de	propriétés	qu'il	est	possible	de
personnaliser	dans	l'inspecteur.	La	plupart	des	options	sont	disponibles	dans	l'onglet	Géométrie.
L'onglet	Apparence	vous	permet	de	modifier	uniquement	l'opacité.	Dans	l'onglet	Texte,	vous	pouvez
choisir	une	police	et	un	alignement	et	ajuster	l'espacement	des	caractères	et	des	lignes.	L'onglet	Texte
vous	permet	en	outre	de	modifier	la	couleur	de	votre	titre.	Une	nouvelle	couleur	sera	appliquée	à	tout
l'objet.

Il	existe	deux	types	de	titres	dans	le	panneau	Source	:	2D	et	3D.	Lorsqu'un	titre	3D	est	sélectionné,
une	poignée	ronde	est	affichée	au	centre	dans	la	partie	inférieure	de	ce	titre.	Vous	pouvez	saisir	cette
poignée	et	la	déplacer	pour	faire	pivoter	le	titre	à	360	degrés.	Une	rotation	régulière	est	possible	pour
les	deux	types	de	titres.
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N'oubliez	pas	que	la	fonctionnalité	Titre	n'est	pas	censée	fonctionner	avec	une	grande	quantité	de
texte.	Cela	risque	de	diminuer	les	performances	du	programme.

115



Traçage	de	lignes	et	de	courbes

Traçage

Pour	tracer	une	ligne	droite,	activez	l'outil	Ligne	 .	Placez	le	curseur	et	appuyez	sur	le	bouton
gauche	de	la	souris	pour	indiquer	le	début	de	la	ligne.	Maintenez	le	bouton	enfoncé	et	pointez	sur
l'emplacement	de	la	fin	de	la	ligne,	puis	relâchez	le	bouton.

Pour	tracer	une	chaîne	polygonale	(trajet),	activez	l'outil	Spline	 .	Cliquez	sur	l'espace	de	travail
pour	placer	le	premier	point.	Cliquez	une	deuxième	fois	pour	placer	un	autre	point	et	ainsi	de	suite.	Ces
points	indiquent	les	fins	des	segments.	Les	points	que	vous	ajoutez	sont	appelés	des	points	d'ancrage.
Si	vous	cliquez	et	que	vous	relâchez	simplement,	la	ligne	tracée	est	droite.	Cependant,	si	vous	cliquez
pour	ajouter	un	deuxième	point,	que	vous	maintenez	le	bouton	enfoncé	et	que	vous	faites	glisser	le
curseur,	vous	pouvez	courber	la	ligne.

Les	outils	Ligne	et	Spline	partagent	le	même	bouton	dans	la	barre	d'outils.	Si	l'outil	dont	vous	avez
besoin	est	masqué,	cliquez	sur	la	flèche	et	sélectionnez	l'outil	dans	le	menu	déroulant.

Pour	créer	une	forme	fermée,	placez	le	dernier	point	d'ancrage	sur	le	premier	point	(un	petit	cercle
près	du	curseur	indique	que	vous	pouvez	fermer	la	forme).

Pour	tracer	des	lignes	droites	dont	les	angles	sont	divisibles	par	45	degrés,	créez	des	lignes	tout	en
maintenant	la	touche	Maj	enfoncée.

Points	d'ancrage	et	trajets

Un	trajet	comprend	des	points	d'ancrage	et	des	lignes	qui	les	relient.	Les	points	d'ancrage	indiquent	le
début	et	la	fin	de	chaque	ligne	(ou	segment).	En	ajoutant	une	ligne	après	une	autre,	vous	créez	un
tracé.

Le	trajet	peut	être	soit	fermé,	soit	ouvert.	Un	trajet	fermé	commence	et	finit	au	même	point.

Les	points	d'ancrage	sont	de	deux	types	:	point	d'angle	ou	point	lissé.	Pour	modifier	le	type	de	point
d'ancrage,	double-cliquez	dessus.	Ainsi,	les	lignes	de	liaison	courbes	deviennent	droites	et	vice	versa.
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1	–	Point	d'angle.	Le	tracé	change	brusquement	de	direction	à	un	point	d'angle.	Un	point	d'angle	peut
relier	n'importe	quelle	combinaison	de	lignes	courbes	ou	droites.	Un	point	d'angle	reliant	deux	lignes
droites	ne	présente	pas	de	poignées	pour	modifier	la	courbe.

2	–	Point	d'ancrage	sélectionné	(mis	en	surbrillance	en	bleu).

3	–	Segment	droit.

4	–	Point	lissé.	Le	trajet	continue	de	suivre	la	même	direction	à	un	point	lissé.	Un	point	lissé	relie	deux
segments	courbes.

5	–	Ligne	de	direction.

6	–	Point	de	direction.	Il	s'agit	d'une	poignée	à	l'extrémité	d'une	ligne	de	direction.	En	déplaçant	un
point	de	direction,	vous	pouvez	modifier	la	longueur	et	l'angle	de	la	ligne	de	direction	correspondante.

7	–	Segment	courbe.

8	–	Point	d'angle.

Pour	sélectionner	un	point	d'ancrage,	cliquez	dessus	avec	l'outil	de	sélection.	Maintenez	la	touche	Maj
enfoncée	et	cliquez	pour	sélectionner	plusieurs	points	d'ancrage.

La	direction	d'un	trajet	courbe	passant	par	un	point	d'ancrage	lissé	coïncide	avec	la	direction	de	la	ligne
de	direction.	Si	vous	laissez	le	point	d'ancrage	tel	quel,	le	tracé	s'écarte	de	la	ligne	de	direction.	Plus	la
ligne	de	direction	est	longue,	plus	le	trajet	suit	cette	ligne.	Pour	modifier	l'angle	ou	la	longueur	d'une
ligne	de	direction,	faites	glisser	le	point	de	direction	sur	son	extrémité.

		

Par	défaut,	les	lignes	de	direction	du	même	point	lissé	pivotent	ensemble	en	conservant	un	angle	de
180	degrés	entre	elles.	En	modifiant	cet	angle,	vous	pouvez	créer	un	point	d'angle	à	partir	d'un	point
lissé.	Pour	ce	faire,	faites	glisser	un	des	deux	points	de	direction	en	maintenant	la	touche	Commande
enfoncée.	Pour	faire	pivoter	à	nouveau	deux	lignes	de	direction	ensemble,	restaurez	un	angle	de	180
degrés	entre	elles.	Vous	pouvez	également	double-cliquer	deux	fois	sur	le	point	d'ancrage.

Si	vous	devez	faire	pivoter	une	des	lignes	de	direction	séparément	d'une	autre,	maintenez	la	touche
Commande	enfoncée.

Pour	faire	pivoter	une	ligne	de	direction	par	incréments	de	45	degrés,	maintenez	la	touche	Maj
enfoncée.

Ajout	et	suppression	de	points	d'ancrage

Lorsque	vous	avez	terminé	de	tracer	le	trajet,	vous	pouvez	ajouter	ou	supprimer	des	points	d'ancrage.

Pour	ajouter	un	nouveau	point,	activez	l'outil	Sélection,	sélectionnez	le	trajet,	puis	cliquez	sur	un
segment	en	maintenant	les	touches	Alt	+	Maj	enfoncées.
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Pour	supprimer	un	point	d'ancrage,	sélectionnez-le,	puis	appuyez	sur	la	touche	Supprimer.	La
suppression	d'un	point	d'ancrage	au	milieu	d'un	trajet	relie	les	deux	points	d'ancrage	voisins	par	un
nouveau	segment.

Ajout	d'un	autre	trajet

Lorsque	vous	avez	terminé	de	tracer	un	trajet,	vous	pouvez	ajouter	un	autre	trajet	au	même	objet.	Le
résultat	est	encore	un	objet	unique.

1.	 Sélectionnez	le	trajet	existant	à	l'aide	de	l'outil	Sélection.

2.	 Activez	l'outil	Spline.

3.	 Maintenez	la	touche	Alt	enfoncée	et	tracez	le	trajet.
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Utilisation	de	tableaux
Les	tableaux	servent	généralement	à	organiser	du	texte	et	des	données	numériques.	Les	tableaux	sont
parfois	utilisés	pour	disposer	du	texte	ou	des	images	sur	la	page.	Dans	ce	cas,	ces	tableaux	sont
souvent	rendus	invisibles.
Le	déplacement,	le	redimensionnement	et	les	autres	actions	habituelles	fonctionnent	avec	les	tableaux
comme	avec	les	autres	objets.

Insertion	et	suppression	de	tableaux
Ajout	de	rangées	et	de	colonnes
Sélection	du	tableau	et	de	ses	éléments
Redimensionnement	des	colonnes	et	des	rangées
Fusion	et	division	des	cellules
Modification	de	la	couleur	d'arrière-plan	des	cellules
Modification	de	la	couleur	et	de	la	largeur	des	bordures
Saisie	de	texte	dans	les	cellules
Insertion	d'images	dans	les	cellules
Effacement	de	cellules

Insertion	et	suppression	de	tableaux

Pour	insérer	un	tableau	dans	le	document,	sélectionnez	Insertion	>	Tableau.

Pour	modifier	le	nombre	de	rangées	et	de	colonnes	d'un	nouveau	tableau,	faite	un	clic	droit	sur	le
tableau,	puis	choisissez	Modifier	le	tableau...	dans	le	menu	contextuel.	L'option	Hauteur	de	tableau
fixe	vous	permet	de	modifier	le	nombre	de	rangées	en	conservant	la	même	hauteur	de	tableau.

Pour	supprimer	un	tableau,	sélectionnez-le,	puis	appuyez	sur	la	touche	Supprimer.

Ajout	de	rangées	et	de	colonnes

Pour	insérer	une	rangée,	sélectionnez	une	cellule.	Ensuite,	ouvrez	le	menu	contextuel,	puis	choisissez
la	commande	Ajouter	une	rangée	au-dessus	ou	Ajouter	une	rangée	en	dessous.

Pour	insérer	une	colonne,	sélectionnez	une	cellule.	Ensuite,	ouvrez	le	menu	contextuel,	puis	choisissez
la	commande	Ajouter	une	colonne	avant	ou	Ajouter	une	colonne	après.

La	touche	Tabulation	ajoute	une	rangée	lorsque	la	cellule	inférieure	droite	est	mise	en	surbrillance.

Sélection	du	tableau	et	de	ses	éléments

Pour	sélectionner	un	tableau,	cliquez	dessus.	Pour	sélectionner	un	élément	du	tableau	(une	cellule	ou
une	ligne),	sélectionnez	le	tableau,	puis	cliquez	sur	une	cellule	ou	un	séparateur.

La	touche	Tabulation	sélectionne	la	cellule	suivante	(dans	l'ordre	Z).	Lorsque	la	dernière	cellule	est
atteinte,	le	fait	d'appuyer	sur	Tabulation	ajoute	une	rangée	et	sélectionne	la	cellule	de	gauche	de
cette	rangée.	C'est	également	le	cas	lorsque	la	totalité	du	tableau	est	sélectionnée.

Appuyez	sur	Maj	+	Tabulation	pour	sélectionner	la	cellule	précédente	(dans	l'ordre	Z).	Une	fois	que
vous	avez	atteint	la	cellule	supérieure	gauche,	le	fait	d'appuyer	sur	Maj	+	Tabulation	sélectionne	la
cellule	inférieure	droite.
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Redimensionnement	des	colonnes	et	des	rangées

Pour	redimensionner	une	colonne	ou	une	rangée,	sélectionnez	le	séparateur	qui	la	divise	d'une	autre
colonne	ou	rangée,	puis	faites	la	glisser	avec	la	souris.

L'option	Hauteur	de	tableau	fixe	vous	permet	de	préciser	comment	le	tableau	réagit	au
redimensionnement	de	rangées.	Pour	accéder	à	cette	option,	faites	un	clic	droit	sur	le	tableau,	puis
choisissez	Modifier	le	tableau...	Lorsque	l'option	Hauteur	de	tableau	fixe	est	activée,	la
modification	de	la	hauteur	de	rangée	affecte	les	rangées	contiguës,	mais	pas	la	taille	du	tableau.
Lorsque	cette	option	est	désactivée,	l'augmentation	ou	la	diminution	de	la	hauteur	d'une	rangée
modifie	la	hauteur	du	tableau.	Les	hauteurs	des	rangées	restent	constantes.

Fusion	et	division	des	cellules

Vous	pouvez	créer	des	cellules	plus	grandes	ou	plus	petites	que	d'autres	en	les	fusionnant	ou	en	les
divisant.

Pour	fusionner	des	cellules,	sélectionnez-les,	puis	choisissez	la	commande	Fusionner	les	cellules
dans	le	menu	contextuel.

Pour	diviser	une	cellule,	sélectionnez-la,	puis	choisissez	la	commande	Diviser	en	rangées	ou	Diviser
en	colonnes	dans	le	menu	contextuel.

Modification	de	la	couleur	d'arrière-plan	des	cellules

Pour	modifier	la	couleur	d'arrière-plan	d'une	ou	de	plusieurs	cellules,	sélectionnez-les	et	appliquez
l'outil	Remplir	situé	dans	l'onglet	Apparence	(Commande	+	3)	de	l'inspecteur.

Modification	de	la	couleur	et	de	la	largeur	des	bordures

Pour	modifier	la	couleur	ou	la	largeur	de	la	bordure	ou	du	séparateur	du	tableau,	utilisez	les	outils
Contour	situés	dans	l'onglet	Apparence	(Commande	+	3)	de	l'inspecteur.

Saisie	de	texte	dans	les	cellules

Pour	commencer	à	saisir	du	texte,	double-cliquez	sur	la	cellule.

Pour	mettre	en	forme	le	texte	dans	le	tableau,	utilisez	les	outils	situés	dans	l'onglet	Texte	de
l'inspecteur.

Insertion	d'images	dans	les	cellules

Pour	insérer	une	image,	sélectionnez	un	tableau,	puis	faites	glisser	une	image	depuis	le	panneau
Source	ou	le	Finder	et	déposez-la	dans	la	cellule.

Autre	manière	d'insérer	une	image	:

1.	 Sélectionnez	une	cellule.
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2.	 Ouvre	l'onglet	Apparence	de	l'inspecteur.

3.	 Cliquez	sur	la	commande	Image,	puis	choisissez	Image	personnalisée...

4.	 Sélectionnez	un	fichier	graphique.

Il	existe	plusieurs	manières	d'insérer	une	image	dans	la	cellule	:

Remplir	:	les	proportions	de	l'image	restent	inchangées.	Il	est	possible	que	certaines	parties
de	l'image	ne	soient	pas	visibles	dans	la	cellule.
Adapter	:	la	totalité	de	l'image	s'adapte	à	la	cellule	sans	modification	des	proportions.	Un
espace	vierge	peut	être	laissé	apparent	dans	la	cellule.
Étirer	:	la	totalité	de	l'image	s'adapte	à	la	cellule.	L'image	peut	être	déformée.
Mosaïque	:	les	proportions	de	l'image	restent	inchangées.	Si	la	cellule	n'est	pas	assez	grande,
l'image	sera	partiellement	coupée.	Si	la	cellule	est	plus	grande	que	l'image,	elle	est	remplie
avec	plusieurs	copies	de	l'image.

Effacement	de	cellules

Pour	supprimer	le	contenu	d'une	cellule	sélectionnée,	choisissez	Effacer	les	cellules	dans	le	menu
contextuel.	Vous	pouvez	effacer	plusieurs	cellules	sélectionnées.

L'effacement	de	cellules	est	pratique	lorsque	vous	voulez	réutiliser	un	tableau	existant	comme	modèle
pour	un	nouveau	tableau.	Dans	ce	cas,	vous	pouvez	effacer	tout	ou	partie	du	tableau	pour	y	saisir	de
nouvelles	données.
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Utilisation	de	calendriers
Pour	ajouter	un	calendrier	à	votre	document,	sélectionnez	Insertion	>	Calendrier	dans	le	menu.

Les	calendriers	sont	composés	de	trois	parties	:	mois,	jours	de	la	semaine	et	dates.	Il	est	possible	de
masquer	les	deux	premières.	Vous	pouvez	modifier	individuellement	la	police,	la	couleur	de	texte	et	la
couleur	d'arrière-plan	de	chacune	des	parties.	Pour	ce	faire,	sélectionnez	l'une	des	parties	du	calendrier
et	utilisez	les	outils	de	texte	et	de	remplissage	de	l'inspecteur.

Pour	afficher	la	zone	de	dialogue	des	propriétés,	double-cliquez	sur	le	calendrier.	Les	réglages	de	ce
panneau	vous	permettent	de	configurer	la	présence	et	l'emplacement	des	éléments	de	calendrier.

De	vos	réglages	régionaux	dépend	le	type	de	calendrier	et	le	jour	de	début	de	la	semaine	(dimanche
ou	lundi).	Vous	pouvez	les	afficher	dans	les	Préférences	Système.
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Insertion	de	la	date	et	de	l'heure	actuelles
Pour	insérer	la	date	et	l'heure	actuelles	dans	votre	document,	choisissez	Insertion	>	Date	et	heure
dans	le	menu.

Les	informations	peuvent	être	ajoutées	soit	sous	forme	d'un	champ	de	texte	individuel,	soit	dans	une
zone	de	texte.	Vous	ne	pouvez	pas	le	modifier	directement.	Pour	mettre	les	informations	à	jour,
double-cliquez	sur	le	champ	Date	et	heure.

Pour	modifier	la	mise	en	forme	du	texte,	utilisez	les	outils	situés	dans	l'onglet	Texte	de	l'inspecteur.

Pour	choisir	un	format	de	représentation	de	données	différent,	double-cliquez	sur	le	champ	Date	et
heure,	puis	sélectionnez	un	format	dans	la	liste	déroulante.

La	zone	d'édition	Format	vous	permet	de	créer	un	format	personnalisé.	Les	symboles	du	format
remplacent	le	jour,	le	mois,	l'année,	etc.	Par	exemple,	«	aaaa	»	représente	l'année	en	cours	au	format
«	1999	»	et	«	aa	»	équivaut	au	format	abrégé	«	99	».	Pour	plus	de	détails	sur	les	formats	de	date	et
d'heure,	rendez-vous	sur	ce	site	Web	:
http://www.unicode.org/reports/tr35/tr35-4.html#Date_Format_Patterns
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Utilisation	de	champs	d'adresse
Pour	ajouter	un	champ	d'adresse	à	votre	document,	sélectionnez	Insertion	>	Champ	d'adresse	dans
le	menu.

Le	programme	remplit	automatiquement	les	champs	d'adresse	de	votre	document	avec	les
informations	importées	depuis	l'application	Contacts.	Si	vous	sélectionnez	plusieurs	contacts,	le
programme	fonctionne	en	mode	de	fusion	d'impression	lorsqu'il	imprime	plusieurs	copies	de	votre
création,	une	par	contact	sélectionné.

Lorsque	vous	modifiez	le	document,	les	champs	d'adresse	affichent	leurs	noms.	Les	données	réelles
sont	insérées	dans	les	champs	au	cours	de	l'impression.	Par	conséquent,	pour	prévisualiser	votre
document	avec	les	coordonnées	personnelles,	vous	devez	utiliser	l'aperçu	dans	la	zone	de	dialogue
Imprimer.

Les	champs	d'adresse	peuvent	être	placés	n'importe	où	sur	la	page.	Toutefois,	pour	créer	une	adresse
à	partir	de	plusieurs	champs,	il	est	conseillé	de	les	placer	à	l'intérieur	d'une	zone	de	texte.	De	cette
manière,	votre	adresse	se	comportera	comme	un	objet	solide.	Pour	tracer	une	zone	de	texte,	utilisez
l'outil	Zone	de	texte	de	la	barre	d'outils.	Lorsque	le	curseur	se	trouve	dans	la	zone	de	texte,	ajoutez
des	champs	d'adresse.	N'oubliez	pas	d'ajouter	des	espaces	entre	les	champs.	Vous	pouvez	saisir	le
texte	de	votre	choix	à	cet	endroit,	par	exemple	ajouter	«	Téléphone	:	»	avant	le	numéro	de	téléphone.
Notez	que	le	texte	normal	comme	celui-ci	n'est	pas	dynamique,	ce	qui	signifie	que	le	mot
«	Téléphone	»	sera	conservé	même	si	un	contact	n'a	pas	de	numéro	de	téléphone.

Pour	modifier	la	mise	en	forme	du	texte,	utilisez	l'onglet	Texte	de	l'inspecteur.
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Types	de	champs	de	données	dynamiques
Les	champs	de	données	dynamiques	sont	des	objets	textuels	dont	le	contenu	est	inséré	et	modifié
automatiquement.	Le	contenu	de	la	plupart	des	champs	de	données	est	mis	à	jour	lorsque	vous
imprimez	plusieurs	copies	du	même	document.

Type Source	de	données

Champ
d'adresse

Coordonnées	personnelles	importées	depuis	les	applications
Contacts	ou	Carnet	d'adresses.	Les	champs	de	données	sont
remplis	au	moment	de	l'impression.	Il	est	possible	de
sélectionner	dans	la	zone	de	dialogue	Imprimer	les	contacts	à
partir	desquels	les	adresses	sont	prélevées.

Données	de
fichier

Données	importées	à	partir	d'un	fichier	texte.	Chaque	copie
imprimée	importe	une	nouvelle	ligne	de	texte.

Compteur
Compteur	qui	augmente	ou	diminue	automatiquement	en
fonction	d'un	critère.	Chaque	copie	imprimée	possède	un
numéro	unique.

Numéro	de
page Générées	automatiquement.

Date	et	heure Générées	automatiquement.

Une	nouvelle	valeur	apparaît	dans	le	champ	d'adresse,	les	données	de	fichier	et	le	compteur	dans
chaque	copie	successive	du	document	lors	de	l'impression.	Le	champ	Quantité	dans	la	zone	de
dialogue	Imprimer	doit	contenir	une	valeur	égale	ou	supérieure	à	2.
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Ajout	et	suppression	de	champs	de	données
Pour	ajouter	un	champ	de	données	dynamique,	sélectionnez-en	un	dans	la	section	centrale	du	menu
Insertion.

Les	champs	de	données	dynamiques	peuvent	être	ajoutés	soit	directement	à	votre	document,	soit	à
l'intérieur	d'un	champ	de	texte	normal.

Le	nom	du	champ	est	affiché	à	la	place	des	données	tant	que	le	champ	n'a	pas	été	rempli.	«	Code
postal	»,	par	exemple.

Prévoyez	un	minimum	d'espace	pour	les	champs	de	données	dont	les	informations	sont	importées	à
partir	de	sources	externes	telles	qu'un	fichier	ou	les	applications	Contacts	ou	Carnet	d'adresses.	Pour
être	sûr	que	tout	tient	parfaitement	dans	votre	création,	ouvrez	la	zone	de	dialogue	Imprimer,
sélectionnez	les	contacts	dont	vous	souhaitez	imprimer	les	données	et	vérifiez	l'aperçu	avant
impression.	Il	est	possible	de	vérifier	la	longueur	des	champs	Numéro	de	page	ou	Date	et	heure
directement	dans	la	fenêtre	principale	lorsque	vous	modifiez	votre	document.

Vous	pouvez	mélanger	dans	la	même	zone	de	texte	du	texte	normal	et	des	champs	de	données
dynamiques.	Cela	vous	permet	de	créer	du	texte	contenant	des	parties	variables	et	de	l'utiliser	pour	la
fusion	d'impression.

Pour	insérer	du	texte	dans	un	champ	contenant	des	données	dynamiques,	double-cliquez	dessus	pour
activer	le	mode	d'édition,	puis	placez	le	curseur	avant	ou	après	le	champ	de	données	et	saisissez	vos
informations.

Pour	supprimer	un	champ	de	données	indépendant,	sélectionnez-le	et	appuyez	sur	la	touche
Supprimer.

Pour	supprimer	un	champ	de	données	inséré	dans	une	zone	de	texte,	double-cliquez	sur	cette	dernière
pour	entrer	en	mode	d'édition.	Cliquez	ensuite	sur	le	champ	dynamique	pour	le	sélectionner	et	appuyez
sur	la	touche	Supprimer.
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Modification	des	propriétés	des	champs	de	données
Pour	afficher	le	panneau	local	contenant	les	propriétés	de	champ	de	données,	double-cliquez	sur	le
champ	concerné.	Vous	devez	en	fait	double-cliquer	deux	fois	:	une	première	fois	pour	activer	le	mode
d'édition	et	une	deuxième	fois	pour	afficher	le	panneau	des	propriétés.

Le	panneau	des	propriétés	vous	permet	de	modifier	le	format	de	données	des	champs	Compteur,
Numéro	de	page	et	Date	et	heure.	Le	numéro	de	page	peut,	par	exemple,	adopter	les	formats	«	3	»,
«	3	sur	11	»	ou	«	3/11	».

Double-cliquer	sur	le	champ	Adresse	permet	de	choisir	le	type	de	coordonnées	à	insérer.

Utilisez	l'option	Données	de	fichier	pour	sélectionner	un	fichier	texte	comme	source	d'importation	ou
pour	effectuer	certains	réglages.

Comme	les	champs	dynamiques	contiennent	du	texte,	vous	pouvez	les	formater	à	l'aide	des	outils
disponibles	dans	l'onglet	Texte	de	l'inspecteur.

127



Importation	de	contacts
Vous	pouvez	importer	des	coordonnées	depuis	l'application	Contacts	d'Apple.	La	procédure	de	base	est
la	suivante	:	Ajoutez	des	champs	de	données	à	votre	création	à	l'aide	de	la	commande	Insertion	>
Champ	d'adresse.	Chacun	d'eux	doit	afficher	une	information	personnelle	particulière	telle	que	le
nom	ou	le	numéro	de	téléphone.	Les	champs	de	données	sont	automatiquement	remplis	avec	les
coordonnées	des	contacts	lors	de	l'impression.	Vous	pouvez	créer,	dans	la	zone	de	dialogue	Imprimer,
une	liste	d'impression	en	sélectionnant	plusieurs	contacts.	Une	fois	que	l'impression	est	lancée,	le
programme	insère	les	coordonnées	de	chaque	contact	sélectionné	dans	les	champs	correspondants.

Vous	pouvez	prévisualiser	votre	document	avec	les	informations	importées	dans	l'aperçu	avant
impression.

Dans	les	dernières	versions	d'OS	X,	le	programme	ne	peut	accéder	aux	informations	de	l'application
Contacts	que	si	l'utilisateur	le	permet.	Pour	cela,	cochez	Swift	Publisher	dans	l'onglet	Confidentialité	de
la	section	Sécurité	et	confidentialité	des	Préférences	Système.
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Importation	de	données	à	partir	d'un	fichier	texte
Pour	importer	des	informations	à	partir	d'un	fichier	texte,	ajoutez	un	champ	Données	de	fichier	à	l'aide
de	la	commande	Insertion	>	Données	de	fichier.	Reliez	ensuite	le	champ	à	un	fichier	texte.	Double-
cliquez	deux	fois	sur	le	champ	pour	ouvrir	le	panneau	des	propriétés.	Cliquez	ensuite	sur	le	bouton
Choisir…	dans	le	panneau	pour	afficher	la	zone	de	dialogue	d'importation.	Sélectionnez	un	fichier
texte,	configurez	les	options	d'importation,	puis	cliquez	sur	le	bouton	Ouvrir.

Les	codes-barres	peuvent	également	utiliser	des	fichiers	texte	comme	source	de	données.

Les	fichiers	texte	doivent	être	enregistrés	dans	le	format	texte	décrit	ci-dessous.	En	règle	générale,	il
est	possible	d'exporter	les	feuilles	de	calcul	vers	des	fichiers	texte	délimités	par	des	tabulations.

Options	d'importation

Si	vous	cochez	la	case	La	première	ligne	est	un	en-tête,	la	première	rangée	n'est	pas	importée.
Cette	option	indique	que	la	première	rangée	ne	contient	pas	de	données.	Elle	est	constituée	des	titres
des	données	qui	se	trouvent	sur	les	lignes	inférieures.

Les	options	Données	unicolonnes	et	Données	multicolonnes	vous	permettent	de	déterminer	si
chaque	ligne	doit	être	traitée	comme	un	seul	(une	colonne)	ou	plusieurs	(plusieurs	colonnes)	éléments
d'information.	Dans	le	deuxième	cas,	vous	devez	sélectionner	le	type	de	délimiteur,	ainsi	que	le
numéro	de	la	colonne	à	partir	de	laquelle	des	données	doivent	être	importées.	Un	délimiteur	est	un
caractère	ou	un	espace	qui	indique	au	programme	où	s'arrête	une	colonne	et	où	commence	la
suivante.

Conservez	l'encodage	par	défaut	sauf	si	vous	connaissez	l'encodage	utilisé	par	votre	fichier.	Si	le	texte
importé	est	illisible	(si	certains	caractères	sont	remplacés	par	des	symboles),	recommencez
l'importation	en	sélectionnant	un	autre	encodage.

Format	de	fichier	texte

Toutes	les	données	du	fichier	texte	source	peuvent	être	organisées	en	une	ou	plusieurs	colonnes.

Structure	à	une	colonne	:

Exemple	:

Structure	à	plusieurs	colonnes	:
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Exemple	avec	un	point-virgule	utilisé	comme	délimiteur	:

	

Si	vos	données	sont	stockées	dans	une	base	de	données	ou	une	feuille	de	calcul,	exportez-les	dans	un
fichier	texte	délimité	par	des	tabulations	ou	des	virgules.

Pour	créer	manuellement	un	fichier	texte	:

1.	 Ouvrez	un	nouveau	document	dans	l'application	Text	Edit.

2.	 Passez	en	format	texte	(Format	>	Convertir	au	format	texte	ou	Commande	+	Maj	+	T).

3.	 Ajoutez	plusieurs	lignes	de	texte.	Utilisez	un	point-virgule	ou	une	tabulation	pour	diviser	une
ligne	en	plusieurs	colonnes.

4.	 Enregistrez	le	fichier.

N'ajoutez	pas	de	symboles	inutiles	!	Vous	risquez	sinon	de	corrompre	la	structure	du	fichier.

130



Ajout	et	suppression	de	codes-barres
Pour	ajouter	un	code-barres,	cliquez	sur	le	bouton	Code-barres	dans	la	barre	d'outils,	puis
sélectionnez	le	type	de	code-barres	à	ajouter.	Une	autre	solution	consiste	à	sélectionner	le	type	de
code-barres	dans	le	menu	Insertion	>	Code-barres.

Pour	remplacer	les	données	par	défaut,	double-cliquez	sur	le	code-barres,	puis	saisissez	vos	propres
informations.	Les	autres	propriétés	des	codes-barres	sont	expliquées	dans	le	document	Propriétés	des
codes-barres.

À	l'impression,	le	programme	vous	offre	la	possibilité	de	modifier	de	manière	dynamique	les
informations	codées	dans	les	différentes	copies	du	code-barres.	Cette	possibilité	n'existe	que	lorsque	le
code-barres	est	lié	à	un	fichier	contenant	des	données	ou	à	un	compteur	(nombre	qui	évolue	à	chaque
code-barres	en	fonction	d'un	critère).	En	cas	d'utilisation	de	codes-barres	contenant	des	informations
codées	variables,	veillez	à	laisser	suffisamment	d'espace	autour	du	code-barres	original	afin	qu'il
puisse	se	développer.	Cela	ne	concerne	que	les	codes-barres	capables	de	contenir	des	quantités
variables	d'informations	(Code	39	ou	Data	Matrix	ASCII,	par	exemple).	D'autres,	comme	les	codes-
barres	EAN	8	prennent	en	charge	un	nombre	de	caractères	fixe	et	ne	changent	pas	de	taille.

Pour	vérifier	si	un	code-barres	contenant	des	données	dynamiques	est	adapté	à	votre	mise	en	page,
utilisez	l'aperçu	avant	impression	accessible	via	la	zone	de	dialogue	Imprimer.

Pour	supprimer	un	code-barres,	sélectionnez-le,	puis	appuyez	sur	la	touche	Supprimer.
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Propriétés	des	codes-barres
Pour	afficher	les	propriétés	d'un	code-barres,	double-cliquez	sur	le	code-barres.

1	–	Type	de	codes-barres.	Si	vous	modifiez	le	type	de	codes-barres,	rappelez-vous	que	comme	les
codes-barres	ne	prennent	pas	tous	la	même	plage	de	caractères	en	charge,	certaines	parties	de	vos
données	risquent	d'être	illisibles.

2	–	Source	de	données.	Vous	disposez	de	trois	options.
Valeur	vous	permet	de	saisir	ou	de	coller	des	informations	directement	dans	la	zone	d'édition.
Fichier	vous	permet	de	lier	le	code-barres	à	un	fichier	texte.	Les	réglages	d'importation	sont	décrits	à
la	section	Importation	de	données	à	partir	d'un	fichier	texte.
Compteur	est	un	nombre	qui	augmente	ou	diminue	automatiquement	en	fonction	d'un	critère.	Vous
avez	la	possibilité	de	choisir	la	valeur	initiale.

3	–	Zone	de	texte	dans	laquelle	vous	pouvez	saisir	manuellement	des	informations.

4	–	Option	permettant	d'ajouter	une	somme	de	contrôle	au	code-barres.	Cette	fonction	n'est	pas	prise
en	charge	par	tous	les	codes-barres.

5	–	Ajouter	une	bordure	au	code-barres.	Seuls	les	codes-barres	«	2	parmi	5	entrelacés	»	prennent	en
charge	cette	fonction.

6	–	Cette	option	affiche	le	texte	ou	le	nombre	codé	avec	le	code-barres.

7	–	Échelle	du	code-barres.	Soyez	prudent	avec	cette	option,	car	les	lecteurs	de	codes-barres	ont	du
mal	à	lire	les	codes-barres	dont	l'échelle	est	inférieure	à	100	%.

8	–	Activer	l'option	Adapter	à	la	taille	standard	pour	redimensionner	le	code-barres	afin	de	lui
donner	une	taille	plus	facilement	lisible.

Toutes	les	informations	saisies	manuellement	sont	préservées,	quel	que	soit	le	nombre	de	codes-
barres	que	vous	imprimez.	Comme	les	valeurs	importées	à	partir	d'un	fichier	texte	ou	générées	par	un
compteur	sont	dynamiques,	lorsque	vous	imprimez	plusieurs	copies	de	votre	document,	chaque	copie
peut	contenir	des	informations	différentes.
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Si	la	saisie	ou	l'importation	de	données	a	été	suivie	d'un	message	d'erreur,	assurez-vous	que	les
caractères	saisis	et	le	nombre	de	caractères	sont	pris	en	charge	par	le	type	de	codes-barres	que	vous
avez	choisi.
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Types	de	code-barres
Le	tableau	ci-dessous	contient	une	liste	des	caractères	et	codes-barres	(non	postaux)	pris	en	charge,
avec	le	nombre	de	caractères	autorisés.

Nom	du
code-
barres

Définition Caractères	pris	en	charge Longueur

Code	128

Utilisé	dans	les
secteurs	de
l'expédition	et	de
l'emballage	à
travers	le	monde.

Presque	tous	les	symboles	ASCII,	y
compris	les	caractères	de	contrôle Variable

Code	39

Utilisé
principalement
dans	le	secteur
de	la	vente	en
gros.

0123456789[Espace]ABCDEFGHIJKL
MNOPQRSTUVWX	
YZ-.$/+%

Variable

Code	39
étendu

Code	39	avec
plage	de
caractères
étendue.

0123456789[Espace]ABCDEFGHIJKL
MNOPQRSTUVWX
YZ!#$%&'()*+,-./:;
<=>?@[\]^_`abc
defghijklmnopqrs
tuvwxyz{|}

Variable

2	parmi	5
entrelacés

Utilisé
commercialement
sur	les	films	135
et	sur	les	cartons
de	produits	dans
le	secteur	de
l'entreposage.

0123456789 Variable

ISBN	13

Numéro
international
normalisé	du
livre.	Utilisé	dans
l'industrie	du
livre.

0123456789 13
caractères

EAN	13

Utilisé	dans	le
monde	entier
pour	marquer	les
produits	vendus
au	détail.

0123456789 13
caractères

EAN	8

Utilisé	dans	le
monde	entier
pour	marquer	les
produits	vendus
au	détail,	plus
particulièrement
de	petite	taille.

0123456789 8
caractères

UPC-A

Utilisé	aux	États-
Unis	pour
marquer	les
produits	vendus

0123456789 12
caractères

134



au	détail.

UPC-E

Utilisé	aux	États-
Unis	pour
marquer	les
produits	vendus
au	détail,	plus
particulièrement
de	petite	taille.

0123456789 8
caractères

Data
Matrix
ASCII

Marquage
d'articles	et
autres
utilisations.

Symboles	ASCII Jusqu'à
2335

Code	QR

Marquage
d'articles,
logistique	et
autres
utilisations.

Numériques	ou	alphanumériques.
Jusqu'à
7089
caractères
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Dépannage
L'imprimante	n'imprime	pas
Mauvaise	qualité	d'impression
Certains	ou	tous	les	objets	présents	dans	l'espace	de	travail	ne	sont	pas	imprimés
Impossible	de	sélectionner	du	texte	ou	une	image

Problèmes	d'impression

L'imprimante	n'imprime	pas

Vérifiez	le	branchement	du	câble	entre	l'imprimante	et	l'ordinateur.
Assurez-vous	que	l'imprimante	est	sous	tension.
Si	plusieurs	imprimantes	sont	installées	sur	votre	système,	assurez-vous	d'avoir	sélectionné
l'imprimante	correcte	dans	le	programme.
Vérifiez	la	source	de	papier	de	l'imprimante	:	certaines	imprimantes	possèdent	plusieurs	bacs
d'alimentation.
Assurez-vous	que	le	papier	est	placé	correctement	dans	l'imprimante.
Certains	modèles	d'imprimantes	ne	commencent	pas	l'impression	si	le	bac	de	sortie	est	fermé.

Assurez-vous	que	l'initialisation	de	l'imprimante	est	terminée.	Les	voyants	lumineux	du	panneau	de
contrôle	de	l'imprimante	vous	indiquent	son	état.	En	général,	si	un	voyant	clignote,	cela	signifie	que
l'imprimante	n'est	pas	encore	prête.

L'impression	est	de	mauvaise	qualité

Si	la	qualité	du	texte	ou	des	images	imprimées	est	mauvaise	(légères	bandes	ou	espaces	sur	le
document	imprimé,	atténuation	ou	couleurs	erronées),	vérifiez	le	niveau	d'encre	ou	de	toner.

Si	l'impression	est	floue	ou	si	l'encre	met	longtemps	à	sécher	:

Assurez-vous	que	le	papier	correspond	aux	spécifications	de	l'imprimante.
Vérifiez	que	le	papier	est	positionné	du	bon	côté.
Veillez	à	sélectionner	le	type	de	papier	correct	dans	les	réglages	de	l'imprimante.

Pour	identifier	la	cause	du	problème,	réalisez	un	test	d'impression	depuis	une	autre	application.	Si	le
problème	persiste,	il	est	probable	que	cela	soit	lié	au	matériel.

Pour	des	instructions	plus	détaillées,	consultez	le	guide	d'utilisateur	de	votre	imprimante.

Certains	ou	tous	les	objets	présents	dans	l'espace	de	travail	ne	sont	pas
imprimés

Tous	les	calques	possèdent	la	propriété	Imprimable.	Si	elle	est	désactivée	sur	certains	calques,	tous
les	objets	que	contiennent	ces	calques	ne	seront	ni	imprimés	ni	exportés.	Par	conséquent,	si	du	texte
ou	des	éléments	graphiques	sont	visibles	sur	le	canevas,	mais	n'apparaissent	pas	à	l'impression	ou
dans	le	fichier	exporté,	vérifiez	la	propriété	Imprimable	de	chaque	calque	concerné.	Activez	ce	calque
et	vérifiez	sa	propriété	dans	le	menu	Arranger	>	Calques.
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Problèmes	rencontrés	avec	le	texte	et	les	images

Impossible	de	sélectionner	du	texte	ou	une	image

Assurez-vous	que	l'objet	que	vous	voulez	sélectionner	se	trouve	sur	le	calque	actif	(Avant-
plan,	Arrière-plan	ou	calque	personnalisé).
Pour	ouvrir	un	autre	calque,	utilisez	le	menu	Arranger	>	Calques.
Un	objet	peut	se	trouver	dernière	un	autre	objet	transparent	ou	semi-transparent.
Pour	sélectionner	à	travers	un	objet,	appuyez	sur	la	touche	Commande,	puis	cliquez	plusieurs
fois	sur	des	objets	superposés	jusqu'à	sélectionner	l'objet	de	votre	choix.
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Assistance	technique
Le	développeur	de	Swift	Publisher	propose	une	assistance	technique	gratuite.

E-mail	:	
support@belightsoft.com

Formulaire	d'assistance	technique	sur	le	site	Web	de	BeLight	:	
http://www.belightsoft.com/support/

Forum	sur	le	site	Web	de	BeLight	:	
http://www.belightsoft.com/forum/

Lorsque	vous	signalez	un	problème,	veuillez	spécifier	les	informations	suivantes	:

la	version	de	Swift	Publisher	que	vous	utilisez	;
la	version	de	macOS	installée	sur	votre	ordinateur	;
les	actions	que	vous	avez	effectuées	précédemment	et	qui	ont	pu	conduire	au	problème	;
si	le	problème	persiste,	la	marche	à	suivre	pour	le	reproduire	;
si	nécessaire,	illustrez	votre	rapport	avec	des	captures	d'écran	(appuyez	sur
Commande	+	Maj	+	3	pour	enregistrer	une	capture	d'écran	sur	votre	Bureau).
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